
Grundbegriffe zum Verständnis 
der Abwasserbehandlung

Abwasserbehandlung
(Wastewater Treatment)
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Vorbemerkungen

Kanalnetz und Kläranlage(n) bilden immer eine Einheit. Sie dürfen 
und können nicht unabhängig voneinander betrachtet, bemessen 
oder betrieben werden!

Aus didaktischen Gründen konzentrieren sich die LV im Teil Abwasser auf die 
Abwasserbehandlung in Kläranlagen. 

Es existieren sehr viele verschiedene Verfahren der 
Abwasserbehandlung, ständig kommen neue hinzu oder werden 
vorhandene weiterentwickelt.

Die LV im Teil Abwasser konzentrieren sich auf die vorgeschaltete Denitrifikation, weil das 
die in D und auch im internationalen Maßstab am häufigsten anzutreffende Technologie 
ist. 
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Einige elementare Grundbegriffe

Parameter

• Abwasservolumenstrom (Q)
• Konzentration der Abwasserinhaltsstoffe (C)

Beschaffenheitsparameter
− pH
− BSB / CSB / TOC
− NH4-N
− NOx-N
− PO4-P
− AOX
− …

• Abwasserfracht/-last (= Q * C)
• Einwohnerwert (EW = 

Einwohnerzahl EZ + Einwohnergleichwerte EGW)

Maßeinheit(en)

m³/h, m³/d, l/s, m³/s
mg/l

-
mg/l
mg/l
mg/l
mg/l
µg/l, mg/l
…
g/s, kg/h, t/d, g/d

- (EW)
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Was ist BSB / CSB?

http://www.wasser-wissen.de/abwasserlexikon/b/bsb.htm
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Was ist BSB / CSB?

http://www.wasser-wissen.de/abwasserlexikon/b/bsb.htm

Ergebnis BSB5 in diesem Beispiel: 

𝟗, 𝟗𝟓
𝒎𝒈

𝒍
− 𝟒, 𝟐𝟓

𝒎𝒈

𝒍
= 𝟓, 𝟕

𝒎𝒈

𝒍

Oxidation von NH4-N wird unterdrückt (“mas-
kiert”) durch Zugabe von Allylthioharnstoff.

Die Bilder 2, 3 an 4 sind nicht 100%ig korrekt: 
Die Füllung der Probeflaschen mit sauerstoff-
reichem Wasser erfolgt bis kurz vor Überlauf, so 
dass keine Luft mehr in der Flasche verbleibt.
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Was ist BSB / CSB?

http://www.wasser-wissen.de/abwasserlexikon/c/csb.htm

Die beiden hier dargestellten La-
boruntersuchungen beschreiben die 
herkömmliche nasschemische Messung. 
Heutigentags werden BSB und CSB i.d.R. 
automatisiert, z. B. mit Sensoren, 
gemessen.

Bei der CSB-Analyse werden or-
ganische Substanzen vollständig 
oxidiert (K2Cr2O7 ist ein sehr starkes 
Oxidationsmittel). 
Bei der BSB-Analyse werden hingegen 
nur jene Organika oxidiert, die von den 
Bakterien verstoffwechselt werden 
können.

Dr.-Ing. O. Sterger – Abwasserbehandlung, Einführung 8

http://www.wasser-wissen.de/abwasserlexikon/c/csb.htm


Was ist TOC?

Total Organic Carbon (TOC)

Dissolved
Organic Carbon

(DOC)

Volatile
Organic Carbon

(VOC)

Particulate
Organic Carbon

(POC)

Beispiel:
PVC oder andere 
Polymere

Beispiel:
Isopropanol oder 
andere Alkohole

Beispiel:
Methylchlorid 
oder andere leicht 
flüchtige CKW‘s
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Zusammenhang von BSB, CSB und TOC
Grundsätzlich gilt: 

𝐵𝑆𝐵 ≤ 𝐶𝑆𝐵

𝐶𝑆𝐵 ≈ 2…5 ∗ 𝑇𝑂𝐶

Stoff Strukturformel BSB CSB TOC

Fett a a a

Zucker

(hier 

Traubenzucker)
a a a

Alkohol

(hier: Ethanol) a a a

Pestizid

(hier: 

Endosulfan)

C9H6Cl6O3S r a a

Sulfid

(hier: Schwefel-

wasserstoff)
r a r

Für normal 
verschmutztes 
häusliches Abwasser 
gilt:

𝐵𝑆𝐵 ≈
0,5…0, 8 ∗ 𝐶𝑆𝐵
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Einige elementare Grundbegriffe
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Was hat es damit auf sich?

1 ppm = 
1 𝑝𝑜𝑛𝑑

1 000 000 𝑝𝑜𝑛𝑑𝑠
d.h. 

1 𝑚𝑔

1 000 000𝑚𝑔
=

1 𝑚𝑔

1 𝑘𝑔

1 L Wasser wiegt 1 kg, deshalb

𝟏 𝒑𝒑𝒎 ≈ 𝟏 𝒎𝒈/𝑳

1 ppb = 
1 𝑝𝑜𝑛𝑑

1 000 000 000 𝑝𝑜𝑛𝑑𝑠
(weil „one billion“ = 1 Milliarde)

d.h. 
1 𝑚𝑔

1 000 000 000 𝑚𝑔
=

1 𝑚𝑔

1000

1 000 000𝑚𝑔
=

1 𝜇𝑔

1 𝑘𝑔

deshalb

𝟏 𝒑𝒑𝒃 ≈ 𝟏 𝝁𝒈/𝑳

Im englisch-amerikanischen Schrifttum findet man anstelle der im Deutschen üblichen 
Angaben zur Konzentration oft ppm (ponds per million) oder ppb (ponds per billion).



Welche Stoffe finden wir im Abwasser?
Gelöste und ungelöste (partikuläre) Stoffe

Absetzbare und nicht (oder nur schwer) absetzbare Stoffe

Abbaubare und nicht (oder nur schwer) biologisch abbaubare Stoffe

Organische und anorganische Stoffe

Polare und unpolare Stoffe

Toxische Stoffe 

Stoffe mit Potenzial zur Hemmung des biologischen Abbaus

und nicht zu vergessen: Krankheitserreger!

Nichtmetalle, Halbmetalle, Metalle / Schwermetalle

Nährstoffe (C, N, P)
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Abwasserinhaltsstoffe in Hinblick auf ihre Eliminierbarkeit

Gelöste Stoffe Ungelöste Stoffe
(partikuläre / Feststoffe)

Biochemisch schnell (gut) 
abbaubare Stoffe

Biochemisch nicht (oder nur 
schwer) abbaubare Stoffe

Suspendierte 
Stoffe

(Schwebstoffe)

Absetzbare 
Stoffe

Schwimm
-stoffe

Säuren, 
Basen, 
Salze, 
Ionen

…

Proteine /
Aminosäuren

z. B. Essigsäure, Ethanol z. B. Huminsäuren, EDTA, Cellulose

Kohlenhydrate z. B. Öl, Fett, 
Holz, Kohlen-
wasserstoffe

z. B. Mikro-
organismen, Öl

z. B. Sand, 
Kies, Stärke

Kohlen-
wasser-
stoffe

Gase

Organisch Anorganisch (frei von Kohlenstoff)Sowohl … als auch …
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Grundlegende Verfahren und Anlagen der 
Abwasserbehandlung

Abwasserbehandlung
(Wastewater Treatment)

Dr.-Ing. O. Sterger – Abwasserbehandlung, Einführung 19



Auf Moodle habe ich unter den Materialien für die heutige 
Lehrveranstaltung eine Aufgabe eingestellt mit der Fragestellung

(1895 wurde in Groß-Lichterfelde – das damals noch nicht zu Berlin gehörte -
eine Abwasserbehandlungsanlage nach den Vorschlägen von Dibdin und 
Schweder errichtet, die nicht die erwarteten Reinigungsleistungen zeigte. 
Der Aufbau der Anlage und die ablaufenden Prozesse gehen aus einer im 
Original wiedergegebenen Beschreibung der damaligen Zeit hervor.)

Mit Kenntnis der Zusammenhänge zum Belebungsverfahren, die ich Ihnen 
auf den nächsten Folien zeige, sollten Sie die Aufgabe lösen können.

Wer mir die richtige Lösung dieser Aufgabe bis spätestens 17.10., 12.00 Uhr 
(kommd. Montag Mittag) per E-Mail zuschickt, ist von Kurzreferat bzw. 
Hausaufgabe befreit und erhält sofort 15 Punkte für den Fachteil Abwasser 
(= volle Punktzahl). 

Vorbemerkung

Warum hat das nicht funktioniert?
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Grobe Übersicht

Biologische 
Abwasserbehandlung

Physikalische
Abwasserbehandlung

Chemische
Abwasserbehandlung

Anaerobe VerfahrenAerobe Verfahren

Belebungs-
Verfahren

(mit frei suspendierten 
Mikroorganismen)

Festbett-
Verfahren

(mit sessilen
Mikroorganismen)

Chemisch-physikalische
Abwasserbehandlung

Sonstige Verfahren der
Abwasserbehandlung
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Nur hier steigen wir etwas tiefer ein



Die biologische Abwasserbehandlung ist 
eine Kopie der Prozesse, die in der Natur bei 
der Selbstreinigung der Gewässer ablaufen!

Festbett-
verfahren

Verfahren mit 
suspendierten 

Mikroorganismen

Tropfkörper Belebungsverfahren

Künstliche biologische Abwasserreinigung
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Selbstreinigung durch sessile Biomasse

org. C H2O

Biomasse

Biofilm oder festsitzende 
(sessile) Biomasse
(Mikroorganismenbelag)

O2

CO2
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▪ Durch sessile Biomasse: Biofilm-/Tropfkörperverfahren

▪ als Biofilm auf einer Aufwuchsfläche

▪ Bakterien werden nur vereinzelt erodiert

▪ Abbau spezifisch bezogen auf Bewuchsfläche

Künstliche biologische Abwasserreinigung

→ spezifische Oberfläche 
erhöhen! 

org.C

O2

Bio-

masse

Was ist erforderlich, um den Abbau unter 
künstlichen Bedingungen zu forcieren???
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aus FOWLER, 1911 - An Introduction to Bacteriological and Enzyme Chemistry

Tropfkörper sind Festbettreaktoren.
Biofilm (sessile Biomasse) siedelt sich an auf Füllmaterial
(Lavaschlacke oder Kunststoffkörper)
Belüftung erfolgt durch Kaminwirkung
Drehsprenger verteilen das Abwasser gleichmäßig
Rückführung von Ablaufwasser zur Verdünnung und 
Vergleichmäßigung des Zulaufs sowie zur
Vermeidung/Beseitigung von Verstopfungen durch Abspülen
überschüssiger Biomasse

Festbettverfahren, Beispiel Tropfkörper
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Verfügbare Oberfläche: 
150…500 m²/m³



org.C

Biomasse

Selbstreinigung durch suspendierte Biomasse

H2O

CO2
O2

Bakterienflocken,
Protozonen,
Pilzhyphen
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▪ Durch suspendierte Biomasse: Belebungsverfahren

▪ Mikroorganismen werden durch Turbulenz in 

Schwebe gehalten 

▪ Schlammflocken 0,1 – 1 mm Durchmesser 

▪ Abbau spezifisch bezogen auf Biomasse 

Künstliche biologische Abwasserreinigung

org.C

Biomasse

H2O

CO2O2

→ Künstlich Belüften! 

Was ist erforderlich, um den Abbau unter 
künstlichen Bedingungen zu forcieren???

→ Biomasse  aufkonzentrieren! 
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Belebungsverfahren

Als „Erfinder“ des Belebungsverfahrens (nach dem Englischen »Activated Sludge

Process« auch als Belebtschlammverfahren bezeichnet,) gelten Edward Ardern und 

William Lockett, die es erstmalig 1913 auf einer Kläranlage in Manchester eingeführt 

haben. Sie wurden inspiriert von Gilbert Fowler (University of Manchester).

aus https://de.wikipedia.org/wiki/Belebtschlammverfahren
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Grundtypen chemischer Reaktoren
http://www.ernst-bratz.de/react_tech/reacteng1.html

Ideal durchmischter Rührreaktor 
Continuously stirred Tank reactor (CSTR)

Ideales Strömungsrohr (Pfropfenströmung)
Plug-flow-reactor (PF)

Chargenweise beschickter Reaktor 
Batch reactor
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Reaktortypen in der Abwasserbehandlung

In idealen Reaktoren ablaufende Transport- und Durchmischungs-
prozesse lassen sich mathematisch exakt beschreiben.

Reale Reaktoren weichen in ihrem Verhalten von den idealen 
Reaktoren ab, sie können aber häufig durch ideale Reaktoren 
genügend genau abgebildet werden.

• Chargen-Reaktor (Batch-Reactor)
• Rührkessel (Completely Mixed Reactor CMR, Chemostat, 

Continuously Stirred Tank Reactor, CSTR)
• Röhrenreaktor (Plug Flow, PF)
• Sequencing Batch Reactor (SBR)

aus KAINZ & GRUBER, 2011
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Reaktortypen in der Abwasserbehandlung

Batch- oder 
Chargen-
Reaktor

aus KAINZ & GRUBER, 2011
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Reaktortypen in der Abwasserbehandlung

Ideal durch-
mischter
Rührreaktor 
(Chemostat, 
Completely
Stirred Tank
Reactor,
CSTR)

aus KAINZ & GRUBER, 2011
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Reaktortypen in der Abwasserbehandlung

Rührkessel-
kaskade

aus KAINZ & GRUBER, 2011
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Reaktortypen in der Abwasserbehandlung

Röhren-
reaktor
(PF)

aus KAINZ & GRUBER, 2011
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Reaktortypen in der Abwasserbehandlung

Sequencing Batch Reactor (SBR)

aus KAINZ & GRUBER, 2011
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Sessile und suspendierte Mikroorganismen 

Frei suspendierte
Bakterien 
(Bakterienflocke)
Belebtschlammverfahren

Sessile Bakterien
(Bakterienfilm)
Biofilmverfahren

aus KUNZ,  1992
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In der neuen Version 

DWA-A 131, 2016 

wird BSB nicht mehr 

gesondert aufgeführt. 

Parameter
Einwohner-
spezifische 

Fracht
Literaturquelle

Abwasseranfall 
(incl. 

Fremdwasser)

250 l/(E*d) bzw. 
91 m³/(E*a)

HABERKERN et al., 2008

BSB5 60 g/(E*d) ATV-DVWK-A 131, 2000

CSB 120 g/(E*d) ATV-DVWK-A 131, 2000

TOC 40 g/(E*d) LONDONG, 2009

TS 70 g/(E*d) ATV-DVWK-A 131, 2000

TKN 11 g/(E*d) ATV-DVWK-A 131, 2000

NH4-N 8 g/(E*d) HABERKERN et al., 2008

P 1,8 g/(E*d) HABERKERN et al., 2008

Einwohnerwerte für häusliches Abwasser

Einwohnerwerte 

normal verschmutzten 

häuslichen Abwassers 

(„Faustwerte“)
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Für optimales Wachstum benötigt Belebtschlamm ein Verhältnis BSB5 : TKN : P von etwa 
100 : 5 : 1. Anders ausgedrückt: Beim Aufbau neuer Biomasse werden auf 100 Teile von C 
5 Massenäquivalente N und 1 Massenäquivalent P verbraucht.

Nährstoffverhältnisse und Konsequenzen 

Um die Gewässer vor Überdüngung zu schützen, sind Nitrifikation/Denitrifikation und 
Phosphateliminierung bei der Behandlung häuslicher Abwässer erforderlich!

? Welche Konsequenz ist daraus zu ziehen???

Ergo: Sanitärabwasser weist einen etwa 
dreifachen Stickstoff- und Phosphor-
überschuss auf!

Im normal verschmutzten häuslichen 
Abwasser liegt das Verhältnis aber, siehe oben, 
bei etwa 100 : 18 : 3.
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𝑁äℎ𝑟𝑠𝑡𝑜𝑓𝑓𝑣𝑒𝑟ℎä𝑙𝑡𝑛𝑖𝑠 𝑁𝑔𝑒𝑠. ∶ 𝐵𝑆𝐵5 =

11 𝑔 𝑁𝑔𝑒𝑠
.

𝐸 ∗ 𝑑
60 𝑔 𝐵𝑆𝐵5

𝐸 ∗ 𝑑

= 18%

𝑁äℎ𝑟𝑠𝑡𝑜𝑓𝑓𝑣𝑒𝑟ℎä𝑙𝑡𝑛𝑖𝑠 𝑃𝑔𝑒𝑠. ∶ 𝐵𝑆𝐵5 =

1,8 𝑔 𝑃𝑔𝑒𝑠.
𝐸 ∗ 𝑑

60 𝑔 𝐵𝑆𝐵5
𝐸 ∗ 𝑑

= 3%



Ablauf KAZulauf BB

Überschuss-
schlamm

Rücklaufschlamm

aerob

Belebungsbecken Nachklärbecken

Belebungsanlage mit Nitrifikation

Hist. Entwicklung des Belebungsverfahrens
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Wie vor
+ Nitrifikation

Breitenanwendung in D: 
Mitte der 70‘er Jahre

Ablauf KAZulauf BB

Überschuss-
schlamm

Rücklaufschlamm

aerob

Belebungsbecken Nachklärbecken

Belebungsanlage (Ausgangsdesign)

Breitenanwendung in D: 
Mitte der 80‘er Jahre

Eliminierung Organika 
(Kohlenstoffverbindungen.)



Hist. Entwicklung des Belebungsverfahrens
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Wie Ausgangsform der Belebungsanlage 
+ teilweise Eliminierung von N und P

Anwendung in D: 
Anfang bis Mitte der 80‘er Jahre

Zulauf KA Ablauf KA

Rücklaufschlamm BRücklaufschlamm A
Überschuss-
schlamm

aerobaerob

Belebung
hochbelastet

Belebung
schwachbelastet NachklärbeckenZwischenklärbecken

B-StufeA-Stufe

Adsorptions-Belebungsanlage (A/B-Anlage)



Hist. Entwicklung des Belebungsverfahrens
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Wie Ausgangsform der Belebungsanlage 
+ Eliminierung von N (ca. 75%)

Breitenanwendung in D: 
Seit Anfang der 90‘er Jahre

Vorgeschaltete Denitrifikation

Ablauf KAZulauf BB

Überschuss-
schlamm

Rücklaufschlamm

Interne Rezirkulation

aeroba
n

o
x
is

c
h

Belebungsbecken Nachklärbecken



Hist. Entwicklung des Belebungsverfahrens
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Wie Vorgeschaltete Denitrifikation
+ Eliminierung von P (je nach behördl. Anforderung)

Breitenanwendung in D: 
Seit Ende der 90‘er Jahre

Vorgeschaltete Denitrifikation mit BioP (biolog. P-Elimination )

Ablauf KA

Zulauf BB

Überschuss-
schlamm

Rücklaufschlamm

Interne Rezirkulation

aeroba
n
o

x
is

c
h

a
n
a

e
ro

b

a
n
o

x
is

c
h

Belebungsbecken Nachklärbecken



Anfangs-CSB CSB0 1

Abbaukoeffizient k1 0.2

Zeit 

t
CSB (t)

0.0 h 100.00%

1.0 h 81.87%

2.0 h 67.03%

3.0 h 54.88%

4.0 h 44.93%

5.0 h 36.79%

6.0 h 30.12%

7.0 h 24.66%

8.0 h 20.19%

9.0 h 16.53%

10.0 h 13.53%

11.0 h 11.08%

12.0 h 9.07%

13.0 h 7.43%

14.0 h 6.08%

15.0 h 4.98%

16.0 h 4.08%

17.0 h 3.34%

18.0 h 2.73%

19.0 h 2.24%

20.0 h 1.83%

0.00%

10.00%

20.00%

30.00%

40.00%

50.00%

60.00%

70.00%

80.00%

90.00%

100.00%

0.0 h 5.0 h 10.0 h 15.0 h 20.0 h

CSB (t)

𝐶𝑆𝐵 =  𝐶𝑆𝐵0 ∗  𝑒 𝑘1∗ 

Theorie des CSB-Abbaus in Belebungsanlagen
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Was sagt uns 
diese 

Abbaukurve???

Je länger die Aufenthalts-
zeit des Abwassers in der 
biologischen Stufe  ist, 
desto mehr CSB wird eli-
miniert. Allerdings wer-
den die Eliminierungs-
raten mit fortlaufender 
Behandlungsdauer im-
mer kleiner. 
Eine 100%ige CSB-Elimi-
nierung würde eine un-
endliche Behandlungs-
dauer erfordern. Üblich 
sind daher 8…12 h.



Abwasserbehandlungsverfahren

Mit der nachgeschalteten Denitrifikation begann die Nährstoffeliminierung. Das Verfahren 
wird heute nur noch angewandt, wenn das Abwasser ein sehr geringes C/N-Verhältnis 
aufweist, so dass die Zugabe von externem Kohlenstoff unumgänglich ist. Das 
Denitrifikationsbecken ist dem Nitrifikationsbecken nachgeschaltet; sicherheitshalber folgt 
oft ein Nachbelüftungsbecken.  

unter Verwendung von DWA-A 131, 2016

Nachgeschaltete Denitrifikation
Skizze aus DWA-A 131, 2016
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Abwasserbehandlungsverfahren

STOAT-Modell für nachgeschaltete Denitrifikation 
(BASF Schwarzheide)
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Abwasserbehandlungsverfahren

Luftbild KA BASF Schwarzheide GmbH, Stand 2010

„Gerinnereaktor“ 
zur nachgeschalt. 

Denitrifikation

Plug Flow (PF) oder 
Completely Stirred

Tank Reactor (CSTR)?
Länge des Fließwegs?
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Abwasserbehandlungsverfahren

KA BASF Schwarzheide GmbH, Beckenvolumina etc.

Fragestellung für 
STOAT-Simulation 
2010:

Kann der vorh. 
Gerinnereaktor 
durch ein BB 5/6 
ersetzt werden?  

Und wenn ja, wie 
ist das Volumen 
des neuen BB 5/6 
zwischen N und 
DN aufzuteilen?

Becken 1/2 Becken 3/4 Becken 5/6 ZKB NKB 1 NKB 3

Geometrie
Rechteck-

becken

Länge 60,00 m 60,00 m 1.836 m 60 m

Breite 12,00 m 12,00 m 1,00 m 10,00 m

Fläche 720 m² 720 m² 1.836 m² 600 m² 800 m² 800 m² 800 m²

Tiefe 4,35 m 4,35 m 1,57 m 3,50 m 2,75 m 2,75 m 4,40 m

Durchmesser 32,00 m 32,00 m 32,00 m

Verhältnis T : D 0,09 0,09 0,14

Volumen gesamt 3.132 m³ 3.132 m³ 2.883 m³ 2.100 m³ 2.200 m³ 2.200 m³ 3.520 m³

VBB, davon 6.264 m³ 4.200 m³

VN 6.264 m³

VD 2.883 m³

Zulaufhöhe 1,40 m 1,40 m 2,20 m

TSBB 20…30 g/l 8…10 g/l 4…6 g/l

O2-Gehalt 2,0 mg/l 1,5 mg/l 0,0 mg/l

RLS 2 x 180 m³/h 2 x 180 m³/h 300 m³/h

ÜSS 10 h x 11 m³/h 8 h x 11 m³/h 6 h x 11 m³/h

kLa-Wert 6 … 21 7 … 15 0

max. O2-Eintrag 490 kg/h 300 kg/h

VD/VBB 0,32

Rundbecken

ist zu 

ermitteln!

ist zu 

ermitteln!

9.147 m³

Gerinne-

reaktorRechteckbecken
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Abwasserbehandlungsverfahren

Behandlungsstufen KA BASF Schwarzheide GmbH, Stand 2014
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Abwasserbehandlungsverfahren

KA BASF Schwarzheide GmbH, Stand 2021-10-03 (Google Maps)

„Gerinnereaktor“ 
zurückgebaut

Becken 5/6
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Abwasserbehandlungsverfahren

Abwasser, Rücklaufschlamm und interne Rezirkulation werden im Denitrifikationsbecken 
vermischt. Sowohl Denitrifikationsbecken als auch Nitrifikationsbecken können als 
Kaskaden ausgebildet sein. Zur Erhöhung der betrieblichen Flexibilität können in 
Fliessrichtung gesehen die letzten Teile des Denitrifikationsbeckens auch belüftbar sein. 
Die interne Rezirkulation ist auf das notwendige Maß zu beschränken, um die 
Beeinträchtigung der Denitrifikation durch hohe Frachten an gelöstem Sauerstoff zu 
minimieren. 

aus DWA-A 131, 2016

Vorgeschaltete Denitrifikation (weltweit häufigster KA-Typ)
Skizze aus DWA-A 131, 2016
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Abwasserbehandlungsverfahren

Weil in der anaeroben Zone kein Nitrat oder Nitrit für eine anoxische Atmung zur 
Verfügung stehen, greifen die Bakterien auf ihre Energiereserve (Polyphosphat) zurück, um 
mit dessen Hilfe leicht abbaubares Substrat mineralisieren zu können und es folgt eine 
Phosphatrücklösung. Bei einem Wechsel in ein aerobes oder anoxisches Milieu kommt es 
zu einer vermehrten Phosphataufnahme gekoppelt mit einer Mineralisation organischer 
Stoffe durch die Mikroorganismen, wobei die Aufnahmerate direkt von der Höhe der 
vorhergehenden Rücklösung abhängig ist. 

aus KUBIN, 2004

Vorgeschaltete Denitrifikation mit BioP
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Abwasserbehandlungsverfahren

STOAT-Modell für vorgeschaltete Denitrifikation
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Abwasserbehandlungsverfahren

Zwei oder mehr Belebungsbecken, jedes mit vorgeschalteter oder simultaner 
Denitrifikation, werden nacheinander durchflossen. Das Abwasser wird aufgeteilt und 
jeweils den Denitrifikationsbecken zugeführt. Hierdurch entfällt in der Regel die interne 
Rezirkulation… Das Verfahren ist hinsichtlich der Stickstoffelimination der vorgeschalteten 
Denitrifikation gleichwertig. Wegen der verteilten Abwasserzuführung ist der 
Schlammtrockensubstanzgehalt im ersten Becken höher als im Ablauf zur Nachklärung. 

aus DWA-A 131, 2016

Kaskadendenitrifikation
Skizze aus DWA-A 131, 2016
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Abwasserbehandlungsverfahren

STOAT-Modell für Kaskadendenitrifikation
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Abwasserbehandlungsverfahren

Praktisch nur in Umlaufbecken realisierbar. Nitrifikation und Denitrifikation finden im 
gleichen Becken statt. Die parallel ablaufenden Verfahrensschritte müssen deshalb 
räumlich getrennt werden. Im belüfteten Teil des Beckens wird das Ammonium zum Nitrat 
oxidiert. Anschließend durchströmt das nitratreiche Abwasser eine belüftungsfreie Zone 
zur Denitrifikation. Die simultane Denitrifikation kann als eine Art vorgeschaltete 
Denitrifikation mit einem hohen internen Rückführverhältnis betrachtet werden. Eine 
Regelung der Belüftung z. B. nach dem Nitratgehalt, dem Ammoniumgehalt, dem Knick des 
Redoxpotenzials (Redoxknick) oder dem Sauerstoffgehalt ist erforderlich. Umlaufbecken 
kommen bezüglich der Verdünnung totalen Mischbecken nahe. 

unter Verwendung von DWA-A 131, 2016

Simultane Denitrifikation
Skizze aus DWA-A 131, 2016
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Abwasserbehandlungsverfahren

Simultane Denitrifikation
(alternative Darstellung für ein Umlaufbecken mit Belüftungskreiseln)
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Abwasserbehandlungsverfahren

STOAT-Modell für simultane Denitrifikation (KA Fürstenwalde/Spree)

aus Bachelorarbeit 
von P. Gierke, 2018
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Abwasserbehandlungsverfahren

Intermittierende Denitrifikation

Skizze aus DWA-A 131, 2016

In einem Becken wechseln zeitlich die Nitrifikations- und die Denitrifikationsphasen. Die 
Phasendauer kann mit einer Zeitschaltung vorgegeben oder durch eine Regelung z. B. nach 
dem Nitratgehalt, dem Ammoniumgehalt, dem Knick des Redoxpotenzials oder dem 
Sauerstoffverbrauch eingestellt werden. Hohe Sauerstoffgehalte am Ende der 
Nitrifikationsphasen beeinträchtigen die Denitrifikation. Die Becken für intermittierende 
Denitrifikation sind als totale Mischbecken zu betrachten.

aus DWA-A 131, 2016
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Abwasserbehandlungsverfahren

STOAT-Modell für intermittierende Denitrifikation
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Abwasserbehandlungsverfahren

STOAT-Modell KA Liebenwalde (intermittierende Denitrifikation)

aus Bachelorarbeit 
von J. Podlasly, 2015
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Abwasserbehandlungsverfahren

Alternierende 
Denitrifikation

Skizze aus DWA-A 131, 2016

Zwei jeweils intermittierend belüftete Becken werden abwechselnd hintereinander 
beschickt, wobei Wasser von dem beschickten, unbelüfteten Becken in das andere, 
belüftete Becken und von dort zur Nachklärung fließt. Die Beschickungsdauer sowie die
Dauer der Denitrifikations- und der Nitrifikationsphase werden in der Regel mit einer 
Zeitschaltung vorgegeben. Hohe Sauerstoffgehalte am Ende der Nitrifikationsphase 
beeinträchtigen die Denitrifikation. Das Mischungsverhalten liegt zwischen dem von 
totalen Mischbecken und Pfropfenströmung. 

aus DWA-A 131, 2016

Dr.-Ing. O. Sterger – Abwasserbehandlung, Einführung 65



Abwasserbehandlungsverfahren

BioDeNitro-Prozess (alternierende Denitrifikation)

Skizze aus ATV-DVWK-A 131, 2000
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Abwasserbehandlungsverfahren

STOAT-Modell für alternierende Denitrifikation
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Abwasserbehandlungsverfahren

Die Abtrennung des gereinigten Abwassers vom Belebtschlamm erfolgt mittels 
Membranfilter. Aufgrund dessen kann mit sehr hohen Trockensubstanzgehalten gefahren 
werden (bis über 20 kg/m³). Dadurch erreichen sie eine sehr gute, völlig feststofffreie 
Ablaufqualität. Nachteilig ist, dass die hohe Viskosität des Belebtschlammgemisches den 
Sauerstoffeintritt und -übergang behindert. Gegenüber konventionellen Anlagen wird 
erheblich mehr Energie benötigt (bis 10-mal mehr).

Biomembranreaktor (Membranbelebungsanlage)

Skizze aus KUBIN, 2004
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Gegenüberstellung der 
Verfahrensführung bei 
herkömmlichen Belebungs-
anlagen im Vergleich zu 
Biomembranreaktoren

UBA, 2003

Abwasserbehandlungsverfahren
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Abwasserbehandlungsverfahren

Der gereinigte Ablauf eines Tropfkörpers weist i. a. R. eine Gelöstsauerstoffkonzentration 
auf, die der Sättigungskonzentration nahe kommt. Für die Denitrifikation sind jedoch 
anoxische Verhältnisse erforderlich. Deshalb sind Tropfkörper heute auf Kläranlagen eher 
selten anzutreffen, obwohl sie in energetischer Hinsicht dem Belebungsverfahren deutlich 
überlegen sind. 

Tropfkörper

aus http://zeichner-ingenieurbau.ch/abwassertechnik und http://brunsumwelttechnik.de/de/produkte3.php
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Abwasserbehandlungsverfahren

SBR-Anlage (Sequencing Batch Reactor)

aus DWA-M 210, 2009
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Abwasserbehandlungsverfahren
SBR-Anlage
Beispiel für die Aufeinanderfolge von 
Prozessphasen während eines Zyklus

aus DWA-M 210, 2009

Die in durchflossenen Belebungsanlagen in getrennten Reaktoren räumlich hintereinander 
stattfindenden Prozesse werden hier auf eine Zeitachse verschoben und finden gestaffelt 
in ein und demselben Reaktionsvolumen statt. Die Reaktion im Belebungsbecken in der 
Reihenfolge anaerob (BioP), anoxisch (DN), aerob (N) und Nachklärung erfolgt beim SBR-
Verfahren somit zeitlich nacheinander. 

Belebungsanlagen mit Aufstaubetrieb 
sind in Bezug auf die stattfindenden 
biologischen Prozesse eine 
verfahrenstechnische Variante des 
Belebungsverfahrens. 
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Abwasserbehandlungsverfahren

STOAT-Modell einer SBR-Anlage (KA Werder/Havel)

aus Bachelorarbeit 
von A. Wagner, 2016
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Beispiel GKW Bitterfeld-Wolfen

Das GKW behandelt die Abwässer des 
Chemieparks Bitterfeld und kommunale Abwässer 
der umliegenden Städte und Gemeinden (ca. 
80.000 EW).

Modernste und größte Anlage in Sachsen-Anhalt, 
Kapazität bei Inbetriebnahme 1994: 422.000 EW, 
heute: 586.000 EW

4 BIOHOCH®-Reaktoren, intensive Vorbehandlung, 
neu: Anaerobanlage
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Beispiel GKW Bitterfeld-Wolfen
Querschnitt eines BIOHOCH®-
Reaktors

Vorteile:
• hoher Sauerstoffertrag

(ca. 3 kg O2/kWh)
• geringer Abgasanfall
• ständige intensive 

Vermischung des 
Belebtschlamms mit dem 
Substrat

• geringer Platzbedarf

nach HOECHST, 1985
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Beispiel GKW Bitterfeld-Wolfen
Neue 
Anaerob-
anlage und 
deren 
Einbindung 
der in das 
Gesamt-
konzept

aus STERGER & 
KOEPPKE, 2013
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Beispiel GKW Bitterfeld-Wolfen
Anaerob-
reaktoren
Foto und
Funktions-
prinzip

aus STERGER & 
KOEPPKE, 2013
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Beispiel GKW Bitterfeld-Wolfen
Gegenüberstellung der Kohlenstoff-
bilanzen bei aerober (A) und anaerober 
(B)  Abwasserbehandlung

UBA, 2003
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Beispiel GKW Bitterfeld-Wolfen
„Der CSB kann als Energieparameter gedeutet werden, so dass der Energieerhaltungssatz 
angewendet werden kann. Über längere Zeiträume, in denen sich der Ablauf-CSB nur 
wenig geändert hat (keine Änderung des CSB im Anaerobreaktor) muss gelten:

CSB-Abbau = CSB-Gas + CSB-ÜS

Der CSB im Biogas ist bei der Methanisierung (H2-Gehalt sehr gering) ausschließlich im 
Methan enthalten; CO2 hat keinen CSB. Der CSB des Methans kann auf Grund der 
Oxidationsreaktion berechnet werden;

CH4 + 2 O2 → CO2 + 2 H2O

d. h. je Mol CH4 (= 22,4 Nl) sind 2 Mol Sauerstoff (= 64 g O2) erforderlich. 1 g CSB 
entspricht daher 22,4 : 64 = 0,35 NI CH4. Unter der Annahme, dass 
ca. 10 % des abgebauten CSB in Biomasse umgewandelt werden, entstehen 
aus 1 kg abgebautem CSB ca. 320 NI Methan.“ 

ATV-Fachausschuss 7.5, 1993
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Beispiel GKW Bitterfeld-Wolfen

Sankey-
Diagramm der 
Energie- und 
Stoffströme in 
der neuen 
Anaerob-
anlage des 
GKW 
Bitterfeld-
Wolfen

aus STERGER & 
KOEPPKE, 2013
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Grundlegende Begriffe und Zusammenhänge 
der Bemessung von Kläranlagen 

nach ATV-DVWK-A 131 bzw. DWA-A 131

Abwasserbehandlung
(Wastewater Treatment)
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CSB-Eliminierung im Belebungsverfahren

1987 wurden mit dem sog. Activated Sludge Model #1 (ASM 1) erstmals einige Kürzel 
eingeführt, die seitdem international Standard sind:

• C für die Gesamtkonzentration des jeweiligen Parameters 

(aus der homogenisierten Probe) 

• S gelöster Anteil des jeweiligen Parameters 

(engl. soluble, aus der filtrierten Probe)

• X partikulärer Anteil des jeweiligen Parameters 

(X = C – S)
vgl. HENZE et al. , 1987 sowie ATV-DVWK-A 198, 2003

Diese Kürzel werden auch im DWA-A 131 verwendet. Alle darauf aufbauenden Symbole und 
Indices sind in A 131 ausführlich erläutert.

vgl. DWA-A 131, 2016

Für die Fraktionen im Zulauf (und auch im Ablauf) einer Belebungsanlage sind im Schrifttum 
zahlreiche Abbildungen und Erläuterungen verfügbar. 
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CSB- und Feststoff-Fraktionierung

International übliche Bezeichnung der Fraktionen des CSB und der Feststoffe im Zulauf einer 
Belebungsanlage und deren Ermittlung auf der Grundlage von Messungen

XTS oder

TS oder TR
XanorgTS

XorgTS
oder

oTS
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CSB-Fraktionierung

International übliche Standardfraktionierung des CSB im Zulauf einer Belebungsanlage
(Variante I, englisch)

Dr.-Ing. O. Sterger – Abwasserbehandlung, Einführung 86



CSB-Fraktionierung

International übliche Standardfraktionierung des CSB im Zulauf einer Belebungsanlage
(Variante II, deutsch + englisch)
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CSB-Fraktionierung

Fraktionierung des CSB im Zulauf einer Belebungsanlage anhand der Belastungsfaustwerte

CSB gesamt
Abfiltrierbare 

Stoffe

600 mg/l 350 mg/l

40% 60%

CSB gelöst CSB partikulär
organische 

Feststoffe

anorganische 

Feststoffe

240 mg/l 360 mg/l 240 mg/l 110 mg/l

68,6% 31,4%

CSB gelöst, 

abbaubar

CSB gelöst, 

nicht abbaubar

CSB partikulär, 

abbaubar

CSB partikulär, 

nicht abbaubar

180 mg/l 60 mg/l 120 mg/l 240 mg/l

30,0% 10,0% 20,0% 40,0%

300 mg/l

BSB gesamt

75% 25%

BSB5

CSB
TOC
AFS
TKN

NH4-N
P 2 g/E*d 10 mg/l

Konzentration im 

Rohabwasser bei einem 

Abwasseranfall 

von 200 l/E*d

Einwohnerspezifische 

Schmutzfrachten in 

Rohabwasser

Parameter

70 g/E*d 350 mg/l

11 g/E*d 55 mg/l

8 g/E*d 40 mg/l

60 g/E*d 300 mg/l

120 g/E*d 600 mg/l

40 g/E*d 200 mg/l
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CSB- und Feststoff-Fraktionierung

Beispiel zur Fraktionierung des CSB und der Feststoffe im Zu- und Ablauf einer Belebungsanlage
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CSB-Eliminierung im Belebungsverfahren

Veränderung des CSB und der partikulären Stoffe bei der biologischen Behandlung 
aus DWA-A 131, 2016
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VBB Volumen des Belebungsbeckens in m³
Die erforderliche Größe des Belebungsbeckens hängt ab vom Abwasserzufluss (m³/h), von den Abwassereigenschaften 
(BSB5, Abbaubarkeit, Nährstoffe), vom geforderten Reinigungseffekt, von der im Belebungsbecken vorhandenen 
Belebtschlammmenge. Die Form des Beckens und das Belüftungssystem haben unter normalen Verhältnissen keinen 
Einfluss auf die Größe des Belebungsbeckens.

VN Volumen des zur Nitrifikation verfügbaren Anteils des Belebungsbeckens in m³
Beckenvolumen, in dem aerobe Verhältnisse herrschen

VD Volumen des zur Denitrifikation verfügbaren Anteils des Belebungsbeckens in m³
Beckenvolumen, in dem anoxische Verhältnisse herrschen 

TSBB Trockensubstanzgehalt im Belebungsbecken in g/l bzw. kg/m³
Ein Maß für die im Belebungsbecken vorhandene Belebtschlammmenge (biologisch aktive Bakterienmasse) ist der 
Schlammgehalt, gemessen als Trockenmasse (g), der in 1 l Schlamm-Wasser-Gemisch enthaltenen Feststoffe. 
Die Bestimmung erfolgt analog den "abfiltrierbaren Stoffen" im Rohabwasser durch Filtrieren und nachfolgendes 
Trocknen und Wiegen des Filterrückstandes. Die damit ermittelte Trockensubstanz TSBB erfasst jedoch nicht nur die 
biologisch aktive Bakterienmasse, sondern die gesamten im Schlamm-Wasser-Gemisch enthaltenen Feststoffe; sie ist 
somit nur ein Näherungswert für die vorhandene aktive Bakterienmasse. 

MTS,BB Masse der Trockensubstanz (Feststoffe) des gesamten im Belebungsbecken 
vorhandenen Belebtschlamms in kg

𝑀𝑇𝑆,𝐵𝐵 = 𝑉𝐵𝐵 ∗ 𝑇𝑆𝐵𝐵

Grundlegende Begriffe u. a. nach DWA-A 131, 2016 / KAINZ & GRUBER, 2011

Dr.-Ing. O. Sterger – Abwasserbehandlung, Einführung 92



BR Raumbelastung in kg/(m³ * d)
Nachdem man erkannt hatte, dass die Reinigungswirkung einer Belebungsanlage nicht von der zugeführten 
Wassermenge, sondern von der zugeführten, als BSB5-Fracht gemessenen Schmutzfracht abhängt, führte man den Begriff 
Raumbelastung BR ein; sie ist definiert als die pro Tag und pro m³ Beckenvolumen eingeleitete BSB5-Fracht.
Die Raumbelastung berücksichtigt somit den Abwasserzulauf Q und die Verschmutzung BSB5 des Abwassers, nicht aber 
den Schlammgehalt TSBB im Belebungsbecken.

𝐵𝑅 =
𝐵𝑆𝐵5 − 𝐹𝑟𝑎𝑐ℎ𝑡 𝑖𝑛 𝑘𝑔/𝑑

𝐵𝑒𝑐𝑘𝑒𝑛𝑣𝑜𝑙𝑢𝑚𝑒𝑛 𝑖𝑛 𝑚³
=

𝐵𝑑,𝐵𝑆𝐵5

𝑉𝐵𝐵

BTS Schlammbelastung in kg/(kg * d)
Der Reinigungseffekt einer Belebungsanlage bzw. die Restverschmutzung im Ablauf hängt davon ab, welche Menge 
biologisch abbaubarer Stoffe pro Tag der vorhandenen Belebtschlammmasse zugeführt wird. Man drückt dies durch den 
Begriff Schlammbelastung BTS aus.

𝐵𝑇𝑆 =
𝐵𝑆𝐵5 − 𝐹𝑟𝑎𝑐ℎ𝑡 𝑖𝑛 𝑘𝑔/𝑑

𝑀𝑎𝑠𝑠𝑒 𝑑𝑒𝑟 𝑇𝑟𝑜𝑐𝑘𝑒𝑛𝑠𝑢𝑏𝑠𝑡𝑎𝑛𝑧 𝑖𝑚 𝐵𝑒𝑙𝑒𝑏𝑢𝑛𝑔𝑠𝑏𝑒𝑐𝑘𝑒𝑛
=

𝐵𝑑,𝐵𝑆𝐵5

𝑀𝑇𝑆,𝐵𝐵

Grundlegende Begriffe u. a. nach DWA-A 131, 2016 / KAINZ & GRUBER, 2011
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Zusammenhang zwischen Raumbelastung 𝐵𝑅 und Schlammbelastung 𝐵𝑇𝑆:

Wegen 𝑉𝐵𝐵 =
𝑀𝑇𝑆,𝐵𝐵

𝑇𝑆𝐵𝐵
und 𝐵𝑇𝑆 =

𝐵𝑑,𝐵𝑆𝐵5

𝑀𝑇𝑆,𝐵𝐵
gilt

𝐵𝑅 = 𝐵𝑇𝑆 ∗ 𝑇𝑆𝐵𝐵 bzw. 𝐵𝑇𝑆 =
𝐵𝑅

𝑇𝑆𝐵𝐵

Vor Veröffentlichung des derzeit gültigen A 131 waren die folgenden drei Größen die 
Grundlage für die Bemessung eines Belebungsbeckens für eine kommunale Kläranlage:

BR = ≤ 0,8 kg BSB5/m³*d
BTS = ≤ 0,25 kg BSB5/kg TS*d
TSBB = 3,0 … 4,0 kg/m³ bzw. g/l

Grundlegende Begriffe u. a. nach DWA-A 131, 2016 / KAINZ & GRUBER, 2011
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t Aufenthaltszeit des Abwassers in h (engl.: HRT - Hydraulic Retention Time) 
Die Bemessung des Belebungsbeckens erfolgte früher nur nach der Aufenthaltszeit t (= Durchflusszeit) und 
berücksichtigte somit lediglich den Abwasservolumenstrom im Zulauf Q, nicht aber die Abwassereigenschaften 
(Abwasserlast/-fracht) und die vorhandene Belebtschlammmenge. 

𝑡 =
𝐵𝑒𝑐𝑘𝑒𝑛𝑣𝑜𝑙𝑢𝑚𝑒𝑛 𝑖𝑛 𝑚³

𝐴𝑏𝑤𝑎𝑠𝑠𝑒𝑟𝑣𝑜𝑙𝑢𝑚𝑒𝑛𝑠𝑡𝑟𝑜𝑚 𝑖𝑛 𝑚³/ℎ
=

𝑉𝐵𝐵

𝑄ℎ

tTS Schlammalter in d (engl.: SRT - Sludge Retention Time)
Das Schlammalter tTS ist die rechnerische mittlere Verweilzeit des Belebtschlamms im Belebungsbecken und ist durch den 
Quotienten aus der im Belebungsbecken vorhandenen Schlammtrockenmasse MTS,BB (kg) und der durchschnittlichen 
täglichen Überschussschlammentnahme ÜSd (kg/d) (= Überschussschlammanfall) definiert. 
Bei dieser Definition wird vernachlässigt, dass sich auch im Nachklärbecken stets eine gewisse Schlammmenge befindet, 
und dass geringe Schlammmengen auch mit dem Ablauf der Abwasserreinigungsanlage ausgetragen werden.

𝑡𝑇𝑆 =
𝑉𝐵𝐵 ∗ 𝑇𝑆𝐵𝐵

Ü𝑆𝑑

ÜSd Überschussschlammanfall in kg/d
setzt sich zusammen aus dem Zuwachs an Biomasse und darin eingelagerten Primärfeststoffen ÜSd,C sowie ggf. dem 
Schlammanfall aus der Phosphatfällung ÜSd,P

Ü𝑆𝑑 = Ü𝑆𝑑,𝐶 + Ü𝑆𝑑,𝑃

Grundlegende Begriffe u. a. nach DWA-A 131, 2016 / KAINZ & GRUBER, 2011
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„Maßgebend für die Bemessung des Belebungsbeckens ist das 
Schlammalter (tTS), das in etwa der mittleren Aufenthaltszeit einer 
Schlammflocke im Belebungsbecken entspricht. Es ist definiert als 
der Quotient aus der Trockenmasse des Schlamms im Belebungs-
becken (VBB · TSBB) und der im Mittel täglich produzierten (und 
abgezogenen bzw. abgetriebenen) Trockenmasse an Schlamm.
Wenn das Belebungsbecken anoxische Zonen zur Denitrifikation 
aufweist (VD), ist das aerobe Schlammalter (tTS,aerob) als Quotient der 
Trockenmasse des Schlamms im aeroben Teil des Belebungsbeckens 
(VN = VBB – VD) und der im Mittel täglich produzierten Masse an 
Schlamm definiert.“

aus DWA-A 131, 2016

Grundlegende Begriffe u. a. nach DWA-A 131, 2016 / KAINZ & GRUBER, 2011
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Wachstumsgeschwindigkeit der Mikroorganismen bei mittleren 
Temperaturverhältnissen:

Ergo: Heterotrophe haben eine rund 10-fach höhere 
Wachstumsgeschwindigkeit als Autotrophe! Das für die 
Bemessung einer Belebungsanlage ausschlaggebende 
Problemfeld ist demzufolge die Nitrifikation.

µmax

Heterotrophe ca. 6,00 /d
Autotrophe ca. 0,58 /d

Autotrophe und Heterotrophe
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Wachstumsgeschwindigkeit der nitrifizierenden Bakterien nach GUJER, 2007:

Unter den in D üblichen Temperaturen halbiert sich 
die Wachstumsgeschwindigkeit im Winter im 
Vergleich zum Sommerbetrieb! Um die gleiche Masse 
an Nitrifikanten im System zu halten, müsste der 
Reaktorraum (= Beckenvolumen) entsprechend 
vergrößert – d.h. in etwa verdoppelt – werden!

in üblicher mathematischer Schreibweise heißt das:

𝜇𝑚𝑎𝑥 = 0,29 ∗ 𝑒 0,11 ∗(𝑇  10)

wobei 𝑒 Eulersche Zahl (2,71828182845904…)
𝑇 Temperatur im Belebungsbecken in °C

µmax, Autotrophe

Tmax. 18 °C 0,70 /d

Tmin. 12 °C 0,36 /d

Autotrophe und Heterotrophe
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Gesetzl. Mindestanforderungen

Auszug aus Abwasserverordnung, Anhang 1 „Häusliches und kommunales Abwasser“
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Gesetzl. Mindestanforderungen

Auszug aus Abwasserverordnung, Anhang 1 „Häusliches und kommunales Abwasser“

„…Die Anforderungen gelten für Ammoniumstickstoff und 
Stickstoff, gesamt, bei einer Abwassertemperatur von 12 °C 
und größer im Ablauf des biologischen Reaktors der Abwasser-
behandlungsanlage. An die Stelle von 12 °C kann auch die 
zeitliche Begrenzung vom 1. Mai bis 31. Oktober treten…“
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Bemessung Klärwerk Stahnsdorf
nach DWA-A 131 – Teil 1

(Zulaufwerte, CSB- und Feststoffbilanz sowie
Fraktionierung, Schlammalter, Schlammanfall, 

VKB)

Abwasserbehandlung
(Wastewater Treatment)

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 1



Übliches Design einer kommunalen Kläranlage 
mit vorgeschalteter Denitrifikation

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 3

Bildquelle: https://info.bmlrt.gv.at/themen/wasser/wasserqualitaet/abwasserreinigung/klaeranlage.html

https://info.bmlrt.gv.at/themen/wasser/wasserqualitaet/abwasserreinigung/klaeranlage.html


Klärwerk Stahnsdorf
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Klärwerk Stahnsdorf
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Verfahrensfließbild Klärwerk Stahnsdorf
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Verfahrensfließbild Klärwerk Stahnsdorf
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Aufgabe: Bemessungsgrundlagen nach A 131

Arbeiten Sie das Kapitel „4. Bemessungsgrundlagen, 

4.1 Ermittlung der Belastungsdaten“ des DWA-A 131 

durch! Fassen Sie kurz zusammen, welche 

Ausgangsinformationen benötigt werden, um eine 

Kläranlage nach A 131 zu bemessen!

In Präsenz-LV
5 Minuten 
Selbststudium

DWA-A 
131

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 8
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Bemessungsgrundlagen nach A 131

Täglicher Abwasserzufluss bei Trockenwetter Qd

Tägliche CSB-Fracht im Zulauf zur KA Bd,CSB

Tägliche Feststofffracht im Zulauf zur KA Bd,X,TS

Tägliche N-Fracht im Zulauf zur KA Bd,N

Tägliche P-Fracht im Zulauf zur KA Bd,P

Maßgebende Konzentration des CSB CCSB

Maßgebende N-Konzentration CN

Maßgebende Konzentration des Phosphors CP

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 9



Bemessungsgrundlagen nach A 131

behördlicher Überwachungswert, CSB CCSB,ÜW

behördlicher Überwachungswert, Nanorg. SanorgN,ÜW

behördlicher Überwachungswert, Pges. CP,ÜW

Maßgebende tiefste Abwassertemperatur TBem., tief

Maßgebende höchste Abwassertemperatur TBem., hoch

Wir erinnern uns:
𝐶 - Konzentration eines Stoffes in der homogenisierten Probe (z.B. Total COD)
𝑆 - Konzentration eines Stoffes in der filtrierten Probe (z.B. COD soluble)
𝑋 - Feststoffkonzentration (aus der homogenisierten Probe z.B. COD particulate)
𝑄 - Abwasservolumenstrom
𝐵 - Last (oder Fracht) eines Stoffes in einem Abwasserstrom oder Fließgewässer

(Produkt aus 𝐶 und 𝑄)

Excel-Tabelle, Register 
„1 Zulaufwerte“

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 10

Bemessung KA Stahnsdorf nach A 131.xlsx
Bemessung KA Stahnsdorf nach A 131.xlsx


Aufgabe: Größenklasse und Mindestanforderungen 
für KA Stahnsdorf

Studieren Sie die auf Moodle eingestellten Dokumente 

und 

Nach Anhang 1 (Häusliches und kommunales Abwasser) der 

Abwasserverordnung werden die Mindestanforderungen an die 

Beschaffenheit des Ablaufs in ein Gewässer nach Größenklassen 

gestaffelt. 

Welche Größenklasse gilt für KA Stahnsdorf?

Welche Mindestanforderungen gelten demzufolge für diese KA?

Kurzbeschreibung und Verfahrensfließbild der KA Stahnsdorf

In Präsenz-LV
5 Minuten 
Selbststudium

Datenblatt sowie Zulauf- und Ablaufwerte der KA Stahnsdorf

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 11

KA Stahnsdorf - Kurzbeschreibung der BWB.pdf
KA Stahnsdorf - Datenblatt, Zu- und Ablaufwerte.pdf
KA Stahnsdorf - Datenblatt, Zu- und Ablaufwerte.pdf


Bemessung KA Stahnsdorf nach A 131

Grundsätzliche Vorgehensweise bei der Bemessung siehe 
Moodle, DWA-Regelwerk & Sonstige Unterlagen: 

DWA-A 131 –
Bemessung von einstufigen Belebungsanlagen.pdf

Praktische Übung anhand der Excel-Tabelle (ebenfalls auf 
Moodle eingestellt)

Bemessung KA Stahnsdorf nach A 131.xlsx
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Ausgangsdaten zur Bemessung der KA Stahnsdorf

Symbol 

in A 131
Bedeutung Meaning (engl.) Wert

𝐸𝑊 Einwohnerwert
Population 
equivalent (PE) 420.000 EW

𝑄𝑑
Täglicher Abwasserzufluss 
bei Trockenwetter

Daily wastewater 
inflow in dry weather 52.000 m³/d

𝑄𝑚
Bemessungszufluss bei 
Regenwetter

Design wastewater 
inflow in stormy 
weather

156.000 m³/d

𝐵𝑑,𝐶𝑆𝐵,𝑍
Tägliche CSB-Fracht im 
Zulauf zur KA

Daily COD load 54,68 t/d

𝐵𝑑,𝐵𝑆𝐵,𝑍
Tägliche BSB5-Fracht im 
Zulauf zur KA

Daily BOD load 22,8 t/d

𝐵𝑑,𝑇𝐾𝑁,𝑍
Tägliche TKN-Fracht im 
Zulauf zur KA

Daily TKN load 4,7 t/d

𝐵𝑑,𝑁𝑂3−𝑁,𝑍
Tägliche NO3-N-Fracht im 
Zulauf zur KA

Daily nitrate load 0 t/d

𝐵𝑑,𝑃,𝑍
Tägliche P-Fracht im Zulauf 
zur KA

Daily phosphorus 
load 0,6 t/d

𝐵𝑑,𝐴𝐹𝑆,𝑍
Tägliche Feststofffracht im 
Zulauf zur KA

Daily total solids load 23,9 t/d

Zulaufwerte

𝑄𝑚 = 𝑄𝑑 ∗ 1 + 2

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 13

Maßgeblich für Einstufung der 
Kläranlage in Größenklasse gemäß 
Anhang 1 der Abwasserverordnug

Excel-Tabelle, Register 
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Ausgangsdaten zur Bemessung der KA Stahnsdorf

Symbol 

in A 131
Bedeutung Meaning (engl.) Wert

Stababstand Rechen
Bar distance of the 
screen 8 cm

Volumen Sandfang (belüftet) Volume of grit trap 2 x 920 m³

𝑄𝑍𝐵 Abwasserzulauf zum BB
Influent flow to 
activated sludge 
aeration tank

52.000 m³/d

𝑄𝑅𝑆 Rücklaufschlammförderung
Recycled activated 
sludge (RAS) flow 70% von 𝑄𝑍𝐵

𝑄Ü𝑆
Überschussschlamm-
entnahme

Wasted activated 
sludge (WAS) flow 1.900 m³/d

𝑇𝑆𝐵𝐵 Feststoffgehalt im BB
Mixed Liquor 
Suspended Solids 3,5 - 5,0  g/l

𝑇𝑆𝑅𝑆
Feststoffgehalt im 
Rücklaufschlamm

RAS solids 8 g/l

𝑋𝑇𝑆,𝐴𝑁
Feststoffgehalt im Ablauf des 
NKB

Effluent solids 11,6 mg/l

𝑇𝐵𝑒𝑚.,𝑡𝑖𝑒𝑓
Maßgebende tiefste 
Abwassertemperatur

Lowest dimensioning 
temperature 12°C

𝑇𝐵𝑒𝑚.,ℎ𝑜𝑐ℎ … höchste … Highest … keine Angabe

Techn. Daten
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Ausgangsdaten zur Bemessung der KA Stahnsdorf

Symbol 

in A 131
Bedeutung Meaning (engl.) Wert

Volumen Vorklärung
Volume of Primary 
sedimentation tank 2.500 m³

Volumen fakultativ 
Vorklärung oder 
Zwischenspeicherbecken bei 
Regenwetter

Volume optional pre-
treatment or storage 
tank in stormy 
weather

7.800 m³

Gesamtvolumen Belebung
darunter

Total volume of 
activated sludge 
tanks

66.200 m³

anaerob anaerobic 6.000 m³

anoxisch anoxic 23.000 m³

aerob aerobic 37.200 m³

Volumen Nachklärung
Volume of secondary 
sedimentation tank 17.600 m³

𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 Luftzufuhr Aeration keine Angabe

𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 maximale Sauerstoffzufuhr 
Oxygen transfer, 
maximum keine Angabe

Techn. Daten
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Ausgangsdaten zur Bemessung der KA Stahnsdorf

Symbol 

in A 131
Bedeutung Meaning (engl.) Wert

𝐶𝐶𝑆𝐵,Ü𝑊
behördlicher 
Überwachungswert, CSB

Limit value COD 68 mg/l

𝑆𝑁𝑎𝑛𝑜𝑟𝑔.,Ü𝑊
behördlicher 
Überwachungswert, Nanorg.

Limit value nitrogen 13 mg/l

𝐶𝑃,Ü𝑊
behördlicher 
Überwachungswert, Pges.

Limit value 
phosphorus

1 mg/l

Überwachungs-
werte

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 16
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Wiederholung: Mindestanforderungen

Auszug aus Abwasserverordnung, Anhang 1 „Häusliches und kommunales Abwasser“
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Parameter Kürzel

behördlicher Überwachungswert, CSB CCSB,ÜW

behördlicher Überwachungswert, Nanorg. SanorgN,ÜW

behördlicher Überwachungswert, Pges. CP,ÜW

MA

75 mg/l

13 mg/l

1 mg/l

Ü-Wert

68 mg/l

13 mg/l

1,0 mg/l

Überwachungswerte KA Stahnsdorf

Die Berliner Wasserbehörde hielt es offenbar aus Gründen des Immissionsschutzes für 
geboten, für CSB einen Überwachungswert (Spalte Ü-Wert) festzulegen, der „schärfer“ als 
die Mindestanforderungen (Spalte MA) gemäß Anhang 1 „Häusliches und kommunales 
Abwasser“ der Abwasserverordnung ist. 
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Zulauf- und Ablaufwerte der KA Stahnsdorf

(nach Angaben der BWB)

Parameter Zulauffrachten Resultierende 

Zulaufkonzentration 

bei 52 000 m³/d

Ablaufwerte 

gerundet

Eliminierung

BSB 22,80 t/d 438 mg/l 5 mg/l 98,9%

CSB 54,68 t/d 1052 mg/l 41 mg/l 96,1%

TKN 4,70 t/d 90 mg/l

NH4-N 3,42 t/d 66 mg/l 0,2 mg/l 99,7%

TIN 3,42 t/d 66 mg/l 11,3 mg/l 82,9%

P gesamt 0,60 t/d 12 mg/l 0,6 mg/l 95,0%

AFS 23,90 t/d 460 mg/l 7 mg/l 98,5%
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gasförmiger Stickstoff Nitrit Nitrat Ammonium Gelöster organischer 

Stickstoff

Dissolved Organic 

Nitrogen (DON)

Partikulärer 

organischer Stickstoff

Particulate Organic 

Nitrogen (PON)

Gesamtstickstoff (einer Wasser-/Abwasserprobe)

Total Nitrogen (TN)

Gesamter organischer Stickstoff

Total Organic Nitrogen (TON)

Gesamter anorganischer Stickstoff

Total Inorganic Nitrogen (TIN)

Total Kjeldahl Nitrogen (TKN)Total Nitrogen bounded (TNb)Total Nitrogen bounded (TNb)

Sofort zugänglich (bioverfügbar) für 
Wasserpflanzen und andere -organismen

Erst nach mikrobiellem Abbau 
bioverfügbar 

NOx-N und NH4-N kommen
ausschließlich in gelöster Form vor!

Summe aus NOx-N und NH4-N ist in D 
i.a.R auch Überwachungswert (Nges.anorg.)!

N-Bilanz und Fraktionierung
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Aufgabe: CSB-Fraktionierung KA Stahnsdorf

Arbeiten Sie das Kapitel 

4.2 Fraktionierung des chemischen Sauerstoffbedarfs 

des DWA-A 131 durch! 

In der letzten LV hatten wir die CSB-Fraktionen und deren Bedeutung 

bereits besprochen. Studieren Sie, was dazu in DWA-A 131 steht!

Aus den vorhandenen Zulaufwerten für Klärwerk Stahnsdorf sollen die 

maßgeblichen Fraktionen des CSB und der Feststoffe im Zulauf zum 

Belebungsbecken ermittelt werden. Soweit keine Angaben vorliegen, 

sind diese unter Verwendung der in DWA-A 131 aufgeführten Faust-

werte zu schätzen.

In Präsenz-LV
15 Minuten 
Selbststudium
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DWA-A 
131

Excel-Tabelle, Register 
„2 CSB-Bilanz“
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Bemessung KA Stahnsdorf nach A 131.xlsx
Bemessung KA Stahnsdorf nach A 131.xlsx
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Grafik:
Fraktionierung des 
CSB und der 
Feststoffe -
grundsätzliche 
Vorgehensweise 
bei Vorliegen von 
Messwerten

CSB-/Feststoff-Fraktionierung (Bei Vorliegen der links aufgeführten 
Messwerte für CSB, BSB und 
Feststoffe)
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CCSB

Konzentration des CSB 

in der homogenisierten 

Probe

Total COD 600 mg CSB/l 600 mg CSB/l 100% 35,0% 390 mg CSB/l 100% 1

XTS

Konzentration der mit 

0,45 μm Membranfilter 

abfiltrierbaren Stoffe 

nach

Trocknung bei 105 °C

Total SS 350 mg TS/l 350 mg TS/l 100% 60,0% 140 mg TS/l 100% 2

XanorgTS

Konzentration der 

abfiltrierbaren 

anorganischen Stoffe

Nonvolatile SS 105 mg TS/l 70 mg TS/l 20% 60,0% 28 mg TS/l 20% 3

XorgTS

Konzentration der 

abfiltrierbaren 

organischen Stoffe

Volatile SS 245 mg TS/l 280 mg TS/l 80% 60,0% 112 mg TS/l 80% 4

XCSB

Konzentration des 

partikulären CSB 

(Filterrückstand)

COD particulate 400 mg CSB/l 67% 55,0% 180 mg CSB/l 46% 5

SCSB

Konzentration des 

gelösten CSB in der mit 

0,45 μm filtrierten Probe

COD soluble 210 mg CSB/l 35% 0,0% 210 mg CSB/l 54% 6

SCSB,inert
Konzentration des 

gelösten, inerten CSB

COD soluble, 

nondegradable
20 mg CSB/l 3% 0,0% 20 mg CSB/l 5% 7

XCSB,inert
Konzentration des 

inerten, partikulären CSB

COD particulate, 

nondegradable
120 mg CSB/l 20% 55,0% 54 mg CSB/l 14% 8

CCSB,abb

Konzentration des 

abbaubaren CSB in der 

homogenisierten Probe

COD  biodegradable

(= Total BOD)
486 mg CSB/l 81% 35,0% 316 mg CSB/l 81% 9

XCSB,abb

Konzentration des 

abbaubaren, partikulären 

CSB

COD particulate, 

biodegradable

(= Particulate BOD)

280 mg CSB/l 47% 55,0% 126 mg CSB/l 32% 10

SCSB,abb

Konzentration des 

gelösten, abbaubaren 

CSB

COD soluble 

biodegradable

(= Soluble BOD)

190 mg CSB/l 32% 0,0% 190 mg CSB/l 49% 11

CCSB,inert

Konzentration des 

inerten CSB in der 

homogenisierten Probe

COD nondegradable 114 mg CSB/l 19% 35,0% 74 mg CSB/l 19% 12
R
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DWA-A 131
engl. 

Bezeichnung
Zulauf Kläranlage hVKB

Zulauf Belebung nach 

1,5…2 h VKB

  

Tabelle:
Fraktionierung des 
CSB und der 
Feststoffe nach 
DWA-A 131, 2016
für normal 
verschmutztes 
häusliches 
Abwasser 

CSB-/Feststoff-Fraktionierung
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(Mittelwerte für normal 
verschmutztes häusliches Abwasser)

Excel-Tabelle, Register 
„1 Zulaufwerte“

Bemessung KA Stahnsdorf nach A 131.xlsx


Gesamt CSB
390 mg/l

Gelöster CSB
211 mg/l

Partikulärer CSB
179 mg/l

Gelöster CSB,
abbaubar
191 mg/l

Gelöster CSB,
nicht abbaubar

20 mg/l

Partikulärer CSB,
abbaubar
125 mg/l

Partikulärer CSB,
nicht abbaubar

54 mg/l

Abfiltrierbare 
Stoffe

140 mg/l

Abfiltrierbare Stoffe
organisch (Glühverlust)

112 mg/l

Abfiltrierbare Stoffe
anorganisch (Glührückstand)

28 mg/l

Grafik:
Fraktionierung des CSB und 
der Feststoffe 
für normal verschmutztes 
häusliches Abwasser 
nach DWA-A 131, 2016
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CSB-/Feststoff-Fraktionierung (Mittelwerte für normal 
verschmutztes häusliches Abwasser)

Excel-Tabelle, Register 
„1 Zulaufwerte“

Bemessung KA Stahnsdorf nach A 131.xlsx


CSB-/Feststoff-Fraktionierung

Vorgehensweise, wenn nur der CSBgesamt und die abfiltrierbaren Stoffe bekannt sind 
(unter Verwendung der Faustwerte gemäß DWA-A 131, 2016)

1. Fraktionierung der Feststoffe (abf. Stoffe)

1a)  Bestimmung der anorganischen Fraktion Feststoffe (XanorgTS,ZB)

= abfiltr. Stoffe * Faustwert fB

(gemäß DWA-A 161: fB = 0,3 für Rohabwasser 
bzw. fB = 0,2 für vorgeklärtes Abwasser)

1b)  Berechnung der organischen Fraktion der Feststoffe (XorgTS,ZB)

= abfiltr. Stoffe - anorganische Feststofffraktion
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CSB-/Feststoff-Fraktionierung
2. Ermittlung der partikulären CSB-Fraktion (XCSB,ZB)

= org. Feststofffraktion * Faustwert
(gemäß DWA-A 161: 1,6 g CSB/g org. TS 

3. Berechnung der gelösten CSB-Fraktion (SCSB,ZB)

= CSBgesamt - partikuläre CSB-Fraktion 

4. Ermittlung der schwer abbaubaren gelösten CSB-Fraktion (SCSB,inert,ZB)

= CSBgesamt * Faustwert fS

(gemäß DWA-A 161: fS = 0,05)

5. Berechnung der gelösten abbaubaren CSB-Fraktion (SCSB,abb,ZB)

= gelöste CSB-Fraktion - schwer abbaubare gelöste CSB-Fraktion 
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CSB-/Feststoff-Fraktionierung

6. Ermittlung der schwer abbaubaren partikulären CSB-Fraktion (XCSB,inert,ZB)

= partikuläre CSB-Fraktion * Faustwert fA

(gemäß DWA-A 161: fA = 0,3)

7. Berechnung der partikulären abbaubaren CSB-Fraktion (XCSB abb,ZB)

= partikuläre CSB-Fraktion - schwer abbaubare partikuläre CSB-Fraktion 

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 29



Excel-Tabelle, Register 
„1 Zulaufwerte“

CSB-/Feststoff-Fraktionierung KA Stahnsdorf Version A

736 mg/l

405 mg/l

442 mg/l VSS * 1,6 = 294 mg/l

COD part. * 0,3 = 88 mg/l

184 mg/l

230 mg/l

TSS * 0,2 = 46 mg/l

206 mg/lTotal COD * 0,05 = 37 mg/l

Bei der hier – und in der Excel-Tabelle - zur Anwendung gebrachten Fraktionierung wird lediglich auf zwei Messwerte zurückgegriffen (Total COD und Total 
Suspended Solids). Daraus werden alle erforderlichen Kompartimente mit Hilfe der in DWA-A 131 angegebenen Formeln errechnet.
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Bemessung KA Stahnsdorf nach A 131.xlsx


CSB-/Feststoff-Fraktionierung KA Stahnsdorf Version B

736 mg/l

405 mg/l

611 mg/l

COD particulate = VSS * 1,6 = 294 mg/l

COD part. * 0,3 = 88 mg/l

184 mg/l

230 mg/l

TSS * 0,2 = 46 mg/l

125 mg/l

Bei der hier – und in der Excel-Tabelle - zur Anwendung gebrachten Fraktionierung wird lediglich auf zwei Messwerte zurückgegriffen (Total COD und Total 
Suspended Solids). Daraus werden alle erforderlichen Kompartimente mit Hilfe der in DWA-A 131 angegebenen Formeln errechnet.

206 mg/l Total COD * 0,05 = 37 mg/l
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Excel-Tabelle, Register 
„1 Zulaufwerte“

Bemessung KA Stahnsdorf nach A 131.xlsx


Aufgabe: Beckenvolumina der biologischen 
Behandlung der KA Stahnsdorf

Die Volumina der biologischen Behandlungsstufen der Klärwerk 

Stahnsdorf gehen aus dem Dokument „Klärwerk Stahnsdorf“ hervor. Sie 

sollen aber nach dem A 131 überprüft werden. Dazu sollen zunächst die 

verschiedenen Volumina, die für die biologische Phosphateliminierung 

(anaerob), Nitrifikation (aerob) bzw. Denitrifikation (anoxisch) zur 

Verfügung stehen, in einer Skizze eingetragen werden.

In Präsenz-LV
5 Minuten 
Selbststudium
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DWA-A 
131
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Skizze KA Stahnsdorf, maßgebliche Stufen
Stufe VKB BioP DN N NKB

Volumen
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2.500 m³
6.000 m³ 23.000 m³ 37.200 m³

17.600 m³
66.200 m³



Aufgabe: Bemessungsschlammalter 

Arbeiten Sie die Kapitel 

5 Berechnung der Schlammmasse 

5.1 Erforderliches Schlammalter

5.1.1 Allgemeines 

5.1.3 Anlagen mit Nitrifikation 

5.1.5 Anlagen mit Nitrifikation und Denitrifikation 

im DWA-A 131 durch! 

Beschreiben Sie in groben Zügen, wie das  Bemessungsschlammalter 

bestimmt wird!

In Präsenz-LV
10 Minuten 
Selbststudium
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Anlagen mit Nitrifikation: Anlagen mit Nitrifikation und Denitrifikation:

Beide Formel wurden empirisch ermittelt! 3,4 =
1,6

0,47
(µA,max bei 15°C = 0,47)

PF - Prozessfaktor

DWA-A 
131

SF - Sicherheitsfaktor
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Volumenstrom- und Feststoffbilanzen 

𝑄𝑍𝐵

𝑄𝑅𝑆

𝑇𝑆𝐵𝐵

𝑇𝑆𝑅𝑆

𝑄Ü𝑆

𝑋𝑇𝑆,𝐴𝑁

𝑄𝑍𝐵 − 𝑄Ü𝑆

𝑇𝑆𝑅𝑆

𝑄𝑍𝐵 + 𝑄𝑅𝑆 ∗ 𝑇𝑆𝐵𝐵 = 𝑄𝑅𝑆 + 𝑄Ü𝑆 ∗ 𝑇𝑆𝑅𝑆 + 𝑄𝑍𝐵 − 𝑄Ü𝑆 ∗ 𝑋𝑇𝑆,𝐴𝑁

𝑄𝑍𝐵
+ 𝑄𝑅𝑆

𝑇𝑆𝐵𝐵

Vollständige TS-Bilanz NKB:
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𝑄𝑍𝐵

𝑇𝑆𝐵𝐵

Vereinfachte Feststoffbilanz NKB 

𝑄Ü𝑆

𝑋𝑇𝑆,𝐴𝑁

𝑄𝑍𝐵 − 𝑄Ü𝑆

𝑇𝑆𝑅𝑆

Schlammbilanz für NKB ausgeglichen, wenn genau so viel Schlamm entnommen wie zugeführt 
wird. Wenn 𝑋𝑇𝑆,𝐴𝑁 = vernachlässigbar gering und die Entnahme von Überschussschlamm exakt 
den Schlammzuwachs im BB ausgleicht, können Ablauf NKB und 𝑄Ü𝑆 unberücksichtigt bleiben.

𝑄𝑅𝑆

𝑇𝑆𝑅𝑆

𝑄𝑍𝐵
+ 𝑄𝑅𝑆

𝑇𝑆𝐵𝐵
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𝑄𝑍𝐵

𝑇𝑆𝐵𝐵

𝑄𝑅𝑆

𝑇𝑆𝑅𝑆

Vereinfachte Feststoffbilanz NKB 

𝑄𝑍𝐵 + 𝑄𝑅𝑆 ∗ 𝑇𝑆𝐵𝐵 = 𝑄𝑅𝑆 ∗ 𝑇𝑆𝑅𝑆Dann gilt... Mit 𝑄𝑅𝑆 = 𝑄𝑍𝐵 ∗ 𝑅𝑉

ergibt sich 𝑄𝑍𝐵 + 𝑄𝑍𝐵 ∗ RV ∗ 𝑇𝑆𝐵𝐵 = 𝑄𝑍𝐵 ∗ 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

𝑄𝑍𝐵
+ 𝑄𝑅𝑆

𝑇𝑆𝐵𝐵
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Vereinfachte Feststoffbilanz NKB 

𝑄𝑍𝐵 + 𝑄𝑍𝐵 ∗ RV ∗ 𝑇𝑆𝐵𝐵 = 𝑄𝑍𝐵 ∗ 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

wird umgewandelt in 𝑄𝑍𝐵 ∗ 1 + RV ∗ 𝑇𝑆𝐵𝐵 = 𝑄𝑍𝐵 ∗ 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

nach Kürzen von 𝑄𝑍𝐵 ergibt sich 1 + RV ∗ 𝑇𝑆𝐵𝐵 = 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

𝑇𝑆𝐵𝐵 =
𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆
1 + 𝑅𝑉

Auflösen nach 𝑻𝑺𝑩𝑩 führt zu der in A 131 (auf S. 41) aufgeführten Formel
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DWA-A 
131
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Vereinfachte Feststoffbilanz NKB 

aus der vorletzten Gleichung 1 + RV ∗ 𝑇𝑆𝐵𝐵 = 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

erhält man durch Auflösen der Klammer:

𝑇𝑆𝐵𝐵 + 𝑅𝑉 ∗ 𝑇𝑆𝐵𝐵 = 𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆

Division durch 𝑅𝑉, 
Subtraktion von 𝑇𝑆𝐵𝐵

𝑇𝑆𝐵𝐵
𝑅𝑉

= 𝑇𝑆𝑅𝑆 − 𝑇𝑆𝐵𝐵

erhält man durch Auflösen nach 𝑻𝑺𝑹𝑺:

𝑇𝑆𝑅𝑆 = 𝑇𝑆𝐵𝐵 ∗
1 + 𝑅𝑉

𝑅𝑉 Auflösen nach 𝑹𝑽 führt zu:

𝑅𝑉 =
𝑇𝑆𝐵𝐵

𝑇𝑆𝑅𝑆 − 𝑇𝑆𝐵𝐵
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Berechnung von 𝑇𝑆𝐵𝐵, 𝑇𝑆𝑅𝑆 und 𝑅𝑉

𝑇𝑆𝑅𝑆 = 𝑇𝑆𝐵𝐵 ∗
1 + 𝑅𝑉

𝑅𝑉

𝑅𝑉 =
𝑇𝑆𝐵𝐵

𝑇𝑆𝑅𝑆 − 𝑇𝑆𝐵𝐵
𝑇𝑆𝐵𝐵 =

𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆
1 + 𝑅𝑉

𝑇𝑆𝐵𝑆  10 kg/m³ = 10 g/l

𝑇𝑆𝑅𝑆  0,7 * 𝑇𝑆𝐵𝑆  7 kg/m³ = 7 g/l

Faustwerte, als erster
Ansatz für die meisten
KA gut geeignet 

Einer der beiden folgenden Werte muss zunächst (innerhalb des zulässigen bzw. 
üblichen Wertebereichs) gewählt werden:

𝑅𝑉 = 0,7 … 1,5 TSBB = 3.000 … 5.000 mg/l
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Anwenden der Formeln auf KA Stahnsdorf 

𝑅𝑉 =
𝑇𝑆𝐵𝐵

𝑇𝑆𝑅𝑆 − 𝑇𝑆𝐵𝐵
=

3,3 𝑔/𝑙

8 𝑔/𝑙 − 3,3 𝑔/𝑙
≈ 0,7

𝑇𝑆𝐵𝐵 =
𝑅𝑉 ∗ 𝑇𝑆𝑅𝑆
1 + 𝑅𝑉

=
0,7 ∗ 8 𝑔/𝑙

1 + 0,7
≈ 3,3

𝑔

𝑙
= 3.300 𝑚𝑔/𝑙

𝑅𝑉 = 0,7

Gegenprobe:

Siehe „Kenndaten und 
Kurzbeschreibung KA 
Stahnsdorf“

𝑇𝑆𝑅𝑆 = 8
𝑔

𝑙

Vgl. Excel-Tabelle, Register „9 ISV, tE, TSBB, RV“
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Berechnung des aeroben Schlammalters

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 = 𝑃𝐹 ∗
1

𝜇𝐴,𝑚𝑎𝑥
∗ 1,6 ∗ 1,103 15−𝑇 [d]

𝑃𝐹 Prozessfaktor (dimensionslos)

𝜇𝐴,𝑚𝑎𝑥 maximale Wachstumsgeschwindigkeit der autotrophen (nitri-
fizierenden) Mikroorganismen (in DWA-A 131 wird bei einer 

Temperatur von 15°C gerechnet mit einem Wert von 0,47 
1

𝑑
)

𝑇 Temperatur des Abwassers [°C]

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 = 𝑃𝐹 ∗ 3,4 ∗ 1,103
(15−𝑇)[d]

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 Minimum des aeroben Schlammalters für die Bemessung [d]

Der hier berechnete Wert gilt für den aeroben Teil des 
Belebungsbeckens (weil sich nur hier die Autotrophen 
vermehren können) 
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Excel-Tabelle Register 
„5 tTS,aerob, Anteil VD“

Bemessung KA Stahnsdorf nach A 131.xlsx


Berechnung des Bemessungsschlammalters

𝑡𝑇𝑆,𝐵𝑒𝑚 = 𝑃𝐹 ∗ 3,4 ∗ 1,103
15−𝑇

1

1 −
𝑉𝐷
𝑉𝐵𝐵

[d]

𝑃𝐹 Prozessfaktor (dimensionslos)

𝑉𝐷 Volumen des Belebungsbeckens für Denitrifikation [m³]

𝑇 Temperatur des Abwassers [°C]

𝑉𝐵𝐵 Volumen des Belebungsbeckens [m³]

𝑡𝑇𝑆,𝐵𝑒𝑚 = 𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 ∗
1

1 −
𝑉𝐷
𝑉𝐵𝐵

[d]

𝑡𝑇𝑆,𝐵𝑒𝑚 Bemessungsschlammalter bezogen auf 𝑉𝐵𝐵 [d]

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 Minimum des aeroben Schlammalters für die Bemessung [d]
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Berechnung des Volumens der Belebung 

𝑀𝑇𝑆,𝐵𝐵 = 𝑡𝑇𝑆,𝐵𝑒𝑚 ∗ Ü𝑆𝑑 [kg]

Ü𝑆𝑑 Tägliche Schlammproduktion (Feststoffe) [kg TS/d]

𝑉𝐵𝐵 Volumen des Belebungsbeckens [m³]

𝑉𝐵𝐵 ≥
𝑀𝑇𝑆,𝐵𝐵
𝑇𝑆𝐵𝐵

[m³]

𝑡𝑇𝑆,𝐵𝑒𝑚 Bemessungsschlammalter bezogen auf 𝑉𝐵𝐵 [d]

𝑀𝑇𝑆,𝐵𝐵 erforderliche Masse der Feststoffe im Belebungsbecken [kg TS]

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 45

Ü𝑆𝑑,𝐶 Tägliche Schlammproduktion aus der Kohlenstoffelimination [kg TS/d]

Ü𝑆𝑑,𝑃 Tägliche Schlammproduktion aus der Phosphorelimination [kg TS/d]

𝑉𝐵𝐵 ≥
Ü𝑆𝑑 ∗ 𝑡𝑇𝑆,𝐵𝑒𝑚

𝑇𝑆𝐵𝐵
[m³]

Ü𝑆𝑑 = Ü𝑆𝑑,𝐶 + Ü𝑆𝑑,𝑃 [kg]
Excel-Tabelle Register 
„8 MTS, VBB, VN, VD“
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Berechnung der Volumenanteile des BB für N und DN

𝑉𝐷
𝑉𝐵𝐵
= 1 −

𝑃𝐹 ∗ 3,4 ∗ 1,103(15−𝑇)

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚
[d]

𝑃𝐹 Prozessfaktor (dimensionslos)

𝑉𝐷 Volumen des Belebungsbeckens für Denitrifikation [m³]

𝑇 Temperatur des Abwassers [°C]

𝑉𝐵𝐵 Volumen des Belebungsbeckens [m³]

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 Minimum des aeroben Schlammalters für die Bemessung [d]
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𝑉𝑁 Volumen des Belebungsbeckens für Nitrifikation [m³]

𝑉𝑁 =
𝑉𝐵𝐵

1 −
𝑉𝐷
𝑉𝐵𝐵

[m³]

𝑉𝐷 = 𝑉𝐵𝐵 ∗
𝑉𝐷
𝑉𝐵𝐵

[m³]

𝑉𝐵𝐵 = 𝑉𝑁 + 𝑉𝐷 [m³] Excel-Tabelle Register 
„8 MTS, VBB, VN, VD“

Excel-Tabelle Register 
„5 tTS,aerob, Anteil VD“
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Anwenden der Formeln auf KA Stahnsdorf 

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 = 1,4 ∗
1

0,47
∗ 1,6 ∗ 1,103 15−12 = 6,39 ≈ 7 d

𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 = 1,4 ∗ 3,4 ∗ 1,103
(15−12) ≈ 7 d

𝑡𝑇𝑆,𝐵𝑒𝑚 = 10 ∗
1

1 − 0,35
≈ 16 d
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Gewählt: 10 d

Ü𝑆𝑑 = 12.768 + 1.191 ≈ 14.000 kg 𝑇𝑆/𝑑 Vgl. Excel-Tabelle,
Register „7 ÜSd, FT, tTS“ 
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Anwenden der Formeln auf KA Stahnsdorf 

𝑉𝐷
𝑉𝐵𝐵
= 1 −

1,4 ∗ 3,4 ∗ 1,103 15−8

16
≈ 0,41
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𝑀𝑇𝑆,𝐵𝐵 = 16 𝑑 ∗ 14.000 𝑘𝑔
𝑇𝑆

𝑑
= 224.000 kg 𝑇𝑆

𝑉𝐵𝐵 ≥
14.000

𝑘𝑔
𝑑
∗ 16𝑑

3,3
𝑘𝑔
𝑚3

≈ 68.000 𝑚³

𝑉𝑁 =
68.000

1 − 0,41
≈ 40.300 [m³]

𝑉𝐷 = 68.000 ∗ 0,41 ≈ 27.700m³

Ergo: Hinreichend gute 
Übereinstimmung!

Excel-Tabelle Register 
„5 tTS,aerob, Anteil VD“

Excel-Tabelle Register 
„8 MTS, VBB, VN, VD“

../Ü_02/Bemessung KA 90.000 EW nach A 131 - Aufgabe und Lösungen.xlsx
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gasförmiger Stickstoff Nitrit Nitrat Ammonium Gelöster organischer 

Stickstoff

Dissolved Organic 

Nitrogen (DON)

Partikulärer 

organischer Stickstoff

Particulate Organic 

Nitrogen (PON)

Gesamtstickstoff (einer Wasser-/Abwasserprobe)

Total Nitrogen (TN)

Gesamter organischer Stickstoff

Total Organic Nitrogen (TON)

Gesamter anorganischer Stickstoff

Total Inorganic Nitrogen (TIN)

Total Kjeldahl Nitrogen (TKN)Total Nitrogen bounded (TNb)Total Nitrogen bounded (TNb)

Sofort zugänglich (bioverfügbar) für 
Wasserpflanzen und andere -organismen

Erst nach mikrobiellem Abbau 
bioverfügbar 

NOx-N und NH4-N kommen
ausschließlich in gelöster Form vor!

Summe aus NOx-N und NH4-N ist in D 
i.a.R auch Überwachungswert (Nges.anorg.)!

N-Bilanz und Fraktionierung
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N-Bilanz

Metabolisierung der Stickstoffkompartimente bei der Abwasserbehandlung
aus LONDONG, 2009

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 50



N-Bilanz

Grobbilanz der Stickstoffkompartimente in Kläranlagen mit Denitrifikation
aus LONDONG, 2009
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Berechnung von 𝑅𝐹

𝑅𝐹 =
𝑆𝑁𝐻4,𝑁
𝑆𝑁𝑂3,𝐴𝑁

− 1 =
𝑄𝑅𝑆
𝑄𝑇,𝑚𝑎𝑥

+
𝑄𝑅𝑍
𝑄𝑇,𝑚𝑎𝑥

𝑅𝐹 Rückführverhältnis, für das die Pumpen auszulegen sind

𝑆𝑁𝐻4,𝑁 Zu nitrifizierender Ammoniumstickstoff

𝑆𝑁𝑂3,𝐴𝑁 Konzentration an Nitratstickstoff, die im Ablauf der Nachklärung 
einzuhalten ist (ergibt sich aus den Überwachungswerten)

𝑄𝑅𝑆 Rücklaufschlammstrom

𝑄𝑅𝑍 Interne Rezirkulation bei vorgeschalteter Denitrifikation

𝑄𝑇,𝑚𝑎𝑥 Maximaler Trockenwetterzufluss

Vgl. Excel-Tabelle,
Register „10 int. Rezi“
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Achtung Verwechselungsgefahr!

𝑅V 𝑅𝐹
Rücklaufverhältnis, 

bezieht sich auf 
Rücklaufschlammstrom

Rückführverhältnis bei vorge-
schalteter Denitrifikation, 
bezieht sich auf 
interne Rezirkulation
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Wirkungsgrad der Denitrifikation
Theoretisch berechnet sich der Wirkungsgrad der Denitrifikation nach folgender Gleichung:

𝜂𝐷 ≤ 1 −
1

1 + 𝑅𝐹 𝑅𝐹 Rückführverhältnis, für das die 
Pumpen auszulegen sind

𝜂𝐷 Maximal möglicher Wirkungsgrad 
der Denitrifikation

aus LONDONG, 2009
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Die Berechnungsergebnisse stimmen 
jedoch mit den Praxiswerten i.d.R. 
nicht überein, da infolge des Sauer-
stofftransportes in die Denitrifika-
tionsstufe, der Verdünnung und der 
abnehmenden Kontaktzeit negative 
Wirkungen eintreten – das ist 
abgebildet in der nebenstehenden 
Grafik!

In praxi wird deshalb 𝑅𝐹 ≤ 4 gesetzt.



𝑅𝐹 und 𝑄𝑅𝑧 berechnen für KA Stahnsdorf

𝑅𝐹 =
81, 3𝑚𝑔 𝑁/𝑙

9,1 𝑚𝑔 𝑁/𝑙
− 1 = 7,9

TKN-Konzentration im Zulauf zur Belebung 𝐶𝑇𝐾𝑁,𝑍𝐵

Nitratstickstoff im Ablauf 𝑆𝑁𝑂3,𝐴𝑁

𝑄𝑅𝑍 = RF ∗ 𝑄𝑍𝐵 − 𝑅𝑉 ∗ 𝑄𝑍𝐵 = 𝑅𝐹 − 𝑅𝑉 ∗ 𝑄𝑍𝐵

Warum ist der Volumenstrom der Rücklaufschlammförderung auf den für 
die Denitrifikation zu rezirkulierenden Volumenstrom an nitratreichem 
Abwasser aus der Nitrifikation anzurechnen?

𝑄𝑅𝑍 = 3 − 0,7 ∗ 2.170 𝑚3/ℎ ≈ 5.000 𝑚3/ℎ

Siehe Excel-Tabelle,
Register „3 N-Bilanz“

Warum darf hier TKN 
anstelle von Ammonium 
gesetzt werden?

Siehe Excel-Tabelle,
Register „10 int. Rezi“

Der errechnete Wert überschreitet das Optimum (siehe vorhergehende Folie). 
Deshalb wird RF gewählt zu 3.
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66.200 𝑚³ 17.600 𝑚³

Volumenstrombilanz KA Stahnsdorf für 𝑄𝑡

2.167 𝑚³/ℎ

𝑄𝑅𝑆 = 0,7 ∗ 2.167 ≈ 1.517 𝑚
3/ℎ

79 𝑚³/ℎ

2.167 − 79 = 2.088 𝑚3/ℎ

𝑄𝑅𝑍 = 3 − 0,7 ∗ 2.167 = 4.984 𝑚3/ℎ

𝑄𝑍𝐵 = 𝑄𝑡 = 2.167 𝑚³/ℎ
𝑅𝐹 = 3
𝑅𝑉 = 0,7
𝑄Ü𝑆,𝑑 = 1.900 𝑚³/𝑑 ≈ 79 𝑚

3/ℎ

𝑄𝑅𝑍 = 𝑅𝐹 − 𝑅𝑉 ∗ 𝑄𝑍𝐵𝑅𝐹 =
𝑄𝑅𝑆 + 𝑄𝑅𝑍
𝑄𝑍𝐵

𝑄𝑅𝑆 = 𝑅𝑉 ∗ 𝑄𝑍𝐵

2.167 +
1.517 =
3.684 𝑚³/ℎ

3.684 −2.088
= 1.596 𝑚³/ℎ

(Trockenwetterfall)
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66.200 𝑚³ 17.600 𝑚³

Feststoffbilanz KA Stahnsdorf für 𝑄𝑡

2.167 𝑚³/ℎ ∗ 0,3 𝑘𝑔/𝑚³ ≈ 0.65 𝑡/ℎ

𝑇𝑆𝑅𝑆 = 0,7 ∗ 2.167 𝑚
3/ℎ ∗ 8 𝑘𝑔/𝑚³ ≈ 12,1 𝑡/ℎ

𝑇𝑆Ü𝑆 = 79𝑚³/ℎ
∗ 8 𝑘𝑔/𝑚³ ≈ 0,6 𝑡/ℎ

2.088 𝑚³/ℎ ∗ 0,007 𝑘𝑔/𝑚3

≈ 0,014 𝑡/ℎ

3.684 𝑚³/ℎ
∗ 3,3 𝑘𝑔/𝑚³ ≈ 12,2 𝑡/ℎ

𝑇𝑆𝑅𝑍 = 3 − 0,7 ∗ 2.167 𝑚3/ℎ ∗ 3,3 𝑘𝑔/𝑚³ ≈ 16, 4 𝑡/ℎ

1.596 𝑚³/ℎ ∗
8 𝑘𝑔/𝑚³ ≈
12,8 𝑡/ℎ

𝑇𝑆𝐵𝐵 = 3.3 𝑘𝑔/𝑚³

(Trockenwetterfall)𝑄𝑍𝐵 = 𝑄𝑡 = 2.167 𝑚³/ℎ
𝑅𝐹 = 3
𝑅𝑉 = 0,7
𝑄Ü𝑆,𝑑 = 1.900 𝑚³/𝑑 ≈ 79 𝑚

3/ℎ

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 57



𝑉𝐵𝐵 ≥
𝑀𝑇𝑆,𝐵𝐵
𝑇𝑆𝐵𝐵

=
Ü𝑆𝑑 ∗ 𝑡𝑇𝑆
𝑇𝑆𝐵𝐵

[𝑚3]

Volumen des Belebungsbeckens

Feststoffmasse im BB

𝑀𝑇𝑆,𝐵𝐵 = 𝑉𝐵𝐵 ∗ 𝑇𝑆𝐵𝐵 [𝑘𝑔 𝑇𝑆]

Schlammalter

𝑡𝑇𝑆 =
𝑀𝑇𝑆,𝐵𝐵
Ü𝑆𝑑

=
𝑉𝐵𝐵 ∗ 𝑇𝑆𝐵𝐵
Ü𝑆𝑑

[𝑑]

𝐵𝑑,𝐵𝑆𝐵 [
𝑘𝑔 𝐵𝑆𝐵5
𝑑

]

BSB5-Tagesfracht

𝐵𝑇𝑆 =
𝐵𝑑,𝐵𝑆𝐵
𝑀𝑇𝑆,𝐵𝐵

=
𝐵𝑑,𝐵𝑆𝐵

𝑉𝐵𝐵 ∗ 𝑇𝑆𝐵𝐵
≤ 0,15

𝑘𝑔 𝐵𝑆𝐵5
𝑘𝑔 𝑇𝑆 ∗ 𝑑

BSB5-Schlammbelastung

Zusammenhang zwischen 𝑉𝐵𝐵, 𝑡𝑇𝑆, 𝑀𝑇𝑆 und 𝐵𝑇𝑆

Diese Gleichung umgestellt nach 𝑉𝐵𝐵
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Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, 𝑀𝑇𝑆 und 𝐵𝑇𝑆
Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 

(konstruiertes Beispiel):

𝑉𝐵𝐵,𝐿ä𝑛𝑔𝑒 = 80 𝑚

𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 25 𝑚

𝑉𝐵𝐵,𝑇𝑖𝑒𝑓𝑒 = 5 𝑚

𝑽𝑩𝑩 = 𝟏𝟎. 𝟎𝟎𝟎𝒎³

𝑉𝐵𝐵,𝐿ä𝑛𝑔𝑒 = 80 𝑚

𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 𝟏𝟐, 𝟓 𝒎

𝑉𝐵𝐵,𝑇𝑖𝑒𝑓𝑒 = 5 𝑚

𝑽𝑩𝑩 = 𝟓. 𝟎𝟎𝟎𝒎³

𝑇𝑆𝐵𝐵 = 3.500 𝑔 𝑇𝑆/𝑚³
𝐵𝑑,𝐵𝑆𝐵 = 5.000 𝑘𝑔 𝑂2/𝑑

Bemessungsvorgabe:

𝑩𝑻𝑺 ≤ 𝟎, 𝟏𝟓
𝒌𝒈 𝑩𝑺𝑩𝟓
𝒎3 ∗ 𝒅

Für beide BB´s gilt:
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Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 
(konstruiertes Beispiel):

𝑴𝑻𝑺 = 10.000 𝑚³ ∗ 3,5 𝑘𝑔 𝑇𝑆/𝑚³

= 𝟑𝟓. 𝟎𝟎𝟎 𝒌𝒈 𝑻𝑺

𝑩𝑻𝑺 =
5.000 𝑘𝑔 𝐵𝑆𝐵5/𝑑

35.000 𝑘𝑔 𝑇𝑆
= 𝟎, 𝟏𝟒

𝑴𝑻𝑺 = 5.000 𝑚³ ∗ 3,5 𝑘𝑔 𝑇𝑆/𝑚³

= 𝟏𝟕. 𝟓𝟎𝟎 𝒌𝒈 𝑻𝑺

𝑩𝑻𝑺 =
5.000 𝑘𝑔 𝐵𝑆𝐵5/𝑑

17.500 𝑘𝑔 𝑇𝑆
= 𝟎, 𝟐𝟗

Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, 𝑀𝑇𝑆 und 𝐵𝑇𝑆
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Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 
(konstruiertes Beispiel):

𝑴𝑻𝑺 = 5.000 𝑚³ ∗ 𝟓, 𝟎 𝒌𝒈 𝑻𝑺/𝒎³
= 25.000 𝑘𝑔 𝑇𝑆

𝑩𝑻𝑺 =
5.000 𝑘𝑔 𝐵𝑆𝐵5/𝑑

25.000 𝑘𝑔 𝑇𝑆
= 𝟎, 𝟐𝟎

𝑴𝑻𝑺,𝒎𝒊𝒏. =
𝐵𝑑,𝐵𝑆𝐵
𝐵𝑇𝑆,𝑚𝑎𝑥.

=
5.000 𝑘𝑔 𝐵𝑆𝐵5/𝑑

0,15

= 33.333 𝑘𝑔 𝑇𝑆

𝑽𝑩𝑩𝒎𝒊𝒏. =
𝑀𝑇𝑆,𝑚𝑖𝑛.
𝑇𝑆𝐵𝐵,𝑚𝑎𝑥.

=
33.333 𝑘𝑔 𝑇𝑆

5 𝑘𝑔 𝑇𝑆/𝑚³
= 6.667 𝑚³

gewählt: 𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 17,0 𝑚

17 𝑚 ∗ 80 𝑚 ∗ 5 𝑚 = 6.800 𝑚³

𝑩𝑻𝑺 =
5.000 𝑘𝑔 𝐵𝑆𝐵5/𝑑

6.800 𝑚³ ∗ 5 𝑘𝑔 𝑇𝑆/𝑚³
≈ 𝟎, 𝟏5

Ergo: 
Bemessung des kleinen BB muss geändert 
werden!

• 𝑇𝑆𝐵𝐵 erhöhen 
(TS-Gehalt im BB, sollte aber nicht höher 
sein als 5.000 mg/l)

und, sofern das allein nicht ausreicht, um 
𝐵𝑇𝑆 im zulässigen Bereich zu halten

• 𝑉𝐵𝐵 erhöhen 

Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, 𝑀𝑇𝑆 und 𝐵𝑇𝑆
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Aufgabe: Schlammproduktion und 
Überschussschlammanfall

Arbeiten Sie die Kapitel 
5.4 Zusammenstellung der Schlammmasse
5.2.2 Berechnung der Schlammproduktion aus dem 

CSB-Abbau
5.3.2 Berechnung der Schlammproduktion aus der 

Phosphorelimination

im DWA-A 131 durch (bitte auch in der o.g. Reihenfolge)! 

Welche Einflussgrößen bestimmen den Überschuss-
schlammanfall? 

5 Minuten
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Überschussschlammanfall Ü𝑆𝑑

Welche Einflussgrößen bestimmen nach DWA-A 131 die tägliche Schlammproduktion aus 
der Kohlenstoffelimination Ü𝑆𝑑,𝐶?

Aus welchen Teilmengen setzt sich der in einer Belebungsanlage täglich produzierte 
Überschussschlamm Ü𝑆𝑑 zusammen? 

tägliche Schlammproduktion aus der Kohlenstoffelimination Ü𝑆𝑑,𝐶

tägliche Schlammproduktion aus der Phosphorelimination Ü𝑆𝑑,𝑃

Maßgebender täglicher Abwasserzufluss zur Kläranlage 𝑄𝑑,𝐾𝑜𝑛𝑧

Feststoffe im Zulauf zur Belebung 𝑋𝑇𝑆,𝑍𝐵

Abbaubare organische Stoffe im Zulauf zur Belebung 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵

Bemessungsschlammalter 𝑡𝑇𝑆,𝐵𝑒𝑚

Abwassertemperatur 𝑇

Ertragskoeffizient (Yield) des mikrobiologischen Wachstums 𝑌 (0,67 𝑔/𝑔)

Zerfallskoeffizient der gebildeten Biomasse 𝑏 (0,17 𝑑−1)
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Überschussschlammanfall Ü𝑆𝑑

Konzentration des Gesamtphosphors im Zulauf zur Belebungsanlage 𝐶𝑃, 𝑍𝐵

Organische Stoffe im Zulauf zur Belebung 𝐶𝐶𝑆𝐵, 𝑍𝐵

Verfahrensweise der Phosphateliminierung (BioP und/oder P-Fällung) 

Ertrag der biologischen Phosphorelimination 𝑋𝑃,𝐵𝑖𝑜𝑃

Eingesetztes Fällmittel bei P-Fällung (Fe oder Al, Kalk)

Wirken sich die o. g. Einflussgrößen – z.B. 𝐶𝑃, 𝑍𝐵 - proportional oder umgekehrt 
proportional auf den Überschussschlammanfall aus?

Welche Einflussgrößen bestimmen nach DWA-A 131 die Schlammproduktion aus der 
Phosphorelimination Ü𝑆𝑑,𝑃?

Warum das??? Das hat doch nichts mit dem Phosphor zu tun – oder???
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Ü𝑆𝑑 = Ü𝑆𝑑,𝐶 + Ü𝑆𝑑,𝑃

Überschussschlammanfall Ü𝑆𝑑 / 𝑄Ü𝑆,𝑑

Masse des insgesamt anfallenden Überschussschlamms in kg Ü𝑆𝑑

Masse des anfallenden Schlamms aus Biomassenentwicklung durch 
Abbau der Organik (C-Substrat) in kg Ü𝑆𝑑,𝐶

Masse des anfallenden Schlamms aus der Phosphatfällung in kg Ü𝑆𝑑,𝑃

𝑄Ü𝑆,𝑑 =
Ü𝑆𝑑

𝑇𝑆Ü𝑆

Täglicher Überschussschlammabzug in m³ 𝑄Ü𝑆,𝑑

Trockensubstanzgehalt des Überschussschlammes in kg/m³ 𝑇𝑆Ü𝑆

Trockensubstanzgehalt des Rücklaufschlammes in kg/m³ 𝑇𝑆𝑅𝑆

Ü𝑆,𝑑 = 𝑄Ü𝑆,𝑑 ∗ 𝑇𝑆Ü𝑆 𝑇𝑆Ü𝑆 = 𝑇𝑆𝑅𝑆
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Überschussschlammanfall KA Stahnsdorf

Vgl. Excel-Tabelle, Register „7 ÜSd, FT, tTS“

𝑄Ü𝑆,𝑑 = 1.900
𝑚3

𝑑
≈ 79,2

𝑚³

ℎ

𝑇𝑆𝑅𝑆 = 8 𝑘𝑔 𝑇𝑆/𝑚³

Ü𝑆𝑑 = 1.900
𝑚³

𝑑
∗ 8

𝑘𝑔

𝑚3
= 15.200

𝑘𝑔

𝑑
= 15,2 𝑡/𝑑

Der obige Wert errechnet sich aus den übermittelten langjährigen Mittelwerten der 
BWB zur KA Stahnsdorf. Nach unserer Bemessung ergibt sich ein etwas geringerer 
Wert, das ist aber durchaus noch im Rahmen der hier zulässigen Abweichungen):

Ü𝑆𝑑 = Ü𝑆𝑑,𝐶 + Ü𝑆𝑑,𝑃 ≈ 12,8 + 1,2 = 14,0 𝑡/𝑑
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Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, Ü𝑆𝑑 und 𝑡𝑇𝑆
Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 

(konstruiertes Beispiel, wie gehabt):

𝑉𝐵𝐵,𝐿ä𝑛𝑔𝑒 = 80 𝑚

𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 25 𝑚

𝑉𝐵𝐵,𝑇𝑖𝑒𝑓𝑒 = 5 𝑚

𝑽𝑩𝑩 = 𝟏𝟎. 𝟎𝟎𝟎𝒎³

𝑉𝐵𝐵,𝐿ä𝑛𝑔𝑒 = 80 𝑚

𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 𝟏𝟐, 𝟓 𝒎

𝑉𝐵𝐵,𝑇𝑖𝑒𝑓𝑒 = 5 𝑚

𝑽𝑩𝑩 = 𝟓. 𝟎𝟎𝟎𝒎³

𝑇𝑆𝐵𝐵 = 3.500 𝑔 𝑇𝑆/𝑚³
𝐵𝑑,𝐵𝑆𝐵 = 5.000 𝑘𝑔 𝑂2/𝑑
Ü𝑆𝑑 = 2.800 𝑘𝑔 𝑇𝑆/𝑑

Bemessungsvorgabe:
𝒕𝑻𝑺 ≥ 𝟏𝟐 𝒅

Wovon hängt ÜSd ab?

Oder, anders gefragt:

Kann ÜSd im kleinen BB 
genau so hoch sein wie 
im großen BB?

Für beide BB´s gilt:
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Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 
(konstruiertes Beispiel):

𝑴𝑻𝑺 = 10.000 𝑚³ ∗ 3,5 𝑘𝑔 𝑇𝑆/𝑚³

= 𝟑𝟓. 𝟎𝟎𝟎 𝒌𝒈 𝑻𝑺

𝒕𝑻𝑺 =
35.000 𝑘𝑔 𝑇𝑆

2.800 𝑘𝑔 𝑇𝑆/𝑑
= 𝟏𝟐, 𝟓 𝒅

𝑴𝑻𝑺 = 5.000 𝑚³ ∗ 3,5 𝑘𝑔 𝑇𝑆/𝑚³

= 𝟏𝟕. 𝟓𝟎𝟎 𝒌𝒈 𝑻𝑺

𝒕𝑻𝑺 =
17.500 𝑘𝑔 𝑇𝑆

2.800 𝑘𝑔 𝑇𝑆/𝑑
= 𝟔, 𝟐𝟓 𝒅

Kann Ü𝑆𝑑 im kleinen Belebungsbecken für die weitere Berechnung einfach verringert werden, 
um 𝑡𝑇𝑆 von 12 d einzuhalten? Wenn „nein“, warum nicht? Begründen Sie Ihre Antwort!

Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, Ü𝑆𝑑 und 𝑡𝑇𝑆
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Gegenüberstellung zweier Belebungsbecken mit unterschiedlichen Volumina 
(konstruiertes Beispiel):

𝑴𝑻𝑺 = 5.000 𝑚³ ∗ 𝟓, 𝟎 𝒌𝒈 𝑻𝑺/𝒎³
= 25.000 𝑘𝑔 𝑇𝑆

𝒕𝑻𝑺 =
25.000 𝑘𝑔 𝑇𝑆

2.800 𝑘𝑔 𝑇𝑆/𝑑
= 𝟖, 𝟗 𝒅

𝑴𝑻𝑺,𝒎𝒊𝒏. = 𝑡𝑇𝑆 ∗ Ü𝑆𝑑
= 12 𝑑 ∗ 2.800 𝑘𝑔 𝑇𝑆/𝑑 = 33.600 𝑘𝑔 𝑇𝑆

𝑽𝑩𝑩𝒎𝒊𝒏. =
𝑀𝑇𝑆,𝑚𝑖𝑛.
𝑇𝑆𝐵𝐵,𝑚𝑎𝑥.

=
33.600 𝑘𝑔 𝑇𝑆

5 𝑘𝑔 𝑇𝑆/𝑚³
= 6.720 𝑚³

gewählt: 𝑉𝐵𝐵,𝐵𝑟𝑒𝑖𝑡𝑒 = 17,0 𝑚

17 𝑚 ∗ 80 𝑚 ∗ 5 𝑚 = 6.800 𝑚³

𝒕𝑻𝑺 =
6.800 𝑚³ ∗ 5 𝑘𝑔 𝑇𝑆/𝑚³

2.800 𝑘𝑔 𝑇𝑆/𝑑
= 𝟏𝟐, 𝟏 𝒅

Ergo, auch bei dieser Betrachtungsweise: 
Bemessung des kleinen BB muss geändert 
werden!

• 𝑇𝑆𝐵𝐵 erhöhen 
(TS-Gehalt im BB, sollte aber nicht höher 
sein als 5.000 mg/l)

und, sofern das allein nicht ausreicht, um 
𝑡𝑇𝑆 im zulässigen Bereich zu halten

• 𝑉𝐵𝐵 erhöhen 

Zusammenhang zwischen 𝑉𝐵𝐵, 𝑇𝑆𝐵𝐵, Ü𝑆𝑑 und 𝑡𝑇𝑆
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„Stellschrauben“ beim Betrieb einer KA

Sauerstoffeintrag

Rücklaufschlammförderung

Überschussschlammentnahme

Volumenstrom interne Rezirkulation (bei Anlagen 
mit vorgeschalteter oder Kaskaden-Denitrifikation)

Volumenaufteilung im Belebungsbecken 

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 1 74



Aufgabe: Bemessung Vorklärbecken

Für das Klärwerk Stahnsdorf soll das rechteckige 
Vorklärbecken nachbemessen werden. 
Der Zufluss zur KA beträgt bei Mischwasserzufluss 
𝑸𝒎 = 1.800 l/s und bei Trockenwetter 𝑸𝒕 = 600 l/s. 
Die Aufenthaltszeit im Becken soll mit  tR = 1,0 h und 
die Oberflächenbeschickung bei Trockenwetter mit 
qa = 2,5 m/h angesetzt werden. 

Selbststudium zu Hause
Vorgehensweise bei der Bemessung siehe Excel-Tabelle Bemessung KA 
Stahnsdorf nach A 131 - Aufgabenstellung.xlsx, Register Bemessung VKB
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Sedimentation ist die physikalische Abtrennung suspendierten Materials aus dem Wasser 
durch Gravitationskräfte. Sedimentation ist ein gut untersuchter und allgemein 
angewandter Prozess der Wasser- und Abwasserbehandlung, der in nahezu allen Anlagen 
zum Einsatz kommt. Sedimentation ist darüber hinaus ein Prozess, der nur geringe Kosten 
bzw. Aufwand erfordert.

Unter bestimmten Bedingungen zeigen suspendierte Partikel eine natürliche Tendenz zur 
Agglomeration (Zusammenballung). Die Zugabe chemischer Hilfsmittel unterstützt diesen 
Vorgang. Dieses Phänomen wird als Flockung oder Typ II Sedimentation bezeichnet. Sie 
leitet sich ab von den Prinzipien der Typ I Sedimentation.

Typ II Sedimentation

Typ I Sedimentation bezieht sich auf das diskrete Absetzen von Partikeln 
(ohne Berücksichtigung der Agglomeration und ohne Hilfsmittel).

Typ I Sedimentation 

Sedimentation
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Sedimentation
Das Bemessungsvolumen eines Absetzbeckens richtet sich nach dem zulaufenden Volumen-
strom und der Absetzgeschwindigkeit der Partikel. Partikel, die nahe der Oberfläche in den 
Absetzbereich eintreten, benötigen die längste Zeit zu ihrer Entfernung. 
𝑣𝑠 - Absetzgeschwindigkeit eines Partikels (in vertikaler Richtung), 
𝑣𝑓 - Durchflussgeschwindigkeit (in horizontaler Richtung).

𝑣1

𝑣𝑠

𝑣2

𝑣𝑓

𝑣𝑓

𝑣𝑓
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Sedimentation

Theoretische Aufenthaltszeit

𝑡𝑑 =
𝑉

𝑄

𝑉 – Volumen des Absetzbereiches im Reaktor in 𝑚³

𝑄 – Abwasservolumenstrom in 
𝑚³

ℎ

Durchflussgeschwindigkeit 

𝑄 – Abwasservolumenstrom in 
𝑚³

ℎ

𝐴 – Querschnittsfläche in 𝑚²
𝑣𝑓 =

𝑄

𝐴
=

𝑄

𝐻 ∗ 𝐵

Soll sich ein Partikel auf dem Boden absetzen, muss er innerhalb der Aufenthaltszeit 𝑡𝑑 das 
Becken sowohl in der Länge als auch in der Höhe passieren:

𝑣𝑓 ∗ 𝑡𝑑 = 𝐿

𝑣𝑠 ∗ 𝑡𝑑 = 𝐻
𝒗𝒔 =

𝐻 ∗ 𝑣𝑓

𝐿
=

𝐻 ∗ 𝑄

𝐿 ∗ 𝐻 ∗ 𝐵
=
𝑸

𝑳 ∗ 𝑩
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𝑣𝑓 =
𝐿

𝑡𝑑

𝑣𝑠 =
𝐻

𝑡𝑑

𝑡𝑑 =
𝐿

𝑣𝑓



Sedimentation

Zusammengefasst gilt für ein ideales Absetzbecken, dass die 
Partikel zu 100% entfernt werden, wenn die hydraulische Last 
pro Fläche kleiner oder gleich der Absetzgeschwindigkeit 𝑣𝑠 ist.

𝑸

𝑳 ∗ 𝑩
≤ 𝒗𝒔

𝑣𝑠

𝑣𝑓
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Sedimentation
Absetzgeschwindigkeit 𝑣𝑠 hängt u. a. ab von der Partikeldichte, der Dichte des Fluids, 
Volumen der Partikel, Querschnittsfläche und Form der Partikel.

Absetzgeschwindigkeit 𝑣𝑠
• kann aus Absetztests abgeleitet werden (das ist zu bevorzugen!),
• oder berechnet werden nach folgender Formel

𝑣𝑠 =
𝑅𝑒𝑇 ∗ 𝜂𝐹
∅ ∗ 𝜌𝐹 𝑅𝑒𝑇 - Reynolds Zahl (dimensionslos)

𝜂𝐹 - Dynamische Viskosität des Fluids in 
𝑘𝑔

𝑚 ∗𝑠

∅ - Durchmesser der Partikel in m

𝜌𝐹 - Dichte des Fluids in 
𝑘𝑔

𝑚³

wobei

Darüber hinaus gibt es einige Faustwerte zur Bemessung der Sedimentation (vgl. Excel-
Tabelle).
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Sedimentation

𝑣𝑠 ≈ 0.01 … 0.03
𝑚

𝑠

(niedrigere Werte für kleine und leichte Partikel) 

Als Faustwerte für die Bemessung von Absetzbecken können herangezogen werden:

Aufenthaltszeit bei Trockenwetter ≥ 1 h
Aufenthaltszeit bei Regenwetter ≥ 0.3 h

Absetzgeschwindigkeit bei Trockenwetter ≤ 0.01 
𝑚

𝑠

Absetzgeschwindigkeit bei Regenwetter ≤ 0.03 
𝑚

𝑠

Hydraulische Belastung  2 … 4 
𝑚

ℎ

Becken Tiefe ≥ 3 m
Becken Breite ≥ 8 m
Becken Länge = 3 … 6 * Becken Breite 
Becken Länge = 10 … 25 * Becken Tiefe 

LONDONG et al., 2009

Als Faustwert für die Absetzgeschwindigkeit 𝑣𝑠 kann herangezogen werden:

Vgl. Excel-Tabelle, 
Register „0 Bemessung VKB“
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Bemessung der Kläranlage Stahnsdorf
nach ATV-DVWK-A 131 - Teil 2

(„Nachlese“ zur Besichtigung des Klärwerks, 
N-Bilanz, Nitrifikation und Denitrifikation)

Abwasserbehandlung
(Wastewater Treatment)

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 2 1



Klärwerk Stahnsdorf
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Unser Weg bei der Führung durch das 
Klärwerk am 25.10.2022

Rechen-
haus

Sandfang Vorklärbecken/
Regenüberlaufbecken

BHKW

Gaso-
meter

Schlamm-
trocknung

Leitwarte

Nachklär-
becken

Belebungsbecken
(aerob)

Schlammfaulung

Pumpen/
Kompressoren

Belebungsbecken
(anoxisch)



Klärwerk Stahnsdorf
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Zulaufgerinne
(vor dem 
Rechen-
gebäude)



Klärwerk Stahnsdorf
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Rechenhaus



Klärwerk Stahnsdorf
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Links: Rechengutcontainer

Unten: Kuriositäten aus dem Rechengut
(KA Fürstenwalde)



Klärwerk Stahnsdorf
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Belüfteter 
Sandfang



Klärwerk Stahnsdorf
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Sandwäsche



Klärwerk Stahnsdorf
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Gerinne 
zwischen 
Sandfang und 
Vorklärbecken



Klärwerk Stahnsdorf
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Vorklärbecken



Klärwerk Stahnsdorf
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Vorklärbecken



Klärwerk Stahnsdorf
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Blockheiz-
kraftwerk



Klärwerk Stahnsdorf
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Heizdampf-
kessel



Klärwerk Stahnsdorf
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Gasometer



Klärwerk Stahnsdorf
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Belebungsbecken
(Nitrifikation)



Klärwerk Stahnsdorf
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Klärwerk Stahnsdorf
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Belebungsbecken

(Foto von 2018, zeigt 
ein Nitrifikations-
becken nach der 
Erneuerung der 
Belüftungskerzen)



Klärwerk Stahnsdorf
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Hyperboloidförmiges Rührwerk aus dem Denitrifikationsbecken (Foto von 2018)



Klärwerk Stahnsdorf
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Nachklärbecken



Klärwerk Stahnsdorf
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Nachklärbecken
(Detail: 
Tauchwand und 
Ablauf über 
Zahnkante)



Kurzer Rückblick auf die bisherige Bemessung

Was haben wir bisher ermittelt bzw. berechnet?

• Fraktionierung des CSB und der Feststoffe im Zulauf zur 
Kläranlage und im Zulauf zur Belebung

• Erforderliches Schlammalter

• Überschussschlammanfall

• Volumen des Belebungsbeckens und dessen Aufteilung 
in einen aeroben und einen anoxischen Bereich

• Rücklaufschlammförderung (Massen- und 
Volumenstrom)

• Interne Rezirkulation (Massen- und Volumenstrom) 
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Kurzer Rückblick auf die bisherige Bemessung
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𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 = 𝑃𝐹 ∗
1

𝜇𝐴,𝑚𝑎𝑥
∗ 1,6 ∗ 1,103 15−𝑇 [d]

Erforderliches Schlammalter aerob:

Berechnet: 7 d, gewählt: 10 d

Überschussschlammanfall:

Berechnet: 14.000 kg 𝑇𝑆/𝑑

Erforderliches Bemessungsschlammalter:

Berechnet: 16 d

Ü𝑆𝑑 = Ü𝑆𝑑,𝐶 + Ü𝑆𝑑,𝑃 [kg]

𝑡𝑇𝑆,𝐵𝑒𝑚 = 𝑡𝑇𝑆,𝑎𝑒𝑟𝑜𝑏,𝐵𝑒𝑚 ∗
1

1 −
𝑉𝐷
𝑉𝐵𝐵

[d]

𝑉𝐵𝐵 ≥
Ü𝑆𝑑 ∗ 𝑡𝑇𝑆,𝐵𝑒𝑚

𝑇𝑆𝐵𝐵
[m³]

Volumen des Belebungsbeckens 

Berechnet (mit 𝑇𝑆𝐵𝐵 =
3.300 𝑔/𝑚³): 68.000 𝑚³

Wie wird das Volumen des 
Belebungsbeckens 

berechnet?



Kurzer Rückblick auf die bisherige Bemessung
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Was hätte sich als Volumen des Belebungsbecken nach der Berechnungsweise ergeben, 
die vor Veröffentlichung des neuen Arbeitsblatts A 131 üblich war?

Maßgebliche Bemessungsgröße war die Schlammbelastung:

𝐵𝑇𝑆 ≤ 0,15
𝑘𝑔 𝐵𝑆𝐵5/𝑑

𝑘𝑔 𝑇𝑆

BSB5-Tagesfracht des Klärwerks Stahnsdorf: 15.960 kg BSB5/d

Beckenvolumen bei 5 𝑔/𝑙 𝑇𝑆:

𝑉𝐵𝐵 =
106 400 𝑘𝑔 𝑇𝑆

5 𝑔 𝑇𝑆/𝑙
= 21 280 𝑚³

Mindestmenge an Trockensubstanz im Belebungsbecken:

𝑇𝑆𝑚𝑖𝑛 =
15 960 𝑘𝑔 𝐵𝑆𝐵5/𝑑

0,15 𝑘𝑔 𝐵𝑆𝐵5/𝑑
𝑘𝑔 𝑇𝑆

= 106 400 𝑘𝑔 𝑇𝑆= 106 400 𝑘𝑔 𝑇𝑆

Beckenvolumen bei 3,3 𝑔/𝑙 𝑇𝑆:

𝑉𝐵𝐵 =
106 400 𝑘𝑔 𝑇𝑆

3,3 𝑔 𝑇𝑆/𝑙
≈ 32 250 𝑚³

Ergebnis nicht überraschend, 
weil man das Problem mit der 
Wachstumsgeschwindigkeit  
der Nitrifikanten noch nicht 
erkannt hatte. Als Ergebnis 
dessen ließen die berechne-
ten Beckenvolumina keine 
Nitrifikation zu! 



Kurzer Rückblick auf die bisherige Bemessung
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Rücklaufverhältnis:

Berechnet: 7,9 - gewählt: 3

Rückführverhältnis:

Berechnet: 0,7

Wie werden Rücklaufverhältnis (für Rücklaufschlamm) und 
Rückführverhältnis (für interne Rezirkulation)  berechnet?

𝑅𝑉 =
𝑇𝑆𝐵𝐵

𝑇𝑆𝑅𝑆 − 𝑇𝑆𝐵𝐵

𝑅𝐹 =
𝑆𝑁𝐻4,𝑁
𝑆𝑁𝑂3,𝐴𝑁

− 1 =
𝑄𝑅𝑆

𝑄𝑇,𝑚𝑎𝑥
+

𝑄𝑅𝑍
𝑄𝑇,𝑚𝑎𝑥



gasförmiger Stickstoff Nitrit Nitrat Ammonium Gelöster organischer 

Stickstoff

Dissolved Organic 

Nitrogen (DON)

Partikulärer 

organischer Stickstoff

Particulate Organic 

Nitrogen (PON)

Gesamtstickstoff (einer Wasser-/Abwasserprobe)

Total Nitrogen (TN)

Gesamter organischer Stickstoff

Total Organic Nitrogen (TON)

Gesamter anorganischer Stickstoff

Total Inorganic Nitrogen (TIN)

Total Kjeldahl Nitrogen (TKN)Total Nitrogen bounded (TNb)Total Nitrogen bounded (TNb)

Sofort zugänglich (bioverfügbar) für 
Wasserpflanzen und andere -organismen

Erst nach mikrobiellem Abbau 
bioverfügbar 

NOx-N und NH4-N kommen
ausschließlich in gelöster Form vor!

Summe aus NOx-N und NH4-N ist in D 
i.a.R auch Überwachungswert (Nges.anorg.)!

N-Bilanz und Fraktionierung (Wiederholung)
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N-Bilanz (Wiederholung)

Metabolisierung der Stickstoffkompartimente bei der Abwasserbehandlung
aus LONDONG, 2009
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N-Bilanz (Wiederholung)

Grobbilanz der Stickstoffkompartimente in Kläranlagen mit Denitrifikation
aus LONDONG, 2009
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Nitrifikation / Denitrifikation

Wie viel Sauerstoff wird verbraucht, um 1 g NH4-N vollständig zu oxidieren?

Reaktionsgleichung:

NH4
+ + 2 O2 → NO3 + H2O + H2

+

Atomgewichte: N=14,  H = 1, O = 16

Molekulargewicht des Sauerstoffs: 16 ∗ 2 =
32𝑔

𝑀𝑜𝑙 𝑂2

Um 1 Mol NH4-N zu oxidieren, werden 2 Mol Sauerstoff verbraucht, d. h.:
es sind 64 g Sauerstoff je 14 g NH4-N erforderlich. Danach ergibt sich:

64 𝑔 𝑂2

14 𝑔 𝑁𝐻4− 𝑁
=

4,57 𝑔 𝑂2

𝑔 𝑁𝐻4− 𝑁

Molekulargewicht des Ammoniumstickstoffs: 14 𝑔 𝑁
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(1 Mol Ammonium-
stickstoff wiegt 14 g)



Nitrifikation / Denitrifikation
Aber: Die Umwandlung des Ammoniumstickstoffs in der Nitrifikation erfolgt nicht als 
Oxidation im streng stöchiometrischen Verhältnis, denn es handelt sich um eine 
biologische Metabolisierung. Dabei wird ein Teil des Stickstoffs in die Zellen der 
Nitrifikanten eingebaut. Dieser Zellertrag vermindert den tatsächlich erforderlichen 
Sauerstoffbedarf. 
Üblicherweise rechnet man deshalb mit:

4,3 𝑔 𝑂2

𝑔 𝑁𝐻4− 𝑁

aus DWA-A 131, 2016

„Für die Nitrifikation wird der Sauerstoffverbrauch mit 4,3 kg O2 pro kg oxidierten 
Stickstoff unter Berücksichtigung des Stoffwechsels der Nitrifikanten angenommen.“
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Nitrifikation / Denitrifikation

Molekulargewicht des Nitratstickstoffs: 14 𝑔 𝑁

Sauerstoffgewinn:
5

2
∙ 16 = 40 𝑔 𝑂2

Reaktionsgleichung:

NO3
- + ½ H2O → ½ N2 + 5/2 O + OH-

Mit anderen Worten: Der Sauerstoffgewinn beträgt 2,9 g je g Nitratstickstoff

Wie viel Sauerstoff wird bei der Denitrifikation je g NO3-N zurückgewonnen?

40
𝑔 𝑂2

𝑀𝑜𝑙 𝑁𝑂3 − 𝑁

14
𝑔 𝑁

𝑀𝑜𝑙 𝑁𝑂3 − 𝑁

≈ 2,9
𝑔 𝑂2

𝑔 𝑁𝑂3 − 𝑁
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(auch 1 Mol Nitrat-
stickstoff wiegt 14 g)



Nitrifikation / Denitrifikation

Sauerstoffrückgewinnung bei der Denitrifikation: 2,9
𝑔 𝑂2

𝑔 𝑁𝑂3 −𝑁

Wie stellt sich somit die Sauerstoffbilanz der Nitrifikation / Denitrifikation dar?

2,9
𝑔 𝑂2

𝑔 𝑁𝑂3 − 𝑁

4,3
𝑔

𝑔 𝑁𝐻4 − 𝑁

= 0,67

Sauerstoffverbrauch bei der Nitrifikation: 4,3
𝑔 𝑂2

𝑔 𝑁𝐻4− 𝑁

Mit anderen Worten: 
Bei der Denitrifikation werden ca. 2/3 des Sauerstoffverbrauchs aus 
der Nitrifikation wieder zurückgewonnen.
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Aufgabe: Selbststudium A 131

Arbeiten Sie Kapitel 7.4 Säurekapazität 
im DWA-A 131 durch! 

Warum muss auf die Einhaltung einer Mindestgröße der 
Säurekapazität im Belebungsbecken geachtet werden? 
Was bedeutet eigentlich „Säurekapazität“? 

5 Minuten
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Nitrifikation / Denitrifikation

Reaktionsgleichung Denitrifikation:

NO3
- + ½ H2O → ½ N2 + 5/2 O + OH-

Reaktionsgleichung Nitrifikation:

NH4
+ + 2 O2 → NO3 + H2O + H2

+

Die Nitrifikation ist gekennzeichnet durch einen hohen Sauerstoffverbrauch (1 g NH4-N 
benötigt 4,3 g 02) und durch eine hohe Säureproduktion (1 Mol NH4-N bildet 2 Mol H+).

Die Denitrifikation ist gekennzeichnet durch einen Gewinn an Sauerstoff (1 g NO3-N 
liefert 2,9 g O2) und durch eine Basenproduktion, die die in der Nitrifikation gebildete 
Säure zur Hälfte wieder neutralisiert (1 Mol NO3-N bildet 1 Mol OH-).

Wie verändert sich demzufolge der pH-Wert bei der Nitrifikation?
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Wie verändert sich demzufolge der pH-Wert bei der Denitrifikation?



Aufgabe 8: Selbststudium A 131

Arbeiten Sie die Kapitel 

5.2.4 Sauerstoffbedarf für den Kohlenstoffabbau 

7.3 Sauerstoffbedarf 

im DWA-A 131 durch! Welche Einflussgrößen bestimmen den 
Sauerstoffbedarf der Belüftung? Beschreiben Sie, welchen Einfluss 
Nitrifikation und Denitrifikation auf den Sauerstoffbedarf der 
Belüftung haben! 

10 Minuten
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Welche Einflussgrößen bestimmen den Sauerstoffbedarf der Belüftung? 

Belüftung

Abbaubare organische Stoffe im Zulauf zur Belebung CBSB,abb,ZB

Mit dem Überschussschlamm eliminierter CSB XCSB,ÜS

CSB gelöst, inert im Ablauf der Nachklärung SCSB,inert,AN

Sauerstoffverbrauch für Nitrifikation OVd,N

Sauerstoffgewinn aus der Denitrifikation OVd,D

Stoßfaktor des Sauerstoffverbrauches für Kohlenstoffelimination fC

Stoßfaktor des Sauerstoffverbrauches für Nitrifikation fN
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Warum ist bei den Lastfällen zur Bemessung der Belüftung 
auch der minimale Sauerstoffbedarf zu berücksichtigen? 



Sauerstoffverbrauch für Kohlenstoffelimination

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵 + 𝐶𝐶𝑆𝐵,𝑑𝑜𝑠 − 𝑋𝐶𝑆𝐵,𝐵𝑀 − 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀

1.000
[𝑖𝑛

𝑘𝑔 𝑂2
𝑑

]

Täglicher Sauerstoffverbrauch für Kohlenstoffelimination 𝑂𝑉𝑑,𝐶

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des abbaubaren CSB im Zulauf zur Belebungsstufe 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵

Konzentration des CSB, der als zusätzliche C-Quelle für die Denitrifikation  
dosiert wird (nur sofern erforderlich) 𝐶𝐶𝑆𝐵,𝑑𝑜𝑠

CSB der Biomasse 𝑋𝐶𝑆𝐵,𝐵𝑀

Inerter Anteil des CSB der Biomasse 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀

„Neue“ Formel nach DWA-A 131, 2016
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Ermittlung Sauerstoffverbrauch („neu“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus DWA-A 131, 2016
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𝑂𝑉𝐶 = 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵 − 𝑋𝐶𝑆𝐵,𝐵𝑀 − 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀



Sauerstoffverbrauch für Kohlenstoffelimination

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆

1.000
[𝑖𝑛

𝑘𝑔 𝑂2
𝑑

]

Täglicher Sauerstoffverbrauch für Kohlenstoffelimination 𝑂𝑉𝑑,𝐶

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

CSB-Konzentration im Zulauf zur Belebungsstufe 𝐶𝐶𝑆𝐵,𝑍𝐵

Konzentration der gelösten inerten (nicht abbaubaren) 
CSB-Fraktion im Ablauf der Nachklärung 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁

Als CSB gemessener Überschussschlamm 𝑋𝐶𝑆𝐵,Ü𝑆

„Alte“ Formel nach ATV-DVWK-A 131, 2000
(nach dieser Formel erfolgt die Berechnung im Excel-Arbeitsblatt)
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Ermittlung Sauerstoffverbrauch („alt“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus ATV-DVWK-A 131, 2000
𝑂𝑉 = 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆
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Vergleich Ermittlung Sauerstoffverbrauch „alt“/„neu“
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Erläutern Sie die neue und die alte 
Berechnungsformel anhand der Grafik 

zur Veränderung des CSB und der 
abfiltrierbaren Stoffe bei der 

biologischen Behandlung in DWA-A 131! 



Sauerstoffverbrauch für Nitrifikation

𝑂𝑉𝑑,𝑁 =
𝑄𝑑 ∗ 4,3 ∗ 𝑆𝑁𝑂3,𝐷 − 𝑆𝑁𝑂3,𝑍𝐵 + 𝑆𝑁𝑂3,𝐴𝑁

1.000

Täglicher Sauerstoffverbrauch für die Nitrifikation 𝑂𝑉𝑑,𝑁

Ermittlung über Nitratsauerstoffbilanz:

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des zu denitrifizierenden Nitrats 𝑆𝑁𝑂3,𝐷

Nitratkonzentration im Ablauf des NKB 𝑆𝑁𝑂3,𝐴𝑁

Nitratkonzentration im Zulauf zur Belebung 𝑆𝑁𝑂3,𝑍𝐵
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Der Faktor 4,3 ist  der O2-
Verbrauch bei der bioche-
mischen Oxidation von 
Ammonium (liegt unter 
dem Ergebnis der stöchio-
metrischen Rechnung)! 



Sauerstoffgewinn bei der Denitrifikation

𝑂𝑉𝑑,𝐷 =
𝑄𝑑 ∗ 2,9 ∗ 𝑆𝑁𝑂3,𝐷

1.000

Täglicher Sauerstoffgewinn bei der Denitrifikation 
(= Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation gedeckt wird) 𝑂𝑉𝑑,𝐷

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des zu denitrifizierenden Nitrats 𝑆𝑁𝑂3,𝐷
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Der Faktor 2,9 resultiert aus der 
stöchiometrischen Rechnung! 



Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

𝑂𝑉ℎ =
𝑓𝐶 ∗ 𝑂𝑉𝑑,𝐶 − 𝑂𝑉𝑑,𝐷 + 𝑓𝑁 ∗ 𝑂𝑉𝑑,𝑁

24

Der als Spitzenwert maßgebliche Sauerstoffverbrauch errechnet sich wie folgt:

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert 𝑂𝑉ℎ

Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶

Täglicher Sauerstoffverbrauch für C-Elimination 𝑂𝑉𝑑,𝐶

Stoßfaktor für die Ammoniumoxidation 𝑓𝑁

Täglicher Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation gedeckt wird 𝑂𝑉𝑑,𝐷

Täglicher Sauerstoffverbrauch für Nitrifikation 𝑂𝑉𝑑,𝑁
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Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

Weil die Sauerstoffverbrauchsspitze für die Nitrifikation in der 
Regel zeitlich nicht mit der Sauerstoffverbrauchsspitze für die 
Kohlenstoffelimination zusammenfällt, muss die Berechnung 
des Spitzenwerts des maßgeblichen Sauerverbrauchs nach der 
Formel auf der vorherigen Folie zweimal erfolgen:

1. einmal mit dem Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶, wobei der 
Stoßfaktor für die Ammoniumoxidation 𝑓𝑁 = 1 gesetzt wird

2. umgekehrt, d. h. mit dem Stoßfaktor für die Ammoniumoxidation 𝑓𝑁, 
wobei der Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶 = 1 gesetzt wird 

Der jeweils höhere Wert von 𝑂𝑉ℎ ist maßgebend.
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Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

Ermittlung der Stoßfaktoren 𝑓𝐶 und 𝑓𝑁 aus DWA-A 131:
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Erforderliche Sauerstoffzufuhr 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶

𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 =
𝑐𝑆 ∗ 𝑂𝑉ℎ
𝑐𝑆 − 𝑐𝑥

Für durchgehend belüftete Becken errechnet sich die erforderliche Sauerstoffzufuhr 
wie folgt:

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert 𝑂𝑉ℎ

erforderliche Sauerstoffzufuhr 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶

Sauerstoff-Sättigungskonzentration (ist gesondert zu ermitteln) 𝑐𝑆

Sollwert der Sauerstoffkonzentration im Belebungsbecken 𝑐𝑥

Die Berechnung der erforderlichen Sauerstoffzufuhr sollte für alle relevanten Lastfälle 
erfolgen (Sommerbetrieb, Winterbetrieb, hohe BSB-Fracht, hohe N-Fracht usw.)
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Sauerstoff-Sättigungskonzentration
Die Sauerstoffsättigungs-

konzentration kann man aus 
Tabellen ablesen…
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Sauerstoff-Sättigungskonzentration
…oder berechnen. Hierfür wurden verschiedene Formeln veröffentlicht.

𝑐𝑆 = 𝑒
(−139,3441+

1,57570 ∗ 105

𝑇
−
6,64231 ∗ 107

𝑇2
+
1,2438 ∗ 1010

𝑇3
−
8,62195 ∗ 1011

𝑇4
)

wobei

𝑐𝑆 Sauerstoffsättigungskonzentration bei Normaldruck (1 bar) und 
vernachlässigbar geringen Salzgehalten des Wassers

𝑇 Wassertemperatur in °K (= 273,15 + Temperatur in °C)

APHA 1995, zitiert in U.S. EPA, 2008 

Berechnungsvorschlag der U.S. American Public Health Association, 1995:
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Sauerstoff-Sättigungskonzentration

Die direkte Berechnung nach einer Formel ist die Methode der Wahl, sobald die Wasser-
temperatur als Variable in die Berechnung eingeht (z. B. wenn eine Scenarioanalyse
durchgeführt werden soll)!

𝑐𝑆 =
2.234,34

𝑇 + 45,93 1,31403

wobei

𝑐𝑆 Sauerstoffsättigungskonzentration bei Normaldruck (1 bar) und 
vernachlässigbar geringen Salzgehalten des Wassers

𝑇 Wassertemperatur in °C
zitiert in WAGNER, 1992

Berechnungsvorschlag von PÖPEL, 1985:
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Ermittlung Sauerstoffverbrauch KA Stahnsdorf („alt“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus ATV-DVWK-A 131, 2000

= 37 mg/l

= 736 mg/l

= 239 mg/l

= 460 mg/l

𝑂𝑉 = 736 − 37 − 239 = 460 𝑚𝑔/𝑙
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siehe Excel-Tabelle, 
Register „2a CSB-Bilanz“
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Ermittlung Sauerstoffverbrauch KA Stahnsdorf („neu“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus DWA-A 131, 2016

= 611 mg/l

= 87 mg/l

= 64 mg/l

= 460 mg/l

𝑂𝑉𝐶 = 611 − 87 − 64 = 460 𝑚𝑔/𝑙
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siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“
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Berechnung 𝑂𝑉𝑑,𝐶 für KA Stahnsdorf

siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“

𝑂𝑉𝑑,𝐶 =
52. 000 ∗ 736 − 37 − 239

1.000
= 23.920 𝑘𝑔 𝑂2/𝑑

Ermittlung über 
Sauerstoffbilanz:

𝑄𝑑 Täglicher Abwasserzufluss bei Trockenwetter 52.000 𝑚³/𝑑

𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 Konzentration der gelösten inerten (nicht abbaubaren) 
CSB-Fraktion im Ablauf der Nachklärung 37 𝑚𝑔 𝑂2/𝑙

𝐶𝐶𝑆𝐵,𝑍𝐵 CSB-Konzentration im Zulauf zur Belebungsstufe 736 𝑚𝑔 𝑂2/𝑙

(„Dosierter externer Kohlenstoff wird für den Sauerstoffverbrauch nicht berücksichtigt, weil davon ausgegangen 
wird, dass dieser mit Nitrat veratmet wird.“ ATV-DVWK-A 131) 

𝑋𝐶𝑆𝐵,Ü𝑆 Als CSB gemessener Überschussschlamm 239 𝑚𝑔 𝑂2/𝑙

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆

1.000
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Berechnung 𝑂𝑉𝑑,𝐷 für KA Stahnsdorf

Täglicher Abwasserzufluss bei Trockenwetter (𝑄𝑑) 52.000 𝑚³/𝑑

Konzentration des zu denitrifizierenden Nitrats (𝑆𝑁𝑂3,𝐷) 46,8 𝑚𝑔/𝑙

𝑂𝑉𝑑,𝐷 =
52.000 ∗ 2,9 ∗ 46,8

1.000
= 7.057 𝑘𝑔 𝑂2/𝑑

𝑂𝑉𝑑,𝐷 =
𝑄𝑑 ∗ 2,9 ∗ 𝑆𝑁𝑂3,𝐷

1.000
Einsparung an Sauerstoff aus der Denitrifikation
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siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“
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Berechnung 𝑂𝑉𝑑,𝑁 für KA Stahnsdorf

𝑂𝑉𝑑,𝑁 =
52.000 ∗ 4,3 ∗ 46,8 − 0 + 9,1

1.000
= 12.500 𝑘𝑔 𝑂2/𝑑

Ermittlung über Nitratsauerstoffbilanz:

Nitratkonzentration im Zulauf zur Belebung 0 𝑚𝑔/𝑙

Nitratkonzentration im Ablauf des NKB 9,1 𝑚𝑔/𝑙

Täglicher Abwasserzufluss bei Trockenwetter 52.000 𝑚³/𝑑

Konzentration des zu denitrifizierenden Nitrats 46,8 𝑚𝑔/𝑙

𝑂𝑉𝑑,𝑁 =
𝑄𝑑 ∗ 4,3 ∗ 𝑆𝑁𝑂3,𝐷 − 𝑆𝑁𝑂3,𝑍𝐵 + 𝑆𝑁𝑂3,𝐴𝑁

1.000
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siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“
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Stoßfaktoren 𝑓𝐶 und 𝑓𝑁 für KA Stahnsdorf:

Berechnung 𝑂𝑉ℎ für KA Stahnsdorf
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Berechnung 𝑂𝑉ℎ für KA Stahnsdorf

Stoßfaktor für die Kohlenstoffatmung (𝑓𝐶) 1,15

Täglicher Sauerstoffverbrauch für C-Elimination (𝑂𝑉𝑑,𝐶) 23.920 𝑘𝑔 𝑂2/𝑑

Stoßfaktor für die Ammoniumoxidation (𝑓𝑁) 1,5

Täglicher Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation abgedeckt wird (𝑂𝑉𝑑,𝐷) 7.057 𝑘𝑔 𝑂2/𝑑

Täglicher Sauerstoffverbrauch für Nitrifikation (𝑂𝑉𝑑,𝑁) 12.500 𝑘𝑔 𝑂2/𝑑

1. Rechengang:

𝑂𝑉ℎ =
1,0 ∗ 23.920 − 7.057 + 1,5 ∗ 12.500

24
≈ 1.484 𝑘𝑔 𝑂2/ℎ

𝑂𝑉ℎ =
1,15 ∗ 23.920 − 7.057 + 1,0 ∗ 12.500

24
≈ 1.329 𝑘𝑔 𝑂2/ℎ

2. Rechengang: Maßgeblicher Wert!
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Berechnung 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 für KA Stahnsdorf

𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 =
8,8 ∗ 1. 484 𝑘𝑔

𝑂2
ℎ

8,8 − 2
≈ 1.920 𝑘𝑔 𝑂2/ℎ

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert (𝑂𝑉ℎ) 1.484 𝑘𝑔 𝑂2/ℎ

Sauerstoff-Sättigungskonzentration (𝑐𝑆)
(abgelesen aus Tabelle) 8,8 𝑚𝑔/𝑙

Sollwert der Sauerstoffkonzentration im Belebungsbecken (𝑐𝑥) 2,0 𝑚𝑔/𝑙

Berechnung für Sommerbetrieb, d. h. maßgebende höchste Abwassertemperatur,  
𝑻𝑩𝒆𝒎.,𝒉𝒐𝒄𝒉 = 𝟐𝟎°𝑪
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siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“
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Berechnung 𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 für KA Stahnsdorf

𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 =
1.920 𝑘𝑔 𝑂2/ℎ

1,293
𝑘𝑔 𝐿𝑢𝑓𝑡
𝑁𝑚3 𝐿𝑢𝑓𝑡

∗ 0,2316
𝑘𝑔 𝑂2

𝑘𝑔 𝐿𝑢𝑓𝑡
∗ 0,33 ∗ 0,7

≈ 28. 000 𝑚3 𝐿𝑢𝑓𝑡/ℎ

erforderliche Sauerstoffzufuhr  (𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶) 1.920 𝑘𝑔 𝑂2/ℎ

1 Normkubikmeter Luft wiegt 1,293 kg, 
Umgebungsluft enthält ca. 23,16 Mass.% O2

Ergo: 1 Nm³ Luft enthält ca. 300 g Sauerstoff

durchschnittliche Sauerstoffaufnahme 33 %

Quotient der Sauerstoffzufuhr in belebtem Schlamm 
und in Reinwasser (𝛼 −𝑊𝑒𝑟𝑡) 0,7

𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 =
1.920 𝑘𝑔 𝑂2/ℎ

0,3
𝑘𝑔 𝑂2

𝑁𝑚³ 𝐿𝑢𝑓𝑡
∗ 0,33 ∗ 0,7

≈ 28. 000 𝑚3 𝐿𝑢𝑓𝑡/ℎ

alternativer Rechenweg:

(Normkubikmeter heißt, 
gemessen bei 0°C und 

Luftdruck = 1.013 mbar)
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Die Berechnung von  
𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 ist in DWA-A 131 

nicht erläutert!
(aber in Excel-Tabelle 

enthalten)
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Aufgabe: Selbststudium A 131

Arbeiten Sie Kapitel 6 Bemessung der Nachklärung

im DWA-A 131 durch! 

10 Minuten

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 2 66



Bemessung Nachklärbecken

Eindickzeit 𝑡𝐸

Schlammindex 𝐼𝑆𝑉

1) außer bei Kaskadendenitrifikation gilt: 𝑇𝑆𝐴𝐵 = 𝑇𝑆𝐵𝐵

Maximaler Regenwetterzufluss 𝑄𝑚

Schlammvolumenbeschickung 𝑞𝑆𝑉
Klarwasserzone (Tiefe) ℎ1

Trockensubstanzgehalt im Ablauf des Belebungsbeckens
bzw. im Zulauf zur Nachklärung 1) 𝑇𝑆𝐴𝐵

Außerdem zu beachten bzw. zu wählen:

Welche Einflussgrößen bestimmen nach ATV-DVWK-A 131 die Bemessung eines NKB? 

Trockensubstanzgehalt des Überschussschlammes 𝑇𝑆Ü𝑆
Trockensubstanzgehalt im Bodenschlamm des NKB 𝑇𝑆𝐵𝑆
Rücklaufschlammvolumenstrom 𝑄𝑅𝑆
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Bemessung Nachklärbecken
Schlammindex (𝐼𝑆𝑉), Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) und 
Eindickzeit (𝑡𝐸) sind voneinander abhängige Größen. Ähnlich wie bei der Ermittlung 
von Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵), Rücklaufverhältnis (𝑅𝑉) und 
Trockensubstanzgehalt des Rücklaufschlamms (𝑇𝑆𝑅𝑆) muss auch hier zunächst ein 
Wert geschätzt werden, um iterativ die übrigen Werte zu ermitteln.

𝐼𝑆𝑉 =
1000

𝑇𝑆𝐵𝑆
∗ 3 𝑡𝐸 𝑡𝐸 =

𝑇𝑆𝐵𝑆 ∗ 𝐼𝑆𝑉

1000

3

𝑇𝑆𝐵𝑆 =
1000

𝐼𝑆𝑉
∗ 3 𝑡𝐸

Maßgeblich für die Fläche des NKB (𝐴𝑁𝐵) ist die sogenannte Flächenbeschickung (𝑞𝐴), 
die wiederum von der Schlammvolumenbeschickung (𝑞𝑆𝑉) und dem Vergleichs-
schlammvolumen (𝑉𝑆𝑉) abhängt: 

𝐴𝑁𝐵 =
𝑄𝑚
𝑞𝑎

𝑞𝐴 =
𝑞𝑆𝑉
𝑉𝑆𝑉

𝑞𝑆𝑉 ist unter Berücksichtigung der Hinweise in A 131 zu wählen.

𝑉𝑆𝑉 = 𝑇𝑆𝐵𝐵 ∗ 𝐼𝑆𝑉

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 2 69



Bemessung Nachklärbecken (alt)

Hauptströmungsrichtungen und funktionale Beckenzonen 
von horizontal durchströmten runden Nachklärbecken

aus ATV-DVWK-A 131, 2000

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 2 70

Warum wird das Nachklärbecken oben als „horizontal durchströmt“ bezeichnet? 

Warum erfolgt der Abwasserzulauf in halber Tiefe des Nachklärbeckens? 



Bemessung Nachklärbecken (neu)

Hauptströmungsrichtungen und funktionale Beckenzonen 
von horizontal durchströmten runden Nachklärbecken

aus DWA-A 131, 2016
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Bemessung Nachklärbecken
Die Klarwasserzone (ℎ1) ist eine Sicherheitszone mit einer Mindesttiefe von 0,50 m. 
Die Tiefe der übrigen drei Funktionszonen wird aus vorher zu berechnenden Werten 
gemäß empirischer Formeln ermittelt: 

ℎ2 =
0,5 ∗ 𝑞𝐴 ∗ (1 + 𝑅𝑉)

1 − 𝑉𝑆𝑉/1.000

ℎ3 =
1,5 ∗ 0,3 ∗ 𝑞𝑆𝑉 ∗ (1 + 𝑅𝑉)

500

ℎ4 =
𝑇𝑆𝐵𝐵 ∗ 𝑞𝐴 ∗ 1 + 𝑅𝑉 ∗ 𝑡𝐸

𝑇𝑆𝐵𝑆

Abschließend  ist zu überprüfen, ob folgende Bedingungen erfüllt sind

• hges auf 2/3 des Fließweges ≥ 3,00 m

• Neigung Beckensohle ≥ 1 : 15
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Bemessung NKB für KA Stahnsdorf

𝑡𝐸 =
11,5 ∗ 100

1000

3

≈ 1,5 ℎ, 𝑔𝑒𝑤äℎ𝑙𝑡: 2 ℎ

Schlammindex (𝐼𝑆𝑉) gewählt 100 𝑙/𝑘𝑔

Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) 11,5 𝑘𝑔/𝑚³

𝑞𝐴 =
450

𝑙
𝑚2 ∗ ℎ

329 𝑙/𝑚³
≈ 1,37 𝑚/ℎ

𝑉𝑆𝑉 = 3,3 𝑘𝑔/𝑚³ ∗ 100 𝑙/𝑘𝑔 = 329 𝑙/𝑚³

Schlammvolumenbeschickung (𝑞𝑆𝑉) gewählt 450 𝑙/𝑚² ∗ ℎ

𝐴𝑁𝐵 =
6.510 𝑚3/ℎ

1,37 𝑚/ℎ
≈ 4.750 𝑚²

Maximaler Regenwetterzufluss  (𝑄𝑚) 6.510 𝑚³/ℎ

siehe Excel-Tabelle, 
Register „9 ISV, tE, TSBB, RV“ 

und „13 qA, qSV, VSV, ANB“

Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵) 3,3 𝑘𝑔/𝑚³
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Bemessung NKB für KA Stahnsdorf
Klarwasserzone (ℎ1) gewählt 0,50 𝑚

ℎ2 =
0,5 ∗ 1,37 ∗ (1 + 0,7)

1 − 329/1.000
= 1,74 𝑚

ℎ3 =
1,5 ∗ 0,3 ∗ 450 ∗ (1 + 0,7)

500
= 0,69 𝑚

ℎ4 =
3,3 ∗ 1, 37 ∗ 1 + 0,7 ∗ 2

11,5
= 1,33 𝑚 − 𝑔𝑒𝑤äℎ𝑙𝑡: 1,57 𝑚

ℎ𝑔𝑒𝑠 = 4,50 𝑚 siehe Excel-Tabelle, 
Register „14 NKB“

Rücklaufverhältnis (𝑅𝑉) 0,7

Flächenbeschickung (𝑞𝐴) 1,37 𝑚/ℎ

Vergleichsschlammvolumen (𝑉𝑆𝑉) 329 𝑙/𝑚³

Schlammvolumenbeschickung (𝑞𝑆𝑉) gewählt 450 𝑙/𝑚² ∗ ℎ

Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵) 3,3 𝑘𝑔/𝑚³

Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) 11,5 𝑘𝑔/𝑚³
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4 ∗ 𝜋 ∗
40 𝑚 2

4
≈ 5.030 𝑚²

𝐴𝑁𝐵 ≈ 4.750 𝑚²

vorhanden: 4 NKBs,  = 40 m

Bemessung NKB für KA Stahnsdorf
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Skizze KA Stahnsdorf, NKB

Nachweis, dass hsum bei 2/3 des Fließwegs ≥ 3,00 m

??? m3,77 m
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Welche Parameter sind bei der Bemessung einer Kläranlage nach ATV-DVWK-A 131 zu 
wählen? 

Parameter, die zu wählen sind

Sicherheitsfaktor SF

Aerobes Schlammalter tTS,aerob,Bem

Bemessungsschlammalter tTS, Bem

Eindickzeit tE

Schlammindex ISV

Trockensubstanzgehalt im Belebungsbecken TSBB

Trockensubstanzgehalt des Überschussschlammes TSÜS

Trockensubstanzgehalt im Bodenschlamm des NKB TSBS

Rücklaufverhältnis RV

Rückführverhältnis für interne Rezirkulation RF

Stoßfaktor des Sauerstoffverbrauches für Kohlenstoffelimination fC

Stoßfaktor des Sauerstoffverbrauches für Nitrifikation fN

Sauerstoffkonzentration im BB cx

Säurekapazität im Ablauf der Belebung SKS,ZB

Schlammvolumenbeschickung qSV

Klarwasserzone (Tiefe) h1
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Tipps zur Interpretation der Excel-Tabelle

Überprüfung von Eingangswerten in Formeln mittels F9-Taste
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Excel-Tabelle, 
Register „11 O2-Zufuhr“

Rückverfolgen von Eingangswerten in Formeln über → Menü Formeln → Spur zum 
Vorgänger
(nur sinnvoll für Werte, die aus dem gleichen Registerblatt eingelesen werden)

Rückverfolgen von Eingangswerten in Formeln über deren Namen
(notwendig, sobald Eingangswerte aus anderen Registerblättern stammen)

Feld E4 (Name:  „OVd_C“) 
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Bemessung der Kläranlage Stahnsdorf  
nach DWA-A 131 

Teil 3 (Belüftung, Nachklärbecken)

Abwasserbehandlung
(Wastewater Treatment)
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Aufgabe 8: Selbststudium A 131

Arbeiten Sie die Kapitel 

5.2.4 Sauerstoffbedarf für den Kohlenstoffabbau 

7.3 Sauerstoffbedarf 

im DWA-A 131 durch! Welche Einflussgrößen bestimmen den 
Sauerstoffbedarf der Belüftung? Beschreiben Sie, welchen Einfluss 
Nitrifikation und Denitrifikation auf den Sauerstoffbedarf der 
Belüftung haben! Warum ist bei den Lastfällen auch der minimale 
Sauerstoffbedarf zu berücksichtigen? 

10 Minuten
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Welche Einflussgrößen bestimmen den Sauerstoffbedarf der Belüftung? 

Belüftung

Abbaubare organische Stoffe im Zulauf zur Belebung CBSB,abb,ZB

Mit dem Überschussschlamm eliminierter CSB XCSB,ÜS

CSB gelöst, inert im Ablauf der Nachklärung SCSB,inert,AN

Sauerstoffverbrauch für Nitrifikation OVd,N

Sauerstoffgewinn aus der Denitrifikation OVd,D

Stoßfaktor des Sauerstoffverbrauches für Kohlenstoffelimination fC

Stoßfaktor des Sauerstoffverbrauches für Nitrifikation fN
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Sauerstoffverbrauch für Kohlenstoffelimination

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵 + 𝐶𝐶𝑆𝐵,𝑑𝑜𝑠 − 𝑋𝐶𝑆𝐵,𝐵𝑀 − 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀

1.000
[𝑖𝑛

𝑘𝑔 𝑂2
𝑑

]

Täglicher Sauerstoffverbrauch für Kohlenstoffelimination 𝑂𝑉𝑑,𝐶

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des abbaubaren CSB im Zulauf zur Belebungsstufe 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵

Konzentration des CSB, der als zusätzliche C-Quelle für die Denitrifikation  
dosiert wird (nur sofern erforderlich) 𝐶𝐶𝑆𝐵,𝑑𝑜𝑠

CSB der Biomasse 𝑋𝐶𝑆𝐵,𝐵𝑀

Inerter Anteil des CSB der Biomasse 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀

„Neue“ Formel nach DWA-A 131, 2016
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Sauerstoffverbrauch für Kohlenstoffelimination

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆

1.000
[𝑖𝑛

𝑘𝑔 𝑂2
𝑑

]

Täglicher Sauerstoffverbrauch für Kohlenstoffelimination 𝑂𝑉𝑑,𝐶

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

CSB-Konzentration im Zulauf zur Belebungsstufe 𝐶𝐶𝑆𝐵,𝑍𝐵

Konzentration der gelösten inerten (nicht abbaubaren) 
CSB-Fraktion im Ablauf der Nachklärung 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁

Als CSB gemessener Überschussschlamm 𝑋𝐶𝑆𝐵,Ü𝑆

Erläutern Sie die neue und die alte Berechnungsformel anhand der Grafik zur 
Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung in 
DWA-A 131! 

„Alte“ Formel nach ATV-DVWK-A 131, 2000
(nach dieser Formel erfolgt die Berechnung im Excel-Arbeitsblatt)
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CSB-Eliminierung im Belebungsverfahren („neu“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus DWA-A 131, 2016
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CSB-Eliminierung im Belebungsverfahren („alt“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus ATV-DVWK-A 131, 2000
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Rückblende Sauerstoffbilanz N/DN:

Sauerstoffrückgewinnung bei der Denitrifikation: 2,9
𝑔 𝑂2

𝑔 𝑁𝑂3 −𝑁

2,9
𝑔 𝑂2

𝑔 𝑁𝑂3 − 𝑁

4,3
𝑔

𝑔 𝑁𝐻4 − 𝑁

= 0,67

Sauerstoffverbrauch bei der Nitrifikation: 4,3
𝑔 𝑂2

𝑔 𝑁𝐻4− 𝑁

Mit anderen Worten: 
Bei der Denitrifikation werden ca. 2/3 des Sauerstoffverbrauchs aus 
der Nitrifikation wieder zurückgewonnen.
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Sauerstoffverbrauch für Nitrifikation

𝑂𝑉𝑑,𝑁 =
𝑄𝑑 ∗ 4,3 ∗ 𝑆𝑁𝑂3,𝐷 − 𝑆𝑁𝑂3,𝑍𝐵 + 𝑆𝑁𝑂3,𝐴𝑁

1.000

Täglicher Sauerstoffverbrauch für die Nitrifikation 𝑂𝑉𝑑,𝑁

Ermittlung über Nitratsauerstoffbilanz:

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des zu denitrifizierenden Nitrats 𝑆𝑁𝑂3,𝐷

Nitratkonzentration im Ablauf des NKB 𝑆𝑁𝑂3,𝐴𝑁

Nitratkonzentration im Zulauf zur Belebung 𝑆𝑁𝑂3,𝑍𝐵
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Sauerstoffgewinn bei der Denitrifikation

𝑂𝑉𝑑,𝐷 =
𝑄𝑑 ∗ 2,9 ∗ 𝑆𝑁𝑂3,𝐷

1.000

Täglicher Sauerstoffgewinn bei der Denitrifikation 
(= Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation gedeckt wird) 𝑂𝑉𝑑,𝐷

Täglicher Abwasserzufluss bei Trockenwetter 𝑄𝑑

Konzentration des zu denitrifizierenden Nitrats 𝑆𝑁𝑂3,𝐷
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Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

𝑂𝑉ℎ =
𝑓𝐶 ∗ 𝑂𝑉𝑑,𝐶 − 𝑂𝑉𝑑,𝐷 + 𝑓𝑁 ∗ 𝑂𝑉𝑑,𝑁

24

Der als Spitzenwert maßgebliche Sauerverbrauch errechnet sich wie folgt:

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert 𝑂𝑉ℎ

Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶

Täglicher Sauerstoffverbrauch für C-Elimination 𝑂𝑉𝑑,𝐶

Stoßfaktor für die Ammoniumoxidation 𝑓𝑁

Täglicher Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation gedeckt wird 𝑂𝑉𝑑,𝐷

Täglicher Sauerstoffverbrauch für Nitrifikation 𝑂𝑉𝑑,𝑁
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Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

Weil die Sauerstoffverbrauchsspitze für die Nitrifikation in der 
Regel zeitlich nicht mit der Sauerstoffverbrauchsspitze für die 
Kohlenstoffelimination zusammenfällt, muss die Berechnung 
des Spitzenwerts des maßgeblichen Sauerverbrauchs nach der 
Formel auf der vorherigen Folie zweimal erfolgen:

1. einmal mit dem Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶, wobei der 
Stoßfaktor für die Ammoniumoxidation 𝑓𝑁 = 1 gesetzt wird

2. umgekehrt, d. h. mit dem Stoßfaktor für die Ammoniumoxidation 𝑓𝑁, 
wobei der Stoßfaktor für die Kohlenstoffatmung 𝑓𝐶 = 1 gesetzt wird 

Der jeweils höhere Wert von 𝑂𝑉ℎ ist maßgebend.
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Sauerstoffverbrauch - Spitzenwert 𝑂𝑉ℎ

Ermittlung der Stoßfaktoren 𝑓𝐶 und 𝑓𝑁 aus DWA-A 131:
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Erforderliche Sauerstoffzufuhr 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶

𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 =
𝑐𝑆 ∗ 𝑂𝑉ℎ
𝑐𝑆 − 𝑐𝑥

Für durchgehend belüftete Becken errechnet sich die erforderliche Sauerstoffzufuhr 
wie folgt:

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert 𝑂𝑉ℎ

erforderliche Sauerstoffzufuhr 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶

Sauerstoff-Sättigungskonzentration (ist gesondert zu ermitteln) 𝑐𝑆

Sollwert der Sauerstoffkonzentration im Belebungsbecken 𝑐𝑥

Die Berechnung der erforderlichen Sauerstoffzufuhr sollte für alle relevanten Lastfälle 
erfolgen (Sommerbetrieb, Winterbetrieb, hohe BSB-Fracht, hohe N-Fracht usw.)
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Sauerstoff-Sättigungskonzentration
Die Sauerstoffsättigungs-

konzentration kann man aus 
Tabellen ablesen…
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Sauerstoff-Sättigungskonzentration
…oder berechnen. Hierfür wurden verschiedene Formeln veröffentlicht.

𝑐𝑆 = 𝑒
(−139,3441+

1,57570 ∗ 105

𝑇
−
6,64231 ∗ 107

𝑇2
+
1,2438 ∗ 1010

𝑇3
−
8,62195 ∗ 1011

𝑇4
)

wobei

𝑐𝑆 Sauerstoffsättigungskonzentration bei Normaldruck (1 bar) und 
vernachlässigbar geringen Salzgehalten des Wassers

𝑇 Wassertemperatur in °K (= 273,15 + Temperatur in °C)

APHA 1995, zitiert in U.S. EPA, 2008 

Berechnungsvorschlag der U.S. American Public Health Association, 1995:
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Sauerstoff-Sättigungskonzentration

Die direkte Berechnung nach einer Formel ist die Methode der Wahl, sobald die Wasser-
temperatur als Variable in die Berechnung eingeht (z. B. wenn eine Scenarioanalyse
durchgeführt werden soll)!

𝑐𝑆 =
2.234,34

𝑇 + 45,93 1,31403

wobei

𝑐𝑆 Sauerstoffsättigungskonzentration bei Normaldruck (1 bar) und 
vernachlässigbar geringen Salzgehalten des Wassers

𝑇 Wassertemperatur in °C
zitiert in WAGNER, 1992

Berechnungsvorschlag von PÖPEL, 1985:
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CSB-Eliminierung im Belebungsverfahren („alt“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus ATV-DVWK-A 131, 2000
𝑂𝑉 = 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆
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CSB-Eliminierung im Belebungsverfahren („alt“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus ATV-DVWK-A 131, 2000

= 37 mg/l

= 736 mg/l

= 239 mg/l

= 460 mg/l

𝑂𝑉 = 736 − 37 − 239 = 460 𝑚𝑔/𝑙
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CSB-Eliminierung im Belebungsverfahren („neu“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus DWA-A 131, 2016
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𝑂𝑉𝐶 = 𝐶𝐶𝑆𝐵,𝑎𝑏𝑏,𝑍𝐵 − 𝑋𝐶𝑆𝐵,𝐵𝑀 − 𝑋𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐵𝑀



CSB-Eliminierung im Belebungsverfahren („neu“)

Veränderung des CSB und der abfiltrierbaren Stoffe bei der biologischen Behandlung 

aus DWA-A 131, 2016

= 611 mg/l

= 87 mg/l

= 64 mg/l

= 460 mg/l

𝑂𝑉𝐶 = 611 − 87 − 64 = 460 𝑚𝑔/𝑙
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Berechnung 𝑂𝑉𝑑,𝐶 für KA Stahnsdorf

siehe Excel-Tabelle, 
Register „11 O2-Zufuhr“

𝑂𝑉𝑑,𝐶 =
52. 000 ∗ 736 − 37 − 239

1.000
= 23.920 𝑘𝑔 𝑂2/𝑑

Ermittlung über 
Sauerstoffbilanz:

𝑄𝑑 Täglicher Abwasserzufluss bei Trockenwetter 52.000 𝑚³/𝑑

𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 Konzentration der gelösten inerten (nicht abbaubaren) 
CSB-Fraktion im Ablauf der Nachklärung 37 𝑚𝑔 𝑂2/𝑙

𝐶𝐶𝑆𝐵,𝑍𝐵 CSB-Konzentration im Zulauf zur Belebungsstufe 736 𝑚𝑔 𝑂2/𝑙

(„Dosierter externer Kohlenstoff wird für den Sauerstoffverbrauch nicht berücksichtigt, weil davon ausgegangen 
wird, dass dieser mit Nitrat veratmet wird.“ ATV-DVWK-A 131) 

𝑋𝐶𝑆𝐵,Ü𝑆 Als CSB gemessener Überschussschlamm 239 𝑚𝑔 𝑂2/𝑙

𝑂𝑉𝑑,𝐶 =
𝑄𝑑 ∗ 𝐶𝐶𝑆𝐵,𝑍𝐵 − 𝑆𝐶𝑆𝐵,𝑖𝑛𝑒𝑟𝑡,𝐴𝑁 − 𝑋𝐶𝑆𝐵,Ü𝑆

1.000
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Berechnung 𝑂𝑉𝑑,𝐷 für KA Stahnsdorf

Täglicher Abwasserzufluss bei Trockenwetter (𝑄𝑑) 52.000 𝑚³/𝑑

Konzentration des zu denitrifizierenden Nitrats (𝑆𝑁𝑂3,𝐷) 46,8 𝑚𝑔/𝑙

𝑂𝑉𝑑,𝐷 =
52.000 ∗ 2,9 ∗ 46,8

1.000
= 7.057 𝑘𝑔 𝑂2/𝑑

𝑂𝑉𝑑,𝐷 =
𝑄𝑑 ∗ 2,9 ∗ 𝑆𝑁𝑂3,𝐷

1.000
Einsparung an Sauerstoff aus der Denitrifikation
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Berechnung 𝑂𝑉𝑑,𝑁 für KA Stahnsdorf

𝑂𝑉𝑑,𝑁 =
52.000 ∗ 4,3 ∗ 46,8 − 0 + 9,1

1.000
= 12.500 𝑘𝑔 𝑂2/𝑑

Ermittlung über Nitratsauerstoffbilanz:

Nitratkonzentration im Zulauf zur Belebung 0 𝑚𝑔/𝑙

Nitratkonzentration im Ablauf des NKB 9,1 𝑚𝑔/𝑙

Täglicher Abwasserzufluss bei Trockenwetter 52.000 𝑚³/𝑑

Konzentration des zu denitrifizierenden Nitrats 46,8 𝑚𝑔/𝑙

𝑂𝑉𝑑,𝑁 =
𝑄𝑑 ∗ 4,3 ∗ 𝑆𝑁𝑂3,𝐷 − 𝑆𝑁𝑂3,𝑍𝐵 + 𝑆𝑁𝑂3,𝐴𝑁

1.000
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Stoßfaktoren 𝑓𝐶 und 𝑓𝑁 für KA Stahnsdorf:

Berechnung 𝑂𝑉ℎ für KA Stahnsdorf
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Berechnung 𝑂𝑉ℎ für KA Stahnsdorf

Stoßfaktor für die Kohlenstoffatmung (𝑓𝐶) 1,15

Täglicher Sauerstoffverbrauch für C-Elimination (𝑂𝑉𝑑,𝐶) 23.920 𝑘𝑔 𝑂2/𝑑

Stoßfaktor für die Ammoniumoxidation (𝑓𝑁) 1,5

Täglicher Sauerstoffverbrauch für die C-Elimination, 
der durch die Denitrifikation abgedeckt wird (𝑂𝑉𝑑,𝐷) 7.057 𝑘𝑔 𝑂2/𝑑

Täglicher Sauerstoffverbrauch für Nitrifikation (𝑂𝑉𝑑,𝑁) 12.500 𝑘𝑔 𝑂2/𝑑

1. Rechengang:

𝑂𝑉ℎ =
1,0 ∗ 23.920 − 7.057 + 1,5 ∗ 12.500

24
≈ 1.484 𝑘𝑔 𝑂2/ℎ

𝑂𝑉ℎ =
1,15 ∗ 23.920 − 7.057 + 1,0 ∗ 12.500

24
≈ 1.329 𝑘𝑔 𝑂2/ℎ

2. Rechengang: Maßgeblicher Wert!
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Berechnung 𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 für KA Stahnsdorf

𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶 =
8,8 ∗ 1. 484 𝑘𝑔

𝑂2
ℎ

8,8 − 2
≈ 1.920 𝑘𝑔 𝑂2/ℎ

Stündlicher Sauerstoffverbrauch, maßgeblicher Spitzenwert (𝑂𝑉ℎ) 1.484 𝑘𝑔 𝑂2/ℎ

Sauerstoff-Sättigungskonzentration (𝑐𝑆)
(abgelesen aus Tabelle) 8,8 𝑚𝑔/𝑙

Sollwert der Sauerstoffkonzentration im Belebungsbecken (𝑐𝑥) 2,0 𝑚𝑔/𝑙

Berechnung für Sommerbetrieb, d. h. maßgebende höchste Abwassertemperatur,  
𝑻𝑩𝒆𝒎.,𝒉𝒐𝒄𝒉 = 𝟐𝟎°𝑪
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Berechnung 𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 für KA Stahnsdorf

𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 =
1.920 𝑘𝑔 𝑂2/ℎ

1,293
𝑘𝑔 𝐿𝑢𝑓𝑡
𝑁𝑚3 𝐿𝑢𝑓𝑡

∗ 0,2316
𝑘𝑔 𝑂2

𝑘𝑔 𝐿𝑢𝑓𝑡
∗ 0,33 ∗ 0,7

≈ 28. 000 𝑚3 𝐿𝑢𝑓𝑡/ℎ

erforderliche Sauerstoffzufuhr  (𝑒𝑟𝑓. 𝛼 ∗ 𝑂𝐶) 1.920 𝑘𝑔 𝑂2/ℎ

1 Normkubikmeter Luft wiegt 1,293 kg, 
Umgebungsluft enthält ca. 23,16 Mass.% O2

Ergo: 1 Nm³ Luft enthält ca. 300 g Sauerstoff

durchschnittliche Sauerstoffaufnahme 33 %

Quotient der Sauerstoffzufuhr in belebtem Schlamm 
und in Reinwasser (𝛼 −𝑊𝑒𝑟𝑡) 0,7

𝑉𝐿𝑢𝑓𝑡,𝑂𝐶 =
1.920 𝑘𝑔 𝑂2/ℎ

0,3
𝑘𝑔 𝑂2

𝑁𝑚³ 𝐿𝑢𝑓𝑡
∗ 0,33 ∗ 0,7

≈ 28. 000 𝑚3 𝐿𝑢𝑓𝑡/ℎ

alternativer Rechenweg:

(Normkubikmeter heißt, 
gemessen bei 0°C und 

Luftdruck = 1.013 mbar)
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ist nicht Gegenstand 
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Aufgabe 9: Selbststudium A 131

Arbeiten Sie Kapitel 6 Bemessung der Nachklärung

im DWA-A 131 durch! 

10 Minuten
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Bemessung Nachklärbecken

Eindickzeit 𝑡𝐸

Schlammindex 𝐼𝑆𝑉

1) außer bei Kaskadendenitrifikation gilt: 𝑇𝑆𝐴𝐵 = 𝑇𝑆𝐵𝐵

Maximaler Regenwetterzufluss 𝑄𝑚

Schlammvolumenbeschickung 𝑞𝑆𝑉
Klarwasserzone (Tiefe) ℎ1

Trockensubstanzgehalt im Ablauf des Belebungsbeckens
bzw. im Zulauf zur Nachklärung 1) 𝑇𝑆𝐴𝐵

Außerdem zu beachten bzw. zu wählen:

Welche Einflussgrößen bestimmen nach ATV-DVWK-A 131 die Bemessung eines NKB? 

Trockensubstanzgehalt des Überschussschlammes 𝑇𝑆Ü𝑆
Trockensubstanzgehalt im Bodenschlamm des NKB 𝑇𝑆𝐵𝑆
Rücklaufschlammvolumenstrom 𝑄𝑅𝑆
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Bemessung Nachklärbecken
Schlammindex (𝐼𝑆𝑉), Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) und 
Eindickzeit (𝑡𝐸) sind voneinander abhängige Größen. Ähnlich wie bei der Ermittlung 
von Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵), Rücklaufverhältnis (𝑅𝑉) und 
Trockensubstanzgehalt des Rücklaufschlamms (𝑇𝑆𝑅𝑆) muss auch hier zunächst ein 
Wert geschätzt werden, um iterativ die übrigen Werte zu ermitteln.

𝐼𝑆𝑉 =
1000

𝑇𝑆𝐵𝑆
∗ 3 𝑡𝐸 𝑡𝐸 =

𝑇𝑆𝐵𝑆 ∗ 𝐼𝑆𝑉

1000

3

𝑇𝑆𝐵𝑆 =
1000

𝐼𝑆𝑉
∗ 3 𝑡𝐸

Maßgeblich für die Fläche des NKB (𝐴𝑁𝐵) ist die sogenannte Flächenbeschickung (𝑞𝐴), 
die wiederum von der Schlammvolumenbeschickung (𝑞𝑆𝑉) und dem Vergleichs-
schlammvolumen (𝑉𝑆𝑉) abhängt: 

𝐴𝑁𝐵 =
𝑄𝑚
𝑞𝑎

𝑞𝐴 =
𝑞𝑆𝑉
𝑉𝑆𝑉

𝑞𝑆𝑉 ist unter Berücksichtigung der Hinweise in A 131 zu wählen.

𝑉𝑆𝑉 = 𝑇𝑆𝐵𝐵 ∗ 𝐼𝑆𝑉
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Bemessung Nachklärbecken (alt)

Hauptströmungsrichtungen und funktionale Beckenzonen 
von horizontal durchströmten runden Nachklärbecken

aus ATV-DVWK-A 131, 2000
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Bemessung Nachklärbecken (neu)

Hauptströmungsrichtungen und funktionale Beckenzonen 
von horizontal durchströmten runden Nachklärbecken

aus DWA-A 131, 2016
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Bemessung Nachklärbecken
Die Klarwasserzone (ℎ1) ist eine Sicherheitszone mit einer Mindesttiefe von 0,50 m. 
Die Tiefe der übrigen drei Funktionszonen wird aus vorher zu berechnenden Werten 
gemäß empirischer Formeln ermittelt: 

ℎ2 =
0,5 ∗ 𝑞𝐴 ∗ (1 + 𝑅𝑉)

1 − 𝑉𝑆𝑉/1.000

ℎ3 =
1,5 ∗ 0,3 ∗ 𝑞𝑆𝑉 ∗ (1 + 𝑅𝑉)

500

ℎ4 =
𝑇𝑆𝐵𝐵 ∗ 𝑞𝐴 ∗ 1 + 𝑅𝑉 ∗ 𝑡𝐸

𝑇𝑆𝐵𝑆

Abschließend  ist zu überprüfen, ob folgende Bedingungen erfüllt sind

• hges auf 2/3 des Fließweges ≥ 3,00 m

• Neigung Beckensohle ≥ 1 : 15
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Bemessung NKB für KA Stahnsdorf

𝑡𝐸 =
11,5 ∗ 100

1000

3

≈ 1,5 ℎ, 𝑔𝑒𝑤äℎ𝑙𝑡: 2 ℎ

Schlammindex (𝐼𝑆𝑉) gewählt 100 𝑙/𝑘𝑔

Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) 11,5 𝑘𝑔/𝑚³

𝑞𝐴 =
450

𝑙
𝑚2 ∗ ℎ

329 𝑙/𝑚³
≈ 1,37 𝑚/ℎ

𝑉𝑆𝑉 = 3,3 𝑘𝑔/𝑚³ ∗ 100 𝑙/𝑘𝑔 = 329 𝑙/𝑚³

Schlammvolumenbeschickung (𝑞𝑆𝑉) gewählt 450 𝑙/𝑚² ∗ ℎ

𝐴𝑁𝐵 =
6.510 𝑚3/ℎ

1,37 𝑚/ℎ
≈ 4.750 𝑚²

Maximaler Regenwetterzufluss  (𝑄𝑚) 6.510 𝑚³/ℎ

siehe Excel-Tabelle, 
Register „9 ISV, tE, TSBB, RV“ 

und „13 qA, qSV, VSV, ANB“

Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵) 3,3 𝑘𝑔/𝑚³
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Bemessung NKB für KA Stahnsdorf
Klarwasserzone (ℎ1) gewählt 0,50 𝑚

ℎ2 =
0,5 ∗ 1,37 ∗ (1 + 0,7)

1 − 329/1.000
= 1,74 𝑚

ℎ3 =
1,5 ∗ 0,3 ∗ 450 ∗ (1 + 0,7)

500
= 0,69 𝑚

ℎ4 =
3,3 ∗ 1, 37 ∗ 1 + 0,7 ∗ 2

11,5
= 1,33 𝑚 − 𝑔𝑒𝑤äℎ𝑙𝑡: 1,57 𝑚

ℎ𝑔𝑒𝑠 = 4,50 𝑚 siehe Excel-Tabelle, 
Register „14 NKB“

Rücklaufverhältnis (𝑅𝑉) 0,7

Flächenbeschickung (𝑞𝐴) 1,37 𝑚/ℎ

Vergleichsschlammvolumen (𝑉𝑆𝑉) 329 𝑙/𝑚³

Schlammvolumenbeschickung (𝑞𝑆𝑉) gewählt 450 𝑙/𝑚² ∗ ℎ

Trockensubstanzgehalt im Belebungsbecken (𝑇𝑆𝐵𝐵) 3,3 𝑘𝑔/𝑚³

Trockensubstanzgehalt im Bodenschlamm des NKB (𝑇𝑆𝐵𝑆) 11,5 𝑘𝑔/𝑚³
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4 ∗ 𝜋 ∗
40 𝑚 2

4
≈ 5.030 𝑚²

𝐴𝑁𝐵 ≈ 4.750 𝑚²

vorhanden: 4 NKBs,  = 40 m

Bemessung NKB für KA Stahnsdorf
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Skizze KA Stahnsdorf, NKB

Nachweis, dass hsum bei 2/3 des Fließwegs ≥ 3,00 m

??? m3,77 m
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Welche Parameter sind bei der Bemessung einer Kläranlage nach ATV-DVWK-A 131 zu 
wählen? 

Parameter, die zu wählen sind

Sicherheitsfaktor SF

Aerobes Schlammalter tTS,aerob,Bem

Bemessungsschlammalter tTS, Bem

Eindickzeit tE

Schlammindex ISV

Trockensubstanzgehalt im Belebungsbecken TSBB

Trockensubstanzgehalt des Überschussschlammes TSÜS

Trockensubstanzgehalt im Bodenschlamm des NKB TSBS

Rücklaufverhältnis RV

Rückführverhältnis für interne Rezirkulation RF

Stoßfaktor des Sauerstoffverbrauches für Kohlenstoffelimination fC

Stoßfaktor des Sauerstoffverbrauches für Nitrifikation fN

Sauerstoffkonzentration im BB cx

Säurekapazität im Ablauf der Belebung SKS,ZB

Schlammvolumenbeschickung qSV

Klarwasserzone (Tiefe) h1
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Grundsätzliche Voraussetzungen für C, N, DN

Voraussetzungen für Nitrifikation (N):

• Gelöstsauerstoffkonzentration  1,5 mg/l
• Ausreichend Ammoniumstickstoff vorhanden
• Ausreichend Autotrophe vorhanden
• Ausreichend Pufferkapazität vorhanden

aerob 

Voraussetzungen für Denitrifikation (DN):

• Gelöstsauerstoffkonzentration  0
• Ausreichend Nitrat vorhanden
• Ausreichend leicht abbaubares Substrat (BOD) vorhanden
• Ausreichend Heterotrophe vorhanden

anoxisch 

Voraussetzungen für Abbau/Eliminierung von Organika (C):

• Gelöstsauerstoffkonzentration  1,5 mg/l
• Ausreichend Kohlenstoffverbindungen vorhanden
• Ausreichend Heterotrophe vorhanden

aerob 
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Biochemische Reaktionen bei BioP
Biologische Phosphatelimierung (BioP):

anoxisch 

In der anaeroben Stufe nehmen die PAO´s leicht 
abbaubare organische Stoffe unter Verbrauch von 
Polyphosphat auf und lagern diese als organische 
Speicherstoffe (Polysubstrat) innerhalb der Zellen ein. 
Dabei wird Polyphosphat im Inneren der Zellen 
abgebaut und als Phosphat ins Abwasser abgegeben. 
Diese Reaktion liefert die erforderliche Energie.

In der anoxischen und in der aeroben Stufe werden die 
organischen Speicherstoffe abgebaut (veratmet), die 
daraus gewonnene Energie dient dazu, die Biomasse zu 
vermehren und wieder mehr Polyphosphate 
aufzubauen. Dabei wird dem Abwasser deutlich mehr 
Phosphat entzogen, als zum Aufbau der Biomasse nötig 
ist. Der Phosphorgehalt der PAO´s kann hier bis zu 15% 
betragen (normal sind ca. 1-2%).

Die mit Phosphor im Überschuss beladenen PAO´s werden entweder mit dem 
Überschussschlamm ausgekreist oder mit dem Rücklaufschlamm zurück in die 
anaerobe Stufe gebracht, wo der Zyklus erneut beginnt.

anaerob 

aerob 

nach GUJER, 2007

Dr.-Ing. O. Sterger – Abwasserbehandlung, DWA-A 131, Teil 3 43



Grundsätzliche Voraussetzungen für BioP
Voraussetzungen für biologische Phosphatelimierung (BioP):

• Ausreichend Phosphor akkumulierende Organismen (PAO‘s) im 
Belebtschlamm vorhanden 
(erreichbar, indem der Belebtschlamm ständig wechselnden 
Sauerstoffbedingungen ausgesetzt wird)

• anaerobe Stufe:
− Gelöstsauerstoffkonzentration  0
− Nitrat  0
− Ausreichend leicht abbaubares Substrat (BOD) vorhanden

• anoxische Stufe:
− Gelöstsauerstoffkonzentration  0
− Ausreichend Nitrat vorhanden
− Ausreichend Phosphat (o-PO4) vorhanden

• aerobe Stufe:
− Gelöstsauerstoffkonzentration  1,5 mg/l
− Ausreichend Phosphat (o-PO4) vorhanden

anaerob 

aerob 

anoxisch 

anaerob 

aerob 

anoxisch 
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Bemessung beruht im Wesentlichen 
auf Bilanzen:

– Abwasservolumenstrom

– CSB (Sauerstoff!)

– Feststoffe (Belebtschlamm!)

– Stickstoffkompartimente 

– Phosphor

Diese Bilanzen sind theoretisch 
abgesichert und gut nachvollziehbar.

„Manöverkritik“ der bisherigen Berechnungen

Einer dynamischen Kläranlagensimulation haften die vorgenannten  Nachteile 
nicht an. Aber auch diese hat Nachteile: Hohe Komplexität und damit 
verbunden hoher Kompliziertheitsgrad und hoher Berechnungsaufwand!

Aber: Bemessung nach DWA-A 131 ist 
eine „Worst case“-Berechnung, 
basierend auf Maximal-, Mittel- bzw. 
Minimalwerten des Zulaufs, d.h. sie 
beruht auf statischen Werten! 
Zeitliche Dynamik (Stunden-/Tages-/Wochen-/Monats-

/Jahresgang) und die jeweils resultierenden 

Ablaufwerte können damit nicht 
abgebildet werden.
Deshalb Sicherheitszuschläge erfor-
derlich→ Überbemessung!
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Dynamische Simulation 
mit dem Programmsystem STOAT:

Erstes eigenes Modell

Abwasserbehandlung
(Wastewater Treatment)
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Bevor wir STOAT starten …
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… erinnern wir uns, dass nur ordnungsgemäß läuft, wenn der im Englischen übliche 
Punkt als Dezimaltrennzeichen verwendet wird. 

Bevor STOAT gestartet wird, sollte also sichergestellt sein, dass auf der Systemebene von 
Windows eine entsprechende Einstellung  gewählt wurde. 

Windows 10
→ Systemsteuerung → Region und Sprache 
→ Formate → Englisch (Großbritannien)

Windows 11:
→ System → Regionales Format
→ Land oder Region: Vereinigtes Königreich
→ Regionales Format: Englisch (Welt)



… wir öffnen STOAT und legen eine Datenbank an …

Neue Datenbank anlegen

(Wir erinnern uns: 
STOAT speichert alle wichtigen Informationen 
zu den Modellen und Rechnerläufen in einer 
Microsoft Access Datenbank.)

Name und Speicherplatz der Datenbank können völlig frei 
gewählt werden (bei Ihnen sinnvollerweise in Ihrem BHT-
Account).

Vorschlag Name der Datenbank: starter.mdb
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… wir legen unser erstes Modell (in start.mdb) an …

Neues Modell anlegen (New works)
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Vorschlag Name des Modells: start



… wir bauen unser erstes, ganz einfaches Modell…

Neues Modell anlegen

Modellaufbau gemäß
STOAT Manual Tutorials Guide, S. 9
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So oder ähnlich soll auch Ihr Modell aussehen, das in der Übung erarbeitet wird. Wenn die Verbindungen in Ihrem 
Modell nicht korrekt rechtwinklig wie in der Vorlage verlaufen, ist das kein Problem! Die Verbindungen zwischen den 
verschiedenen STOAT bits im Modell müssen nicht exakt horizontal oder vertikal verlaufen oder rechtwinklig 
gestaltet sein. Maßgeblich für die Simulation ist lediglich, dass die Verbindungen tatsächlich hergestellt sind. Das 
lässt sich überprüfen, indem die bits bewegt werden – dabei müssen die Verbindungen halten, also der Bewegung 
der bits folgen.

Die verschiedenen „Bausteine“ von STOAT (engl.: STOAT bits) sind grafische Repräsentanten der Prozesse, die mit 
dem jeweiligen Modell simuliert werden sollen. Aktive bits (wie z.B. der aeration tank, im Modell als BB bezeichnet) 
haben immer mindestens einen Eingang und einen Ausgang.  Bei der Simulation wird die am Eingang anliegende 
Datei mathematisch entsprechend der gewählten Abbau- bzw. Eliminierungsleistungen des bits verändert und an 
den Ausgang zwecks Weiterleitung an das folgende bit übergeben.

… wir bauen ein ganz einfaches Modell…



… ein ganz einfaches Modell – Plan B  

Wenn es Ihnen partout nicht gelingen will, laden Sie sich das Ganze von Moodle herunter: 
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… wir konfigurieren einen Rechnerlauf…

Was muss eingestellt werden, bevor man einen 
Rechnerlauf startet?

Kann ich den Rechnerlauf beaufsichtigen?

Wie wird der Rechnerlauf gestartet? 
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Nachdem das Modell (work) fertig konfiguriert wurde, kann die Modell-Ebene 
verlassen und auf die Rechnerlauf-Ebene (run level) übergegangen werden.

Konfiguration des Rechnerlaufs gemäß
STOAT Manual Tutorials Guide, S. 10 ff.



… wir konfigurieren einen Rechnerlauf…
Run anlegen

Beginn und Ende
des Rechnerlaufs
anpassen!
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file:///C:/WRc/STOAT/stoat32.exe


… wir konfigurieren einen Rechnerlauf…
Zulaufdatei (Influent file) generieren
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file:///C:/WRc/STOAT/stoat32.exe


… wir konfigurieren einen Rechnerlauf…

STOAT bits für Rechnerlauf einstellen 
(Operation data, Initial data usw., 
insbesondere VKB, BB, NKB)
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file:///C:/WRc/STOAT/stoat32.exe


… wir konfigurieren einen Rechnerlauf…
Operational data NKB

RAS Recycled Activated Sludge
= Rücklaufschlamm

WAS Wastage Activated Sludge (oder auch: Sludge wastage)
= Überschussschlamm
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Run 1



… wir konfigurieren einen Rechnerlauf…
Initial data NKB

Viable heterotrophs / viable autotrophs müssen sich in den unteren Schichten (layer) im 
NKB anreichern, damit sie in ausreichender Menge im Rücklaufschlamm enthalten sind. 
Damit die Feststoffbilanz aufgeht, muss folgende Bedingung erfüllt sein:

𝑀𝑖𝑥𝑒𝑑 𝑙𝑖𝑞𝑢𝑜𝑟 𝑠𝑢𝑠𝑝𝑒𝑛𝑑𝑒𝑑 𝑠𝑜𝑙𝑖𝑑𝑠 𝑀𝐿𝑆𝑆

≥ ෍𝑣𝑖𝑎𝑏𝑙𝑒 ℎ𝑒𝑡𝑒𝑟𝑜𝑡𝑟𝑜𝑝𝑠 + 𝑣𝑖𝑎𝑏𝑙𝑒 𝑎𝑢𝑡𝑜𝑡𝑟𝑜𝑝ℎ𝑠
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… wir konfigurieren einen Rechnerlauf…
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Auswahl der Parameter für die fortlaufende 
Darstellung der Ergebnisse während des Rechnerlaufs 
(In-simulation reporting)



… wir starten einen Rechnerlauf…
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… wir starten einen Rechnerlauf…
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… der Rechnerlauf ist beendet …

Run 1



… wir begutachten die Resultate…

Welche Ergebnisse liefert ein Rechnerlauf? 

Wie kann ich diese veranschaulichen? 

Welche Schlussfolgerungen sind daraus zu ziehen?

Muss ich die Einstellungen zum Rechnerlauf verändern 
und/oder das Modell umbauen (verändern, erweitern) 
und wenn ja, wie?
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Nachdem der Rechnerlauf (run) abgeschlossen ist, wird die Rechnerlauf-Ebene 
verlassen und auf die Berichts-Ebene (report level) übergegangen.



… wir begutachten die Resultate…
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Die Ablaufkonzentration von Ammonia (NH4-N) steigt zunächst stark an bis auf etwa 40 mg/l. 
Dieser Anstieg ergibt sich daraus, dass die Konzentration in VKB, BB und NKB beim Start des 
ersten Rechnerlaufs „Null“ ist und die Reaktoren erst mit dem im Zulauf simulierten 
„Abwasser gefüllt“ werden müssen, so dass das „Reinwasser“ verdrängt wird. Danach fällt 
die Kurve sukzessive immer weiter ab. Der Verlauf der Konzentration von Nitrate (NO3-N) 
verhält sich umgekehrt. Ergo: Nitrifikation findet statt, allerdings noch gebremst! 

BSB (BOD) analog NH4-N, Einschwingkurve ist aber deutlich kürzer!

Run 1



… wir begutachten die Resultate…
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Ein Blick hinter die Kulissen anhand der Resultate im Baustein aeration tank zeigt uns, dass sich die 
Heterotrophen sehr schnell vermehren und sich bereits nach kurzer Einschwingzeit des Modells bei 
im Mittel etwa 900 mg/l stabilisieren. Das erklärt den fast instantan einsetzenden BSB-Abbau.

Die Autotrophen hingegen brauchen fast die gesamte Simulationsperiode (ein halbes Jahr), bis sie sich 
soweit angereichert haben, dass eine mittlere Konzentration von etwa 20 mg/l erreicht wird. Das ist der 
Hintergrund für die nur langsam in Gang kommende Nitrifikation und verdeutlicht die geringe Wachs-
tumsgeschwindigkeit der für diesen Prozess maßgeblichen autotrophen Mikroorganismen. 

Run 1



… wir begutachten die Resultate…
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Sankey-Diagramm der Volumenströme
(Tools → Stream reports → Sankey diagram → Flow)



… wir begutachten die Resultate…

Sankey-Diagramm NH4-N-Frachten
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Sankey-Diagramm Stofffracht Ammoniumstickstoff
Tools → Stream reports → Sankey diagram → NH3
(Für die hier gezeigte Form des Sankey-Diagramms wurde unter 
Options gewählt Logarithmic / Load)



… wir begutachten die Resultate…
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Sankey-Diagramm Stofffracht Nitratstickstoff 
Tools → Stream reports → Sankey diagram → NO3
(Für die hier gezeigte Form des Sankey-Diagramms wurde unter 
Options gewählt Logarithmic / Load)



… wir begutachten die Resultate usw. usf.

Dr.-Ing. O. Sterger – Abwasserbehandlung, STOAT, Teil 2 24

Sankey-Diagramm Stofffracht Feststoffe
Tools → Stream reports → Sankey diagram → TSS
(Für die hier gezeigte Form des Sankey-Diagramms wurde unter 
Options gewählt Linear / Load)



… wir begutachten die Resultate usw. usf.
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Massenbilanz
Tools → Stream reports → Mass balance



… wir starten einen neuen Run …

In dem neuen Rechnerlauf soll der 
Überschussschlammabzug um 50% 
erhöht werden (von 5 auf 7.5 m³/h). 
Alle anderen Einstellungen werden 
beibehalten.
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Run 2



… neuer Rechnerlauf und Resultate …

Jetzt stellt sich ein anderes Bild ein: Die NH4-N-Konzentration 
steigt von etwa 10 mg/l wieder bis auf ca. 40 mg/l an. NO3-N 
verhält sich hingegen genau umgekehrt, sinkt ab bis auf ca. 
5 mg/l. Ergo: Nitrifikation bricht ein!
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Run 2



Auch hier ein Blick ins Innere des 
Belebungsbeckens:

Die Konzentration der Autotrophen nimmt stark ab bis auf einen 
gewissen Gleichgewichtszustand bei ca. 3 mg/l!

Ergo: Überschussschlamm-Entnahme zu hoch, führt zu „wash-out“!
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Run 2

… weiterer Rechnerlauf und Resultate …



… wir starten noch einen neuen Run …
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In dem neuen Rechnerlauf soll der 
Überschussschlammabzug auf 2,5 m³/h
abgesenkt werden. Alle anderen 
Einstellungen werden beibehalten.



Im nächsten Rechnerlauf soll der Überschussschlammabzug im Vergleich zu run 1
verringert werden (von 5 auf 1 m³/h). Alle anderen Einstellungen werden beibehalten.
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Erwartungsgemäß verbessert sich damit die Nitrifikation, NH4-N geht zurück 
bis auf Werte unter 1 mg/l, die Nitratwerte steigen auf über 40 mg/l an. 

Run 3

… Resultate und noch ein Rechnerlauf …
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Erwartungsgemäß verbessert sich auch hier die Nitrifikation, NH4-N geht 
zurück bis auf Werte unter 1 mg/l. Das Gesamtresultat kann aber nicht 
akzeptiert werden, denn wir sehen einen Durchbruch der Feststoffe (Total SS) 
und damit des BSB (Total BOD) in den Ablauf. Ursache hierfür ist, dass wir mit 
der o.g. Einstellung die Überschussschlamm-Entnahme zu stark gedrosselt 
haben, so dass das Nachklärbecken überlastet wurde.

Run 4

… weiterer Rechnerlauf und Resultate …
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Ein Blick ins Innere des Nachklärbeckens bestätigt diese Vermutung: Die Feststoffe sind innerhalb des NKB soweit 
angestiegen, dass sie auch in der obersten Schicht (Stage 1) eine Konzentration von bis zu etwa 800 mg/l erreichen!

Run 4

… weiterer Rechnerlauf und Resultate …
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Fazit betreffs Überschussschlammabzug

Wenn die Überschussschlammentnahme falsch eingestellt ist, d. h. wenn entweder zu 
viel oder zu wenig Überschussschlamm entnommen wird, passiert folgendes:

Überschussschlammabzug zu hoch: 
Feststoffkonzentration im Belebungsbecken verringert sich, typischer Fall von "wash-
out". Die Nitrifikation bricht ein, weil sich Autotrophe aufgrund ihrer langen 
Generationszeit nicht mehr vermehren können und daher die Konzentration der 
Nitrifikanten im Belebungsbecken immer weiter abnimmt. Die Konzentration an NH4-N 
im Ablauf aus dem Nachklärbecken steigt parallel dazu an, die Konzentration an NO3-N 
nimmt ab.

Überschussschlammabzug zu niedrig: 
Feststoffkonzentration im Belebungsbecken erhöht sich. Damit steigt auch die 
Konzentration der Autotrophen und die Nitrifikation wird soweit verstärkt, dass die 
Konzentration an NH4-N im Ablauf aus dem Nachklärbecken auf Werte unter 1 mg/l 
sinkt. Dementsprechend steigt die Konzentration an NO3-N. Aber: Das Nachklärbecken 
wird überlastet, Feststoffe gelangen in den Ablauf und damit erhöhte Werte an CSB.



«Build»-Menü zum Umbau eines Modells

1. Öffnen des Modells, das die Grundlage für das neue Modell bilden soll (z.B. Works #3)

2. Anlegen eines «New run» - um die gewünschten Einstellungen zu übernehmen z.B. 
als «Start of old run (repeat run)» mit jenem run, der als Ausgangspunkt für die Arbeit 
mit dem Folgemodell dienen soll (z. B. jener Rechnerlauf, der bisher die beste 
Simulationsgüte aufwies)

3. «Build» aktivieren

4. Basis-Modell entsprechend dem gewünschten Design verändern

5. «Save works As» (neuer Name für das geänderte Modell, z.B. Works #4)

6. STOAT bietet an, den Rechnerlauf unter dem neuen Modell sofort zu sichern: 
«Save run as New run» („Run 1“)

7. «Build» deaktivieren

Diese Schritte sind exakt zu befolgen, anderenfalls droht Datenverlust!
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Wir bauen das simple Modell des Tutorials mit Hilfe des «Build»-Menü um zu einem 
Modell der KA Stahnsdorf
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Dynamische Simulation 
der Kläranlage Stahnsdorf

mit dem Programmsystem STOAT

Abwasserbehandlung
(Wastewater Treatment)
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Rückblende letzte LV:
Fazit betreffs Überschussschlammabzug

Überschussschlammabzug zu niedrig: 
Feststoffkonzentration im Belebungsbecken erhöht sich. Damit steigt auch die 
Konzentration der Autotrophen und die Nitrifikation wird soweit verstärkt, dass die 
Konzentration an NH4-N im Ablauf aus dem Nachklärbecken auf Werte unter 1 mg/l 
sinkt. Dementsprechend steigt die Konzentration an NO3-N. Aber: Das Nachklärbecken 
wird überlastet, Feststoffe gelangen in den Ablauf und damit erhöhte Werte an CSB.

Was passiert, wenn die Überschussschlammentnahme falsch eingestellt ist, d. h. wenn 
entweder zu viel oder zu wenig Überschussschlamm entnommen wird?

Überschussschlammabzug zu hoch: 
Feststoffkonzentration im Belebungsbecken verringert sich, typischer Fall von "wash-
out". Die Nitrifikation bricht ein, weil sich Autotrophe aufgrund ihrer langen 
Generationszeit nicht mehr vermehren können und daher die Konzentration der 
Nitrifikanten im Belebungsbecken immer weiter abnimmt. Die Konzentration an NH4-N 
im Ablauf aus dem Nachklärbecken steigt parallel dazu an, die Konzentration an NO3-N 
nimmt ab.



KA Stahnsdorf #1 (Grundmodell)
Laden Sie das in der letzten LV aufgebaute STOAT-Modell und 

bauen Sie dieses um zur „KA Stahnsdorf #1“ (wie unten abgebildet)! 
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Starter-Modell

Modell 
KA Stahnsdorf #1



KA Stahnsdorf #1 (Grundmodell)
Die KA Stahnsdorf ist mehrstraßig ausgelegt. Zwecks
Vereinfachung wird im Modell nur eine Straße – mit
den Beckenvolumina aller Straßen – konfiguriert. Der
Mischwasserzufluss wird aufgeteilt in einen Teil-
strom für Schmutz- und einen für Niederschlags-
wasser.
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Skizze KA Stahnsdorf, maßgebliche Beckenvolumina

VKB 
optional

VKB
BB

NKB
BioP DN N

= 7.800 m³ = 2.500 m³
= 6.000 m³ = 23.000 m³ = 37.200 m³

= 17.600 m³
= 66.200 m³
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„Plan B“ für KA Stahnsdorf #1 (Grundmodell)

Laden Sie das Verzeichnis „STOAT-Dateien der Kläranlage Stahnsdorf“ für die
heutige Lehrveranstaltung von Moodle herunter. Richten Sie unter STOAT die
Datenbank

„KA Stahnsdorf #1.mdb“ (im Pfad „Runs“)
als neue Standarddatenbank ein und öffnen Sie das Modell „KA Stahnsdorf #1“ 
(wie unten abgebildet)! 
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KA Stahnsdorf #1 - Rechen, Sandfang, VKB und BB
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Rechen

Sandfang

VKB BB

Das Modell #2D wird gewählt,
weil wir – neben der Eliminie-
rung von C und N auch die
Eliminierung von P mittels
BioP und Fällung simulieren
wollen.



KA Stahnsdorf #1 - NKB
Im Zusammenspiel mit entspre-
chenden Einstellungen auf Run-
Ebene bewirkt dies, dass die Ent-
nahme von ÜSS gesteuert wird
nach dem TS-Gehalt in Stufe 3
des BB (𝑀𝐿𝑆𝑆 𝑏𝑧𝑤. 𝑇𝑆𝐵𝐵)!

3910 m² x 4.5 m  17600 m³
Der Zulauf zum NKB erfolgt
üblicherweise in halber Höhe
des Beckens.

Warum?
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NKB

NKB



KA Stahnsdorf #1, Run 1 - Einstellungen Vorbehandl.
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Drossel Operation data:

Sandfang Operation data:

Operation data VKB:

𝑄𝑚 = 1.800
𝑙

𝑠
= 6.510 𝑚3/ℎ

(Bemessungszufluss bei 
Regenwetter: „1 + 2“)

Mischwasserzuflüsse, die die hy-
draulische Kapazität der Kläran-
lage überschreiten, werden in
diesem Modell – via Drossel – in
das Gewässer abgeschlagen.



KA Stahnsdorf #1, Run 1 - Einstellungen BB

Stage data BB:

BioP DN N
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Berechnungen 𝑘𝐿𝑎
in Excel-Tabelle

Gewählt gemäß 
Angaben BWB

Siehe folg. Folie!

Siehe Folie 14!

Einstellungen bewir-
ken, dass diese Stufen 

des BB nicht belüftet 
werden.

Alle übrigen Werte 
werden auf den 
STOAT-Vorschlägen 
belassen. 

Einstellungen bewir-
ken, dass diese Stufe 
des BB belüftet wird.



KA Stahnsdorf, Ü-Werte und maßgebliche Stufen BB

BB:

Überwachungswerte

behördlicher Überwachungswert, CSB CCSB,ÜW 68 mg/l

behördlicher Überwachungswert, Nanorg. SanorgN,ÜW 13 mg/l

behördlicher Überwachungswert, Pges. CP,ÜW 1,0 mg/l

BB

BioP DN N

Volumen 6000 m³ 23000 m³ 37200 m³

Anteil 
9.1% 34.7% 56.2%

gewählt: 10% gewählt: 35% gewählt: 55%

Volumen 

gesamt
= 66200 m³
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Belüftung und Belüftungskoeffizient 𝑘𝐿𝑎

𝑐𝑡 = 𝑐𝑆 − 𝑐𝑆 − 𝑐0 ∗ 𝑒−𝑘𝐿𝑎 ∗ 𝑡

nach DROSTE, 1997 
und DWA-M 209

Wobei
𝑐𝑡 Gelöstsauerstoffkonzentration zum Zeitpunkt 𝑡

𝑐𝑆 Sättigungskonzentration des im Wasser gelösten Sauerstoffs

𝑐0 Gelöstsauerstoffkonzentration zum Zeitpunkt 𝑡 = 0

𝑘𝐿𝑎 Belüftungskoeffizient / Sauerstoffübergangskoeffizient

𝑡 Abgelaufene Zeit in Minuten

Sauerstoffkonzentration im BB:
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erforderliche Sauerstoffzufuhr (𝑒𝑟𝑓. 𝛼𝑂𝐶) = 1920 𝑘𝑔 𝑂2/ℎ
mit 𝛼 = 0,7 ergibt sich 𝑒𝑟𝑓. 𝑂𝐶 ≈ 𝟐𝟕𝟎𝟎 𝒌𝒈 𝑶𝟐/𝒉

gewählt:     𝑴𝒊𝒏. 𝒌𝑳𝒂 = 𝟏, 𝟎
𝑴𝒂𝒙. 𝒌𝑳𝒂 = 𝟔, 𝟎

Nebenrechnung zur Ermittlung des Belüftungskoeffizienten 𝑘𝐿𝑎:

Belüftungskoeffizient 𝑘𝐿𝑎

Min. kLa
Minimum 

energy input
required

aerator
efficiency

max. 
Temperature

C Oxygen Saturation C Oxygen Min kLa

W/m³ kg O2/kWh °C mg/l mg/l 1/h

3,0 W/m³ 2,0 kg O2/kWh 20,0°C 9,1 mg O2/l 2,0 mg O2/l 0,8/h𝑀𝑖𝑛. 𝑘𝐿𝑎 =
𝑀𝑖𝑛𝑖𝑚𝑢𝑚 𝑒𝑛𝑒𝑟𝑔𝑦 𝑟𝑒𝑞𝑢𝑖𝑟𝑒𝑑 ∗ 𝐴𝑒𝑟𝑎𝑡𝑜𝑟 𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑐𝑦

𝑐𝑂𝑥𝑦𝑔𝑒𝑛 𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑖𝑜𝑛 − 𝑐𝑂𝑥𝑦𝑔𝑒𝑛

Max. kLa
Max. Oxygen 

uptake

Maximum 
oxygen

supplied

Volume of the 
tank

max. 
Temperature

C Oxygen Saturation Max kLa

% kg/h m³ °C mg/l 1/h

Berechnung von cOxygen

nach PÖPEL, 1985:
30% 2700 kg O2/h 66.200 m³ 20,0°C 9,1 mg O2/l 5,7/h

Berechnung von cOxygen

nach APHA, 1995:
30% 2700 kg O2/h 66.200 m³ 20,0°C 9,1 mg O2/l 5,8/h

𝑀𝑎𝑥. 𝑘𝐿𝑎 =
𝑀𝑎𝑥𝑖𝑚𝑢𝑚 𝑜𝑥𝑦𝑔𝑒𝑛 𝑠𝑢𝑝𝑝𝑙𝑖𝑒𝑑 ∗ 1000

𝑉𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑡ℎ𝑒 𝑡𝑎𝑛𝑘 ∗ 𝑐𝑂𝑥𝑦𝑔𝑒𝑛 𝑠𝑎𝑡𝑢𝑟𝑎𝑡𝑖𝑜𝑛
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Formeln für 𝑀𝑖𝑛. 𝑘𝐿𝑎 und 𝑀𝑎𝑥. 𝑘𝐿𝑎
gemäß STOAT Handbüchern



KA Stahnsdorf #1, Run 1 – Einstellungen BB
MLSS recycle data BB:

P-Fällung 120.0 kg Fe/d mit b  2

240.0 kg Fe/d = 10.0 kg Fe/h = 0.10 m³/h mit 100,000 mg Fe/l

oder = 0.05 m³/h mit 200,000 mg Fe/l

oder = 0.50 m³/h mit 20,000 mg Fe/l (gewählt)

oder = 1.25 m³/h mit 8,000 mg Fe/l

Operation data BB:
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Einstellung bewirkt, dass die 
interne Rezirkulation von 
Stufe 3 (N) zu Stufe 2 (DN) 
des BB erfolgt.

Volumenstrom der internen Rezirkulation 
gemäß Bilanzberechnung (siehe folg. Folie)



66.200 𝑚³ 17.600 𝑚³

Volumenstrombilanz KA Stahnsdorf für 𝑄𝑡

2.167 𝑚³/ℎ

𝑄𝑅𝑆 = 0,7 ∗ 2.167 ≈ 1.517 𝑚3/ℎ

79 𝑚³/ℎ

2.167 − 79 = 2.088 𝑚3/ℎ

𝑄𝑅𝑍 = 3 − 0,7 ∗ 2.167 ≈ 5.000 𝑚3/ℎ

𝑄𝑍𝐵 = 𝑄𝑡 = 2.167 𝑚³/ℎ
𝑅𝐹 = 3
𝑅𝑉 = 0,7
𝑄Ü𝑆,𝑑 = 1.900 𝑚³/𝑑 ≈ 79 𝑚3/ℎ

𝑄𝑅𝑍 = 𝑅𝐹 − 𝑅𝑉 ∗ 𝑄𝑍𝐵𝑅𝐹 =
𝑄𝑅𝑆 + 𝑄𝑅𝑍

𝑄𝑍𝐵

𝑄𝑅𝑆 = 𝑅𝑉 ∗ 𝑄𝑍𝐵

2.167 +
1.517 =
3.684 𝑚³/ℎ

3.684 −2.088
= 1.596 𝑚³/ℎ

(Trockenwetterfall)
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KA Stahnsdorf #1, Run 1 – Einstellungen NKB

Operation data NKB: RAS ratio (Rücklaufverhältnis) = 0,7

Sludge wastage flow (Überschuss-
schlammentnahme) = 79 m³/h i. M.
Eintrag hier ist Maximalwert, deshalb 
gewählt max. ÜSS = 100 m³/h

MLSS set-point (𝑇𝑆𝐵𝐵) = 3.300 mg/l

Im Zusammenspiel mit der Einstellung des NKB auf Works-Ebene bewirkt die oben 
gewählte Einstellung, dass genau so viel ÜSS entnommen wird, dass sich in Stufe 3 
des BB eine Feststoffkonzentration von 3.300 mg/l einstellt und erhalten bleibt. 
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Stage1 Stage2 Stage3 Stage4 Stage5 Stage6 Stage7 Stage8

1 Temperature: 15 15 15 15 15 15 15 15

2 BOD of volatile fatty acids (mg/l): 0 0 0 0 0 0 0 0

3 Soluble BOD (mg/l): 0 0 0 0 0 0 0 0

4 Soluble inert COD (mg/l): 0 0 0 0 0 0 0 0

5 Particulate BOD (mg/l): 0 0 0 0 0 0 0 0

6 Particulate inert COD (mg/l): 0 0 0 0 0 0 0 0

7 Volatile solids (mg/l): 0 0 0 0 0 200 500 2000

8 Non-volatile solids (mg/l): 0 0 0 0 0 0 0 0

9 Ammonia (mg/l): 0 0 0 0 0 0 0 0

10 Nitrate (mg/l): 0 0 0 0 0 0 0 0

11 Soluble organic nitrogen (mg/l): 0 0 0 0 0 0 0 0

12 Particulate organic N (mg/l): 0 0 0 0 0 0 0 0

13 Phosphate (mg/l): 0 0 0 0 0 0 0 0

14 Dissolved oxygen (mg/l): 0 0 0 0 0 0 0 0

15 PolyP in viable P removers (mg/l): 0 0 0 0 0 10 200 500

16 PolyP in non-viable P removers (mg/l): 0 0 0 0 0 0 0 0

17 PHB in viable P removers (mg/l): 0 0 0 0 0 10 25 50

18 PHB in non-viable P removers (mg/l): 0 0 0 0 0 0 0 0

19 Viable autotrophs (mg/l): 0 0 0 0 0 10 50 100

20 Non-viable autotrophs (mg/l): 0 0 0 0 0 0 0 0

21 Viable heterotrophs (mg/l): 0 0 0 0 0 50 100 1000

22 Non-viable heterotrophs (mg/l): 0 0 0 0 0 0 0 0

23 Viable P removers (mg/l): 0 0 0 0 0 50 100 500

24 Non-viable P removers (mg/l): 0 0 0 0 0 0 0 0

KA Stahnsdorf #1, Run 1 – Einstellungen NKB
Initial data NKB:

erforderlich für 
Initialisierung BioP

erforderlich für 
Initialisierung DN

erforderlich für 
Initialisierung N

𝑉𝑜𝑙𝑎𝑡𝑖𝑙𝑒 𝑠𝑜𝑙𝑖𝑑𝑠 ≥ ෍𝑣𝑖𝑎𝑏𝑙𝑒 ℎ𝑒𝑡𝑒𝑟𝑜𝑡𝑟𝑜𝑝𝑠 + 𝑣𝑖𝑎𝑏𝑙𝑒 𝑎𝑢𝑡𝑜𝑡𝑟𝑜𝑝ℎ𝑠 + 𝐵𝑖𝑜𝑃 − 𝑜𝑟𝑔𝑎𝑛𝑖𝑠𝑚𝑠
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KA Stahnsdorf #1, Run 1 - Einstellungen NKB
Initial data NKB:
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KA Stahnsdorf #1, Run 1 - Zulaufdateien

Zulaufdateien:
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(STOAT Menü → Edit → Influents)

Aus didaktischen Gründen wurde der Mischwasserzulauf zur KA Stahnsdorf im 
Modell aufgeteilt in einen Schmutzwasserzulauf und einen Regenwetterzulauf. Somit 
entsteht im Modell der tatsächlich vorhandene Mischwasserzulauf hinter dem Mixer, 
der beide Teilströme rechnerisch zusammenführt.
Die Inputdateien für diese beiden Zuläufe beruhen nicht auf Originaldaten der KA 
Stahnsdorf, sondern auf Daten eines anderen Klärwerks. Diese wurden entsprechend 
der angeschlossenen Einwohner proportional umgerechnet. 



KA Stahnsdorf #1, Run 1 - Zulaufdateien

Excel-Datei für Schmutzwasser
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Stahnsdorf/Influents/Stahnsdorf_cod.xlsx


KA Stahnsdorf #1, Run 1 - Zulaufdateien

Excel-Datei für Niederschlagswasser
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… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Ablaufwerte
Flow, Konzentration Total SS, Total COD, Ammonia, Nitrate, Phosphate



…Resultate überprüfen – Schlussfolgerungen?

Denitrifikation, BB:

Phosphatelimierung, BB:

Nitrifikation, BB:

Eliminierung Organika, BB:
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Feststoffkreislauf, BB + NKB:

Ablaufwerte Nitrate

Ablaufwerte Phosphate, BioP – Phosphorakkumulie-
rende Mikroorganismen (PAO´s) im BB

Ablaufwerte Ammonia, Autotrophe im BB

Ablaufwerte BOD/COD, Heterotrophe im BB

Ablaufwerte der Total Suspended Solids, Konzentration 
der Feststoffe im BB (MLSS), Überschussschlamm-
entnahme (WAS), Rücklaufschlammförderung (RAS)

Prozess, Reaktor Prüfkriterien
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(nach Angaben der BWB)

Parameter Zulauffrachten Resultierende 

Zulaufkonzentration 

bei 52 000 m³/d

Ablaufwerte 

(gerundet)

Eliminierung

BSB 22,80 t/d 438 mg/l 5 mg/l 98,9%

CSB 54,68 t/d 1052 mg/l 41 mg/l 96,1%

TKN 4,70 t/d 90 mg/l

NH4-N 3,42 t/d 66 mg/l 0,2 mg/l 99,7%

TIN 3,42 t/d 66 mg/l 11,3 mg/l 82,9%

P gesamt 0,60 t/d 12 mg/l 0,6 mg/l 95,0%

AFS 23,90 t/d 460 mg/l 7 mg/l 98,5%

Zulauf- und Ablaufwerte der KA Stahnsdorf



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Zulaufwerte Schmutzwasser
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Zulaufwerte Regenwasser
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Zulaufwerte Mischwasser
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Ablauf Drossel zur KA
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Überlauf Drossel (Mischwasserentlastung)
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf BB → Results… → Total solids (mg/l) → Graph only

3D-Grafik BB
Konzentration Total solids



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf Rücklaufschlamm (vom NKB zum BB) → Results… → Flow (m³/h) + 
Total SS (mg/l) → Graph and summary statistics, Flow graph scale factor: x1

Rücklaufschlamm (RAS)
Flow, Konzentration Total SS



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf ÜSS → Results → Flow (m³/h) + Total SS (mg/l) → Graph and 
summary statistics, Flow graph scale factor: x100

Überschussschlamm (WAS)
Flow, Konzentration Total SS



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf BB → Results… → Heterotrophs (mg COD/l) + PAO + Autotrophs + 
Total solids → Summary Statistics only

Zusammenfassende Statistik BB
Konzentration Heterotrophs, Autotrophs, PAO´s, Total solids



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf BB → Results… → Heterotrophs (mg COD/l) → Graph only

3D-Grafik BB
Konzentration Heterotrophs



…Resultate überprüfen – Schlussfolgerungen?

Dr.-Ing. O. Sterger – Abwasserbehandlung, STOAT, Teil 3 36

STOAT Menü → Tools → Stream reports → Sankey diagram → Options → Logarithmic + Concentration
STOAT Menü → Tools → Stream reports → Sankey diagram → COD

KA Stahnsdorf #1
Run 1

Sankey-Diagramm
Konzentration COD



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf BB → Results… → Autotrophs (mg COD/l) → Graph only

3D-Grafik BB
Konzentration Autotrophs



…Resultate überprüfen – Schlussfolgerungen?
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STOAT Menü → Tools → Stream reports → Sankey diagram → Options → Linear + Load
STOAT Menü → Tools → Stream reports → Sankey diagram → NH3

KA Stahnsdorf #1
Run 1

Sankey-Diagramm
Fracht NH4-N



…Resultate überprüfen – Schlussfolgerungen?
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STOAT Menü → Tools → Stream reports → Sankey diagram → Options → Linear + Load
STOAT Menü → Tools → Stream reports → Sankey diagram → NO3

KA Stahnsdorf #1
Run 1

Sankey-Diagramm
Fracht NO3-N



…Resultate überprüfen – Schlussfolgerungen?
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STOAT Menü → Tools → Stream reports → Sankey diagram → Options → Linear + Load
STOAT Menü → Tools → Stream reports → Sankey diagram → Total N

KA Stahnsdorf #1
Run 1

Sankey-Diagramm
Fracht Total N



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

Mausklick rechts auf BB → Results… → PAO (mg COD/l) → Graph only

3D-Grafik BB
Konzentration PAO´s



…Resultate überprüfen – Schlussfolgerungen?

Dr.-Ing. O. Sterger – Abwasserbehandlung, STOAT, Teil 3 42

STOAT Menü → Tools → Stream reports → Sankey diagram → Options → Logarithmic + Concentration
STOAT Menü → Tools → Stream reports → Sankey diagram → PO4

KA Stahnsdorf #1
Run 1

Sankey-Diagramm
Konzentration PO4



…Resultate überprüfen – Schlussfolgerungen?

Denitrifikation (Nitrate):

Phosphatelimierung (Phosphate):

Nitrifikation (Ammonia):

Organika (BOD/COD):
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o.k. (top!)

o.k.

o.k.

o.k.

Die überaus positive Bewertung der Simulationsergebnisse beruht allerdings nur auf 
den uns zugänglichen langjährigen Mittelwerten des Ablaufs der KA Stahnsdorf.
Eine besser belastbare Aussage über die Simulationsqualität erzielt man, wenn die 
Simulationsergebnisse anhand von Ganglinien der Ablaufwerte, z.B. mit stündlicher 
Auflösung beurteilt werden. 
Die „hohe Schule“ der Simulation besteht darin, auch kurzzeitig auftretende Peaks 
der Ablaufwerte nachzuvollziehen und damit Störungen im Betriebsgeschehen 
abzubilden und analysieren zu können! 

Feststoffe (Suspended Solids): o.k. (top!)



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #1
Run 1

STOAT Menü → Tools → Stream reports → Mass balance

Bilanz der 
Massenströme

Allerdings gelan-
gen über die 
Mischwasserent-
lastung hohe 
Schadstofffrach-
ten in den Vorflu-
ter. Bei BOD und 
Feststoffen (SS) 
sind diese sogar 
noch höher als 
der Ablauf der 
KA!

Ein Vergleich zwischen 
Mischwasserzulauf und 
Ablauf der KA zum 
Vorfluter zeigt die hohe 
Reinigungsleistung.
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Zum Problem der Mischwasserentlastungen

„Infectionsstoffe sollten also unter allen Umständen von den öffentlichen 
Wasserläufen fern gehalten werden. In der Praxis wird sich diese Forderung 
indessen nicht vollständig durchführen lassen… Die jetzt bestehenden Einrichtungen 
sind sämmtlich darauf berechnet, daß die Abzugskanäle das Regenwasser nur 
theilweise abführen und daß, wenn die Regenmenge über die Leistungsfähigkeit des 
Kanalsystems hinausgeht, Nothauslässe in Function treten, welche sowohl das 
überschüssige Regenwasser als die dann noch in die Kanäle gelangenden Fäcalien
und Haus-Schmutzwässer direct in den nächsten öffentlichen Wasserlauf fließen 
lassen. Bei dieser Gelegenheit können selbstverständlich auch Infectionsstoffe in die 
Wasserläufe gespült werden… Immerhin ist die Benutzung der Nothauslässe im 
Stande, recht bedenkliche Stoffe in die öffentlichen Wasserläufe zu führen. Sie sind 
aber nun einmal nicht zu entbehren und es bleibt nur übrig, ihre Thätigkeit auf das 
allernothwendigste Maaß zu beschränken.“ (Robert Koch) 

zitiert in Jurisch, K. W.: Die Verunreinigung der Gewässer
Eine Denkschrift im Auftrage der Flusscommission des Vereins zur Wahrung der Interessen der Chemischen Industrie Deutschlands…
R. Gaertner’s Verlagsbuchhandlung, Berlin 1890



Grundmodell erweitern mit «Build»-Menü

Bauen Sie das eben benutzte Grundmodell mit Hilfe des «Build»-
Menüs so um, dass das unten abgebildete neue Modell der KA
Stahnsdorf - mit Regenüberlaufbecken - entsteht!
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«Build»-Menü zum Umbau eines Modells

1. Öffnen des Modells, das die Grundlage für das neue Modell bilden soll (z.B. Works #3)

2. Anlegen eines «New run» - um die gewünschten Einstellungen zu übernehmen z.B. 
als «Start of old run (repeat run)» mit jenem run, der als Ausgangspunkt für die Arbeit 
mit dem Folgemodell dienen soll (z. B. jener Rechnerlauf, der bisher die beste 
Simulationsgüte aufwies)

3. «Build» aktivieren

4. Basis-Modell entsprechend dem gewünschten Design verändern

5. «Save works As» (neuer Name für das geänderte Modell, z.B. Works #4)

6. STOAT bietet an, den Rechnerlauf unter dem neuen Modell sofort zu sichern: «Save 
run as New run» („Run 1“)

7. «Build» deaktivieren

Diese Schritte sind exakt zu befolgen, anderenfalls droht Datenverlust!
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KA Stahnsdorf #2, Regenüberlaufbecken

Dr.-Ing. O. Sterger – Abwasserbehandlung, STOAT, Teil 3 48

Volumen gemäß Angaben BWB 
(„Zwischenspeicherbecken bei 

Regenwetter“ bzw. VKB optional)

Beckentiefe: 5 m

Konfiguration benötigt Angabe eines Teilstroms, der bei
der Steuerung von Füllung und Entleerung des RÜB zum
Vergleich herangezogen wird.
Gewählt wird hierzu der Drosselablauf zur KA, hier be-
zeichnet als „RÜB_bypass“



KA Stahnsdorf #2

Erläuterungen zum Teilsystem Drossel-Regenüberlaufbecken (RÜB)
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KA Stahnsdorf #2, Einstellungen Run 1

D.h.: Solange in RÜB_bypass (= Control stream) nicht mehr als 1000 
m³/h fließen, kann das RÜB mit 5500 m³/h zur KA entlasten.
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Die Einstellungen jener bits, die bereits im Modell KA Stahnsdorf #1 vorhanden waren (also Drossel, 
Rechen, Sandfang, VKB, BB und NKB) werden nicht verändert, sondern allenfalls sicherheitshalber 
noch einmal überprüft. Auch die Zulaufdateien bleiben dieselben wie bisher.
Einstellungen sind lediglich für das neu hinzugekommene RÜB erforderlich.

RÜB Operation data

Volumenstrom, der beim Entleeren des 
RÜB zur KA geleitet werden soll

𝑅𝑒𝑡𝑢𝑟𝑛 𝑝𝑢𝑚𝑝 𝑟𝑎𝑡𝑒 + 𝐶𝑜𝑛𝑡𝑟𝑜𝑙 𝑠𝑡𝑟𝑒𝑎𝑚 𝑓𝑙𝑜𝑤 ≤ 6500 𝑚3/ℎ

Bemessungszufluss der KA Stahnsdorf bei Regenwetter: 

𝑄𝑚 = 156000
𝑚3

𝑑
= 6500

𝑚3

ℎ

Volumenstrom, der im Control 
stream maximal fließen darf, damit 
das RÜB mit der gewählten Return 
pump rate entleert werden kann



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

Ablaufwerte
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate

Mausklick rechts auf «Ablauf KA» → Results… → Flow, Total SS, Biodegradable COD, Total COD, 
Ammonia, Nitrate, Phosphate → Graph and summary statistics, Flow graph scale factor: /10



…Resultate überprüfen – Schlussfolgerungen?

Im Prinzip keine Änderungen im Vergleich zu KA Stahnsdorf #1, Run 1:
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Denitrifikation (Nitrate):

Phosphatelimierung (Phosphate):

Nitrifikation (Ammonia):

Organika (BOD/COD): o.k. (top!)

o.k.

o.k.

o.k.

Feststoffe (Suspended Solids): o.k. (top!)

Der Unterschied zum Vorläufermodell besteht – wie nicht anders zu erwarten - in 
einer verringerten Mischwasserentlastung und damit in einer insgesamt geringeren 
Belastung des aufnehmenden Gewässers.

Lohnt sich die Mühe auch für die BWB als Betreiber der Anlage?



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB Überlauf
Flow

Durch die Zwischenschaltung eines Regenüberlauf-
beckens springt die Mischwasserentlastung im Vergleich 
zum vorhergehenden Modell #1 seltener an. 

Mausklick rechts auf «Mischwasserentlastung» → Results… → Flow → Graph and 
summary statistics, Flow graph scale factor: x1



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB Ablauf zur KA
Flow

Die aus dem Regenüberlaufbecken über den Return 
flow zur Kläranlage zurückgeleiteten Abwassermengen 
entlasten das aufnehmende Gewässer. 

Mausklick rechts auf Ablauf des RÜB zum 2 Way Mixer → Results… → Flow → Graph and 
summary statistics, Flow graph scale factor: x1



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB 
Volume in tank

Mausklick rechts auf «Regenüberlaufbecken» → Results… → Volume in tank → Graph and 
summary statistics

Es ist erkennbar, dass das Regenüberlaufbecken mit der gewählten 
Einstellung des öfteren über längere Zeit gefüllt bleibt – also im 
Regenwetterfall kein Mischwasser mehr aufnehmen kann. 



Vergleich KA Stahnsdorf #1 mit KA Stahnsdorf #2

Vergleichen Sie die Frachten, die im Regenwetterfall nach Inbetrieb-
nahme des Regenüberlaufbeckens vermieden werden!

• Feststoffe
• CSB
• NH4-N
• P
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… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

STOAT Menü → Tools → Stream reports → Mass balance

Über die Mischwasserentlastung 
werden jetzt geringere Schadstoff-
frachten in den Vorfluter geleitet 
als in Modell #1, diese sind aber 
immer  noch viel zu hoch und bei 
BOD sogar noch höher als der 
Ablauf der KA!

Ein Vergleich zwischen Misch-
wasserzulauf und Ablauf der 
KA zum Vorfluter zeigt die hohe 
Reinigungsleistung.

Bilanz der 
Massenströme



KA mit vorgeschalteter Denitrifikation: C-Bilanz

100%

35…50%
(in Form von CO2)

35…50%10…30%

5…15%
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KA mit vorgeschalteter Denitrifikation: O2/CSB-Bilanz

Zulauf
100%

30…40%5…15%

Ablauf
5…15%

Belüftung
30…50%
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Dynamische Simulation der Kläranlage Stahnsdorf
mit dem Programmsystem STOAT

- Zusammenspiel von Drossel & RÜB /
Einsatz von Steuer- und Regeleinrichtungen -

Abwasserbehandlung
(Wastewater Treatment)
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KA Stahnsdorf #2 (Modell #1 zuzügl. RÜB)
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Modell 
KA Stahnsdorf #2

Modell 
KA Stahnsdorf #1

Laden Sie die gezippten STOAT Dateien für die heutige LV von Moodle herunter und 
entpacken Sie diese. Starten Sie STOAT und wählen Sie „KA Stahnsdorf #1_4.mdb“ als 

Standarddatenbank aus. Öffnen Sie dann Modell „KA Stahnsdorf #2“! 



KA Stahnsdorf #2, Regenüberlaufbecken
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Volumen gemäß Angaben BWB 
(„Zwischenspeicherbecken bei 

Regenwetter“ bzw. VKB optional)

Beckentiefe: 5 m

Konfiguration benötigt Angabe eines Teilstroms, der bei
der Steuerung von Füllung und Entleerung des RÜB zum
Vergleich herangezogen wird.
Gewählt wird hierzu der Drosselablauf zur KA, hier be-
zeichnet als „RÜB_bypass“

Mischwasserzuflüsse, die die hy-
draulische Kapazität der Kläran-
lage überschreiten, werden – via
Drossel – in diesem Modell nicht
in das Gewässer abgeschlagen,
sondern in das Regenüberlauf-
becken geleitet.



KA Stahnsdorf #2

Erläuterungen zum Teilsystem Drossel-Regenüberlaufbecken (RÜB)
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KA Stahnsdorf #2, Einstellungen Run 1

D.h.: Solange in RÜB_bypass (= Control stream) nicht mehr als 1000 
m³/h fließen, kann das RÜB mit 5510 m³/h zur KA entlasten.
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Die Einstellungen jener bits, die bereits im Modell KA Stahnsdorf #1 vorhanden waren (also Drossel, 
Rechen, Sandfang, VKB, BB und NKB) werden nicht verändert, sondern allenfalls sicherheitshalber 
noch einmal überprüft. Auch die Zulaufdateien bleiben dieselben wie bisher.
Einstellungen sind lediglich für das neu hinzugekommene RÜB erforderlich.

RÜB Operation data

Volumenstrom, der beim Entleeren des 
RÜB zur KA geleitet werden soll

𝑅𝑒𝑡𝑢𝑟𝑛 𝑝𝑢𝑚𝑝 𝑟𝑎𝑡𝑒 + 𝐶𝑜𝑛𝑡𝑟𝑜𝑙 𝑠𝑡𝑟𝑒𝑎𝑚 𝑓𝑙𝑜𝑤 ≤ 6510 𝑚3/ℎ

Bemessungszufluss der KA Stahnsdorf bei Regenwetter: 

𝑄𝑚 = 156000
𝑚3

𝑑
= 6510

𝑚3

ℎ

Volumenstrom, der im Control 
stream maximal fließen darf, damit 
das RÜB mit der gewählten Return 
pump rate entleert werden kann



KA Stahnsdorf #2, Run 1
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Starten Sie den 
Rechnerlauf!



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

Ablaufwerte
Flow, Konzentration Total SS, Biodegradable COD (= Total 
BOD), Total COD, Ammonia, Nitrate, Phosphate

Mausklick rechts auf «Ablauf KA»→ Results…→ Flow, Total SS, Biodegradable COD, Total COD, 
Ammonia, Nitrate, Phosphate → Graph and summary statistics, Flow graph scale factor: /10



…Resultate überprüfen – Schlussfolgerungen?

Im Prinzip keine Änderungen im Vergleich zu KA Stahnsdorf #1, Run 1:
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Denitrifikation (Nitrate):

Phosphatelimierung (Phosphate):

Nitrifikation (Ammonia):

Organika (BOD/COD): o.k. (top!)

o.k.

o.k.

o.k.

Feststoffe (Suspended Solids): o.k. (top!)

Der Unterschied zum Vorläufermodell besteht – wie nicht anders zu erwarten - in 
einer verringerten Mischwasserentlastung und damit in einer insgesamt geringeren 
Belastung des aufnehmenden Gewässers.



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB Überlauf
Flow

Durch die Zwischenschaltung eines Regenüberlauf-
beckens springt die Mischwasserentlastung im 
Vergleich zum vorhergehenden Modell #1 seltener an. 

Mausklick rechts auf «Mischwasserentlastung»→ Results…→ Flow → Graph and 
summary statistics, Flow graph scale factor: x1



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB Ablauf zur KA
Flow

Die aus dem Regenüberlaufbecken über den 
Return flow zur Kläranlage zurückgeleiteten 
Abwassermengen entlasten das aufnehmende 
Gewässer. 

Mausklick rechts auf Ablauf des RÜB zum 2 Way Mixer → Results…→ Flow → Graph and 
summary statistics, Flow graph scale factor: x1



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

RÜB 
Volume in tank

Mausklick rechts auf «Regenüberlaufbecken»→ Results…→ Volume in tank → Graph and 
summary statistics

Es ist erkennbar, dass das Regenüberlaufbecken mit der gewählten Einstel-
lung des Öfteren über längere Zeit gefüllt bleibt – also im Regenwetterfall 
kein Mischwasser mehr aufnehmen kann. 



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

Interne Rezirkulation
Flow

Der Abwasservolumenstrom der internen Rezirkulation bleibt –
entsprechend unserer Einstellungen – über die gesamte 
Simulationsperiode konstant (= 5000 m³/h). 

Mausklick rechts auf «BB»→MLSS recycle results→ From / To / Flow → Graph and 
summary statistics→Mausklick rechts auf Grafik, Maßstab der Y-Achse verändern



Vergleich KA Stahnsdorf #2 mit KA Stahnsdorf #1

Vergleichen Sie die Frachten, die im Regenwetterfall nach Inbetrieb-
nahme des Regenüberlaufbeckens vermieden werden!

• Feststoffe
• CSB
• NH4-N
• P
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… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #2
Run 1

STOAT Menü → Tools→ Stream reports→Mass balance

Über die Mischwasserentlastung 
werden jetzt geringere Schadstoff-
frachten in den Vorfluter geleitet 
als in Modell #1, diese sind aber 
immer  noch viel zu hoch und bei 
BOD sogar noch höher als der 
Ablauf der KA!

Ein Vergleich zwischen Misch-
wasserzulauf und Ablauf der 
KA zum Vorfluter zeigt die hohe 
Reinigungsleistung.

Bilanz der 
Massenströme



KA Stahnsdorf #3 (Modell #2 zuzügl. PLC RÜB)
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Modell 
KA Stahnsdorf #3

Modell 
KA Stahnsdorf #2

Öffnen Sie Modell „KA Stahnsdorf #3“! (Im Unterschied zu #2 wird das RÜB hier nicht 
durch einen Storm tank, sondern durch einen Balancing tank repräsentiert. Das ist 

erforderlich, um die Steuerung mittels PLC zu ermöglichen.) 

Um die Mischwasserentlastung aus dem Regen-
überlaufbecken zu verringern, wird in diesem
Modell eine intelligentere Steuerung des RÜB
eingeführt.



Im Vergleich zu Modell «KA Stahnsdorf #2» wird
im neuen Modell ein anderer Baustein für das
«RÜB» verwendet. Dabei handelt es sich um den
Balancing Tank aus dem Untermenü Other treat-
ment processes der Processes tool box.
Die Ein- und Ausgänge des Balancing Tank sind
praktisch identisch mit den Ein- und Ausgängen
des Storm tanks, der im vorhergehenden Modell
zum Einsatz kam.
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Modell KA Stahnsdorf #3 – RÜB, PLC RÜB

Diese Änderung ist erforderlich, um die Entleerung des
RÜB intelligenter als in «KA Stahnsdorf #2» steuern zu
können. Dazu dient der Baustein «PLC RÜB» (PLC steht
für Programmable Logic Controller) aus dem Unter-
menü Control functions der Processes tool box.



KA Stahnsdorf #3, Run 1 – Einstellungen RÜB

Öffnen Sie Run 2! File → Open run→ Run 2
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RÜB Operation data:

RÜB Process Calibration:

Pump rate (Abpump-
Volumenstrom) des RÜB 
auf 100 m³/h eingestellt, 
wird aber von dem Wert 
überschrieben, den der 
PLC triggert.

Mode of operation muss 
auf Variable volume
gestellt werden!



KA Stahnsdorf #3, Run 1 – Einstellungen PLC RÜB
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PLC RÜB Connectivity:

Input des «PLC RÜB»:
Volumenstrom in 
«RÜB_bypass»

Output des «PLC RÜB»: 
Pump rate der Entlee-
rung des RÜB zur Klär-
anlage

Die STOAT-Bausteine zur Steuerung und Regelung werden nicht in die Fließwege des Abwassers
integriert, sondern können beliebig auf dem digitalen „Zeichenbrett“ angeordnet werden. Dies
trifft auch zu für den Baustein «PLC RÜB» (wurde im Modell beim «RÜB» platziert).

Die Verbindung zwischen PLC und RÜB ist rein
logisch und wird mittels Connectivity definiert.



KA Stahnsdorf #3, Run 1 – Einstellungen PLC RÜB
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PLC RÜB Operation data:

Wenn der Volumenstrom im «RÜB_bypass» zwischen 0 und 500 m³/h liegt, können der 
Kläranlage aus dem RÜB 6010 m³/h zugeführt werden (6510 − 500 = 6010).

«999999» ist nach der Syntax des PLC das Synonym für 
unendlich ().

Die Operation data können per Drag & Drop aus der Excel-Datei „KA Stahnsdorf STOAT 
Hintergrundberechnungen.xlsx“, Register „ PLC RÜB“ übernommen werden!



KA Stahnsdorf #3, Run 1 – Einstellungen PLC RÜB
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PLC RÜB Operation data:

Wenn der Volumenstrom im «RÜB_bypass» zwischen 500 und 1000 m³/h liegt, können der 
Kläranlage aus dem RÜB 6010 m³/h zugeführt werden (6510 − 1000 = 5510).



KA Stahnsdorf #3, Run 1
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Starten Sie den 
Rechnerlauf!



Ergebnisse KA Stahnsdorf #3, Run 1 
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KA Stahnsdorf #3
Run 1

2D-Grafik Teilstrom «Ablauf KA»
Flow und Konzentration der wichtigsten Parameter

Mausklick rechts auf Baustein «Ablauf KA»→ Results…→ Flow (m³/h), Total SS (mg/l), 
Biodegradable COD (mg/l), Total COD (mg/l), Ammonia (mg/l), Nitrate (mg/l), Phosphate (mg/l)

→ Graph and summarystatistics→ Flow scale factor: /10

Diese Grafik zeigt zusammenfassend den Ablauf der Kläranlage zum Teltowkanal als aufnehmen-
des Gewässer. 



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf Teilstrom «RÜB-bypass»→ Results…→ Flow (m³/h), Total SS (mg/l), 
Biodegradable COD (mg/l), Total COD (mg/l), Ammonia (mg/l), Nitrate (mg/l), Phosphate (mg/l)

→ Graph and summarystatistics→ Flow scale factor: 1

KA Stahnsdorf #3
Run 1

2D-Grafik Teilstrom «RÜB-bypass»
Flow und Konzentration der wichtigsten Parameter

Diese Grafik charakterisiert den Zulauf zur Kläranlage aus der «Drossel». Abschneidegrenze des 
Volumenstroms ist die maximale hydraulische Kapazität der Kläranlage (6510 m³/h). 



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf Teilstrom «Drossel Overflow»→ Results…→ Flow (m³/h), Total SS (mg/l), 
Biodegradable COD (mg/l), Total COD (mg/l), Ammonia (mg/l), Nitrate (mg/l), Phosphate (mg/l)

→ Graph and summarystatistics→ Flow scale factor: 1

KA Stahnsdorf #3
Run 1

2D-Grafik Teilstrom «Drossel Overflow»
Flow und Konzentration der wichtigsten Parameter

Jeder Peak dieser Grafik kennzeichnet ein Niederschlagsereignis, bei dem die maximale hydrau-
lische Kapazität der Kläranlage (6510 m³/h) überschritten wurde. Demzufolge springt der 
Overflow der Drossel an und es wird Mischabwasser in das RÜB geleitet. 



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf Baustein «PLC RÜB» → Results…→ Output

KA Stahnsdorf #3
Run 1

2D-Grafik «PLC RÜB» 
Output

Diese Werte hat die Steuerung getriggert.



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf Teilstrom «RÜB_Ablauf_KA»→ Results…→ Flow (m³/h)

KA Stahnsdorf #3
Run 1

2D-Grafik Ableitung von Abwasser aus dem RÜB zur KA 
Flow

Hier sind die Volumenströme zur Entleerung des RÜB in Richtung Kläranlage dargestellt. Diese 
Darstellung der Ergebnisse weicht deutlich vom Output des Reglers ab. Das hängt damit 
zusammen, dass die Signale des Reglers buchstäblich ins Leere laufen, wenn das RÜB kein 
gespeichertes Mischwasser mehr enthält, also bereits entleert ist. Dennoch ist zu erkennen, 
dass die Return pump rate tatsächlich vom «PLC RÜB» gesteuert wurde. 



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf STOAT bit «Regenüberlaufbecken»→ Results…→ Volume in tank (m³)

KA Stahnsdorf #3
Run 1

2D-Grafik Füllungsstand «Regenüberlaufbecken»
Volume in tank (m³)

Im Unterschied zu Modell #2 wird das RÜB nach jeder Befüllung infolge eines 
Niederschlagsereignisses unverzüglich entleert und steht somit beim nächsten 
Mischwasserzulauf wieder zur Verfügung. 

Erwartungsgemäß ähnelt diese Grafik dem Overflow der Drossel als Zulauf zum RÜB. Als 
„Abschneidegrenze“ wirkt das maximale Volumen des RÜB (7800 m³). Geht der Zulauf zum RÜB 
über dessen Fassungsvermögen hinaus, muss Mischwasser in den Vorfluter entlastet werden –
das ist aber nur noch selten der Fall. 



Ergebnisse KA Stahnsdorf #3, Run 1 
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Mausklick rechts auf STOAT bit «Mischwasserentlastung»→ Results…→ Flow (m³/h)

KA Stahnsdorf #3
Run 1

2D-Grafik «Mischwasserentlastung»
Flow

Im Vergleich zur vorhergehenden Version des Modells der KA Stahnsdorf 
sind deutlich weniger Überlaufereignisse zu verzeichnen. 



Ergebnisse KA Stahnsdorf #3, Run 1 
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KA Stahnsdorf #3
Run 1

STOAT Menü → Tools→ Stream reports→Mass balance

Über die Mischwasser-
entlastung werden jetzt 

nur noch minimale 
Schadstofffrachten in 
den Vorfluter geleitet

Ein Vergleich zwischen Misch-
wasserzulauf und Ablauf der 
KA zum Vorfluter zeigt wie-
derum die hohe Reinigungs-

leistung.

Bilanz der 
Massenströme



KA Stahnsdorf #4 (Modell #3 zuzügl. PLC´s und Fuzzy)
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Öffnen Sie Modell „KA Stahnsdorf #4“! (Zuzüglich zu PLC RÜB werden PLC´s zur 
Steuerung der internen Rezirkulation und zur Fällmitteldosierung eingesetzt. 

Außerdem erfolgt die Belüftungssteuerung mit einem Fuzzy-Logic-Regler.) 

Modell 
KA Stahnsdorf #3

Modell 
KA Stahnsdorf #4

Eine weitere Änderung des Modells betrifft das Belebungsbecken: Hier wird die Anzahl 
der Stufen von 3 auf 4 gesetzt. Damit kann zusätzlich zu anerob, anoxisch und aerob 

eine Stufe simuliert werden, die fakultativ aerob oder anoxisch gefahren wird (N / DN). 

Die Mischwasserentlastung ist
mit Modell #3 bereits optimal.
Modell #4 zielt daher auf die
Verringerung der Fracht aus
dem Ablauf KA – mittels wei-
terer Steuerungsbausteine.



KA Stahnsdorf #4, Run 1 – PLC Fällmitteldosierung
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«PLC Fällmitteldosierung» 
Connectivity:

Input:
Phosphatkonzentration 
des Zulaufs zum NKB

«PLC Fällmitteldosierung» 
Operation data:

Programmierung der PLC´s für 
Fällmitteldosierung und inter-
ne Rezirkulation grundsätzlich 
analog PLC RÜB!

Übernahme der Operation data per Drag & Drop aus der 
Excel-Datei „KA Stahnsdorf STOAT Hintergrundberech-
nungen.xlsx“, Register „ PLC Fällmitteldosierung“!

Output:
Volumenstrom der 
Fällmittel-Dosierung 



KA Stahnsdorf #4, Run 1 – PLC interne Rezirkulation
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«PLC int. Rezirkulation» 
Connectivity:

Input:
Volumenstrom des 
Zulaufs zum BB

«PLC int. Rezirkulation» 
Operation data:

Übernahme der Operation data per Drag & Drop aus der 
Excel-Datei „KA Stahnsdorf STOAT Hintergrundberech-
nungen.xlsx“, Register „ PLC int. Rezirkulation“!

Output:
Volumenstrom der 
internen Rezirkulation

Programmierung der PLC´s für 
Fällmitteldosierung und inter-
ne Rezirkulation grundsätzlich 
analog PLC RÜB!



KA Stahnsdorf #4, Run 1 – BB Stage Data

BB Stufe 3 soll mit Hilfe von 
«Fuzzy Logic Belüftung» so 
gesteuert werden, dass zur 
sicheren Einhaltung der 
Grenzwerte für Ammonium 
und Gesamtstickstoff ent-
weder anoxische, aerobe  
oder dazwischen liegende 
Bedingungen herrschen! 

BioP N/DN NDN
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Einstellungen bewirken, 
dass in Stufe 3 ein Gelöst-
sauerstoffgehalt im Bereich 
zwischen 0 und 2 mg/l 
möglich ist. Der jeweilige 
Wert wird vom Fuzzy Logic
Controller vorgegeben.



Die Wirkung der gewählten Grenzen für die Inputwerte lässt sich am besten verstehen 
über die sog. Membership function (Zugehörigkeitsfunktion).

KA Stahnsdorf #4, Run 1 – Fuzzy Logic Belüftung

Input

Fuzzy Logic Belüftung → Input data→ Operation
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Auch die zur Konfiguration des Fuzzy Logic Controllers erforderlichen Werte brauchen 
Sie nicht einzeln einzutippen, sondern können Sie aus der Excel-Datei „KA Stahnsdorf 
STOAT Hintergrundberechnungen.xlsx“, Register „Fuzzy Logic Belüftung“ übernehmen!



Membership function für Ammonia:

Siehe Excel-Datei „KA Stahnsdorf STOAT Hintergrundberechnungen.xlsx“,
Register „Fuzzy Logic Belüftung“
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KA Stahnsdorf #4, Run 1 – Fuzzy Logic Belüftung

Input

Zutaten/KA Stahnsdorf STOAT Hintergrundberechnungen.xlsx


Membership function für Nitrate:

Siehe Excel-Datei „KA Stahnsdorf STOAT Hintergrundberechnungen.xlsx“,
Register „Fuzzy Logic Belüftung“
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KA Stahnsdorf #4, Run 1 – Fuzzy Logic Belüftung

Input

Zutaten/KA Stahnsdorf STOAT Hintergrundberechnungen.xlsx


Gesteuert wird der Sauerstoff-Sollwert in Stufe 3 des BB im Bereich zwischen 0 und 
2 mg/l. Je nach Ergebnis der Berechnung des Reglers wird der Sauerstoff-Sollwert 
auf der vorhergehenden Einstellung belassen oder um 1 bzw. 0,5 mg/l verringert 
bzw. erhöht.
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KA Stahnsdorf #4, Run 1 – Fuzzy Logic Belüftung

Output Fuzzy Logic Belüftung → Input data→ Operation 
→ Register Output
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KA Stahnsdorf #4, Run 1 – Fuzzy Logic Belüftung

Ist Input #1 (Konzentration von Ammoniumstickstoff) VS (Very Small) und
1. Input #2 (Konzentration von Nitratstickstoff) VS (Very Small), dann 

triggere N (Nothing to do)
2. Input #2 S (Small), dann triggere SD (Small Decrease)
3. Input #2 A (Average), dann triggere SD (Small Decrease)
4. Input #2 L (Large), dann triggere LD (Large Decrease)
5. Input #2 VL (Very Large), dann triggere LD (Large Decrease)

Ist Input #1 S (Small) und
1. Input #2 VS (Very Small), dann triggere SI (Small Increase)
2. Input #2 S (Small), dann triggere SI (Small Increase)
3. Input #2 A (Average), dann triggere SD (Small Decrease)
4. Input #2 L (Large), dann triggere SD (Small Decrease)
5. Input #2 VL (Very Large), dann triggere LD (Large Decrease)

Ist Input #1 VL (Very Large) und
1. Input #2 VS (Very Small), dann triggere LI (Large Increase)
2. Input #2 S (Small), dann triggere LI (Large Increase)
3. Input #2 A (Average), dann triggere SI (Small Increase)
4. Input #2 L (Large), dann triggere SI (Small Increase)
5. Input #2 VL (Very Large), dann triggere SI (Small Increase)

Control rules Fuzzy Logic Belüftung → Input data→
Operation → Register Output



KA Stahnsdorf #4, Run 1
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Starten Sie den 
Rechnerlauf!



Ergebnisse KA Stahnsdorf #4, Run 1 
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KA Stahnsdorf #4
Run 1

2D-Grafik Teilstrom «Ablauf KA»
Flow und Konzentration der wichtigsten Parameter

Mausklick rechts auf STOAT bit «Ablauf KA»→ Results…→ Flow (m³/h), Total SS (mg/l), 
Biodegradable COD (mg/l), Total COD (mg/l), Ammonia (mg/l), Nitrate (mg/l), Phosphate (mg/l)

→ Graph and summarystatistics→ Flow scale factor: /10

Diese Grafik zeigt zusammenfassend den Ablauf der Kläranlage zum 
Teltowkanal als aufnehmendes Gewässer. 



Ergebnisse KA Stahnsdorf #4, Run 1 
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Mausklick rechts auf «PLC Fällmitteldosierung»→ Results…→ Output

KA Stahnsdorf #4
Run 1

2D-Grafik Steuersignal des Reglers «PLC Fällmitteldosierung»
Output

Der «PLC Fällmitteldosierung» tritt insgesamt eher selten in Funktion. Am häufigsten sind die 
Signale in der Jahresmitte. In der warmen Jahreszeit sinkt die Sauerstoffsättigungskonzentration, 
die Belüftung kommt schneller an ihre Grenzen und lässt weniger BioP zu. Damit stellt sich eine 
höhere Ausgangskonzentration für die Phosphatfällung ein, was wiederum mehr Fällmittel 
erfordert. 



Ergebnisse KA Stahnsdorf #4, Run 1 
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Mausklick rechts auf «PLC Interne Rezirkulation»→ Results…→ Output

KA Stahnsdorf #4
Run 1

2D-Grafik Steuersignal des Reglers «PLC Interne Rezirkulation»
Output

Im Gegensatz zum «PLC Fällmitteldosierung» ist der «PLC Interne Rezirkulation» ohne Unter-
brechung in Funktion. Die niedrigsten Szenarien treten selten auf, die Signale häufen sich im 
oberen Bereich. Das widerspiegelt das Übergewicht höherer Abwasserzuflüsse zum BB – als 
Input des Reglers - infolge der Rückleitung aus dem RÜB. 



Ergebnisse KA Stahnsdorf #4, Run 1 
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Mausklick rechts auf BB → Results…→MLSS Recycle results→ Flow (m³/h)

Diese Grafik stimmt vollständig überein mit der Anzeige des Outputs des «PLC
Interne Rezirkulation». Das zeigt, dass die Regelung 100%ig funktioniert hat.

KA Stahnsdorf #4
Run 1

2D-Grafik Volumenstrom der internen Rezirkulation
Output



… Resultate überprüfen – Schlussfolgerungen?
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KA Stahnsdorf #4
Run 1

Interne Rezirkulation
Flow

Im Gegensatz zu den vorherigen Modellen #2 und #3 ist der Abwasservolumenstrom der inter-
nen Rezirkulation nicht konstant, sondern verändert sich ständig - und zwar proportional zum 
Abwasservolumenstrom im Zulauf des Belebungsbeckens. 

Mausklick rechts auf «BB»→MLSS recycle results→ From / To / Flow → Graph and 
summary statistics→Mausklick rechts auf Grafik, Maßstab der Y-Achse verändern



Ergebnisse KA Stahnsdorf #4, Run 1 
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Mausklick rechts auf «Fuzzy Logic Belüftung»
→ Results…→ Output → Timeseries data only

KA Stahnsdorf #4
Run 1

Steuersignale des Reglers «Fuzzy Logic Belüftung»
Output (nur als Tabelle einsehbar)

Anhand dieser Ergebnistabelle ist zunächst nur zu erkennen, 
dass der Fuzzy Regler „gefeuert“ hat. Ob das auch zu der 
gewünschten Veränderung der Belüftung von Stufe 3 des BB 
geführt hat, kann nur im BB selbst und anhand der 
Veränderung der Eliminierungsleistungen überprüft werden 
(siehe nächste Folien).



Ergebnisse KA Stahnsdorf #4, Run 1 
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Mausklick rechts auf «BB»
→ Results…
→ Dissolved Oxygen (mg/l)

KA Stahnsdorf #4
Run 1

3D-Grafik «BB»
Dissolved Oxygen 
(Gelöstsauerstoff-
konzentration)

Es ist zu erkennen, dass sich die Sauer-
stoffkonzentration in Stufe 3 des BB 
laufend ändert und dass sie insgesamt 
niedriger liegt, als in Stufe 4 des BB. Ergo: 
Regler hat ordnungsgemäß gearbeitet.



Ergebnisse KA Stahnsdorf #4, Run 1 
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KA Stahnsdorf #4
Run 1

Exportiert man die Ergebnistabelle des BB in Excel, 
lässt sich mit wenigen Handgriffen die Sauerstoff-
konzentration in Stufe 3 filtern. Daran sind die 
stündlichen Änderungen im Detail zu erkennen. 
Auch hier zeigt sich: Regler hat ordnungsgemäß 
gearbeitet!



Ergebnisse KA Stahnsdorf #4, Run 1 
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KA Stahnsdorf #4
Run 1

STOAT Menü → Tools→ Stream reports→Mass balance

An der Mischwasser-
entlastung ändert sich 

nichts im Vergleich zum 
vorhergehenden 

Modell. Es werden nur 
noch minimale 

Schadstofffrachten in 
den Vorfluter geleitet.

Ein Vergleich zwischen Misch-
wasserzulauf und Ablauf der 
KA zum Vorfluter zeigt wie-

derum hohe Reinigungs-
leistung. Dank PLC‘s und Fuzzy-

Regler sind die Ablaufwerte 
– z.B. bei BOD, N und PO4 -

noch besser als in Modell #3.

Bilanz der 
Massenströme



Ergebnisse der Simulation der KA Stahnsdorf
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Modell PO4 NH3 NO3 Total N BOD Solids Flow Entlastung COD

#1 10,687.20 kg/a 42,748.80 kg/a 82,519.20 kg/a 130,086.00 kg/a 178,266.00 kg/a 220,401.60 kg/a 443,869 m³/a 748,717.20 kg/a

#2 9,022.80 kg/a 42,748.80 kg/a 83,044.80 kg/a 129,998.40 kg/a 109,587.60 kg/a 130,524.00 kg/a 266,129 m³/a 673,206.00 kg/a

#3 6,920.40 kg/a 43,186.80 kg/a 83,044.80 kg/a 130,173.60 kg/a 59,830.80 kg/a 107,485.20 kg/a 41,960 m³/a 621,084.00 kg/a

#4 5,080.80 kg/a 24,440.40 kg/a 79,540.80 kg/a 107,835.60 kg/a 55,188.00 kg/a 108,974.40 kg/a 43,187 m³/a 618,193.20 kg/a

Lohnt sich die Mühe des  
Übergangs von #2 auf 
#3 und #4 auch für die 
BWB als Betreiber der 
Anlage?



Vergleich der Modelle nach Schadeinheiten/Abwasserabgabe

Lohnt sich die Mühe auch für die BWB als Betreiber der Anlage? Als Maßstab sollen die Schad-
einheiten nach AbwAG und die jährlich zu zahlende Abwasserabgabe herangezogen werden.

Schadeinheiten Abwasserabgabe

KA Stahnsdorf #1 17.776 SE 318.102,00 €

KA Stahnsdorf #2 16.241 SE 290.633,00 €

KA Stahnsdorf #3 15.175 SE 271.557,00 €

KA Stahnsdorf #4 14.635 SE 261.894,00 €

Antwort: Klares Ja!
Abgesehen von der Abwasserabgabe schlagen Einsparungen auch bei den 
Betriebskosten (Chemikalienkosten, Energiekosten) zu Buche!
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Abwasserabgabengesetz (AbwAG)

Begriffsbestimmung 
für Abwasser

Begriffsbestimmung 
für Einleiten

Die Begriffsbestimmung für „Abwasserbehandlungsanlage“ ist im AbwAG deutlich 
weiter gefasst als sonst üblich!
Beispielsweise zählen nach dem AbwAG nicht nur Kläranlagen, sondern auch Anlagen 
zur Wertstoffrückgewinnung aus dem Abwasser ganz eindeutig zu den 
Abwasserbehandlungsanlagen (denn sie vermindern die Schädlichkeit des Abwassers) 
sowie z. B. auch abwasserfreie oder abwasserarme Verfahrensschritte bei der 
Herstellung bestimmter Produkte (denn sie vermindern die Entstehung von Abwasser). 
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Erlass des AbwAG 
am 13.9.1976



Abwasserabgabengesetz (AbwAG)
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Berechnungsbeispiel:

Jahresschmutzwassermenge: 1.000.000 m³ 

Überwachungswert CSB:  120 mg/l 

CSB-Jahresfracht:  
1.000.000 m³ * 120 g/m³

1.000 g/kg
 = 120.000 kg CSB/a 

Schadeinheiten für CSB: 
120.000 kg CSB

50 kg CSB/SE
 = 2.400 SE 



Abwasserabgabengesetz (AbwAG)
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Hier greift die 
„4-aus-5-Regelung“

Zusammenwirken von 
Ordnungsrecht und 
fiskalischer Regelung

„Vorbelastung“ darf 
abgezogen werden

maßgeblich für die 
Berechnung der Höhe der 
Abgabe ist die 
wasserrechtliche Erlaubnis



Abwasserabgabengesetz (AbwAG)
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Zusammenwirken von 
Ordnungsrecht und 
fiskalischer Regelung

Werden die Mindest-
anforderungen gemäß AbwV 
eingehalten, wird die 
Abgabenlast um 50% vermindert.

Abwasserabgabe für CSB: 2.400 SE * 35,79 €/SE * 0,5 = 42.948,00 € 

 (50% Ermäßigung nach § 9 Abs. 5 AbwAG) 

Fortsetzung 
Berechnungsbeispiel:

Abwassereinleiter hatten mehr als 
vier Jahre Zeit, sich auf die Abgabe 
vorzubereiten! 



Abwasserabgabengesetz (AbwAG)

Dr.-Ing. O. Sterger – Abwasserbehandlung, STOAT, Teil 4 60

Möglichkeit der Verrechnung der 
Abwasserabgabe mit 
Investitionskosten für Anlagen, 
die die Schädlichkeit mindern

Zweckbindung des Einsatzes 
der Mittel aus der 
erhobenen Abwasserabgabe

z.B. Fischtreppen



Abwasserabgabengesetz (AbwAG)
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Finanzielles Aufkommen aus der Abwasserabgabe (aus GAWEL et al., 2011)



Abwasserabgabengesetz (AbwAG)
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Finanzielles Aufkommen aus der Abwasserabgabe 2014-2018 (aus GAWEL et al., 2021)

Bundesland AbwAG 

Gesamtaufkommen 

(Durchschnitt der 

Jahre 2014-2018)

lt. Angaben des BMU
Baden-Württemberg 10.04 Mio. €

Bayern 39.32 Mio. €

Berlin 10.27 Mio. €

Brandenburg 12.08 Mio. €

Bremen 2.65 Mio. €

Hamburg 0.94 Mio. €

Hessen 23.68 Mio. €

Mecklenburg-Vor-pommern 5.77 Mio. €

Niedersachsen 31.04 Mio. €

Nordrhein-Westfa-len 49.01 Mio. €

Rheinland-Pfalz 21.00 Mio. €

Saarland 8.36 Mio. €

Sachsen 15.24 Mio. €

Sachsen-Anhalt 12.84 Mio. €

Schleswig- Holstein 10.54 Mio. €

Thüringen 16.85 Mio. €

Summe BRD 269.63 Mio. €



Stellschrauben im Kläranlagenbetrieb

„Stellschraube“

Ausgleich von Fracht- oder 
Volumenstromspitzen im Zulauf 
zur Kläranlage 
z.B. durch Ausgleichsbecken im 
Haupt- oder Nebenstrom, aber 
auch unter Nutzung des 
Retentionsvermögen des 
Kanalnetzes

Vergleichmäßigung des zufließenden 
Volumenstroms und der Schmutzfracht als 
Hauptstörgrößen des Abwasserbehandlungs-
verfahrens; je nach Lage und Art der 
Ausgleichsvolumina können dabei zusätzliche 
Energiekosten entstehen.

Wirkungsweise

Sauerstoffeintrag Die Konzentration des im Abwasser gelösten 
Sauerstoffs ist die wichtigste Zustands- und 
Regelgröße beim Belebungsverfahren. Theoretisch 
gilt, dass je höher der Sauerstoffgehalt, desto 
geringer die Konzentration an CSB und NH4-N im 
Ablauf der KA. Das erfordert allerdings auch einen 
höheren Sauerstoffeintrag, sprich Energiebedarf. 
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Stellschrauben im Kläranlagenbetrieb

„Stellschraube“

Überschussschlammentnahme Durch den Überschussschlammabzug wird die 
gesamte Schlammenge in der biologischen 
Reinigungsstufe gesteuert. Die maximale 
Überschussschlammentnahme wird dadurch 
begrenzt, dass zur Aufrechterhaltung der 
biologischen Prozesse ein Mindestmaß an 
Belebtschlamm im System gehalten werden muss. 
Aufgrund ihrer im Vergleich zu den Heterotrophen 
deutlich geringeren Wachstumsgeschwindigkeit 
geben dabei die Autotrophen den Ausschlag.

Wirkungsweise

Rücklaufschlammförderung Eine Erhöhung der Rücklaufschlammförderung 
entlastet die Nachklärbecken und kann helfen, 
Grenzwertüberschreitungen durch Schlammabtrieb 
zu vermeiden. Dies ist allerdings nur kurzzeitig und 
in begrenztem Maße möglich.
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Stellschrauben im Kläranlagenbetrieb

„Stellschraube“

Volumenstrom interne 
Rezirkulation
nur bei Anlagen mit 
vorgeschalteter oder Kaskaden-
Denitrifikation

Je höher die interne Rezirkulation umso 
niedriger die Nitratkonzentration im Ablauf der 
KA, aber desto höher der Energiebedarf! 
(RF > 3 ist i.d.R. unwirtschaftlich!)

Wirkungsweise

Volumenaufteilung im 
Belebungsbecken
Wechsel zwischen aeroben und 
anoxischen Bedingungen 
innerhalb bestimmter 
Beckenbereiche, d.h. Belüftung + 
Durchmischung oder nur 
Durchmischung

Eine Vergrößerung des anoxischen Beckenanteils 
verbessert die Nitratablaufwerte auf Kosten der 
Konzentration an CSB und Ammoniumstickstoff im 
Ablauf der KA. Umgekehrt führt eine 
Vergrößerung des Nitrifikationsvolumens zu einer 
Verbesserung der CSB- und Ammoniumstickstoff-
Konzentration im Ablauf, zu Lasten der 
Nitratstickstoffwerte.
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Stellschrauben im Kläranlagenbetrieb

„Stellschraube“

Dosierung von Nährstoffen, um ein 
optimales Nährstoffverhältnis von 
etwa C : N : P = 100 : 5 : 1 
einzuhalten 
Eingesetzte Chemikalien:
für C z. B. Essigsäure, Methanol; 
für N z. B. Harnstoff;
für P z. B. Phosphorsäure.

Wenn z. B. ein Kohlenstoffdefizit besteht, 
unterstützt die bedarfsgerechte Dosierung eines 
leicht abbaubaren organischen Substrats die 
biologische Phosphateliminierung und verbessert 
die Denitrifikation; führt mithin dazu, dass P und N 
im Ablauf sinken, allerdings auf Kosten einer 
erhöhten Überschussschlammproduktion.

Wirkungsweise

Fällmittelzugabe zur P-Fällung
Eingesetzte Chemikalien:
Eisen(III)chlorid, 
Aluminiumchlorid

Senkung der Konzentration an o-Phosphat und 
P gesamt im Ablauf der KA, allerdings ebenfalls auf 
Kosten einer erhöhten Überschussschlamm-
produktion.
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Stellschrauben im Kläranlagenbetrieb

„Stellschraube“

Zeitpunkt und Dauer der 
Behandlung anfallender Abwässer 
aus der Schlammbehandlung
z.B. bezüglich Ammoniumstickstoff 
hochbelastete Zentrate

Die bei der mechanischen Schlammentwässerung 
entstehenden Trübwässer führen zu einer 
nennenswerten Rückbelastung der Kläranlagen. 
Die Behandlung dieser hochbelasteten Abwässer 
sollte deshalb immer in Abhängigkeit der 
Zulauffracht erfolgen. Ideal geeignet sind jene 
Lastfälle, wo weder die hydraulische noch die 
Stickstoffbelastung im Zulauf zu hoch sind, aber 
trotzdem ausreichend BSB (C-Quelle) vorhanden 
ist. Voraussetzung für eine diesbezügliche 
Steuerung sind entsprechende Stapelbehälter und 
Fördermöglichkeiten (Energiebedarf!).

Wirkungsweise
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